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Preface

TIBCO ActiveMatrix Adapter Service Engine for Lotus Notes provides two-way 
translation and communication between Lotus Notes database and the TIBCO 
environment. This manual describes configuration methods and deployment 
methods.

Topics

• Related Documentation, page xii

• Typographical Conventions, page xiv

• Terminology and Acronyms, page xvi

• How to Contact TIBCO Support, page xvii
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Related Documentation

This section lists documentation resources you may find useful.

TIBCO ActiveMatrix Adapter Service Engine for Lotus Notes Documentation
The following documents form the TIBCO ActiveMatrix Adapter Service Engine 
for Lotus Notes documentation set:

• TIBCO ActiveMatrix Adapter Service Engine for Lotus Notes Concepts Read this 
manual before reading any other book in the documentation set. This manual 
describes the adapter, adapter features, and the applications with which the 
adapter interacts.

• TIBCO ActiveMatrix Adapter Service Engine for Lotus Notes Installation Read this 
manual for instructions on how to install and uninstall the adapter service 
engine on Windows and UNIX platforms.

• TIBCO ActiveMatrix Adapter Service Engine for Lotus Notes Configuration and 
Deployment Read this manual to learn how to create and configure adapter 
projects. Information on deploying adapter projects is also included.

• TIBCO ActiveMatrix Adapter Service Engine for Lotus Notes Examples Read this 
manual to work through the examples provided with the adapter service 
engine.

• TIBCO ActiveMatrix Adapter Service Engine for Lotus Notes Release Notes Read 
the release notes for information about new features, changed features, and 
open and closed issues.

Before TIBCO ActiveMatrix Adapter Service Engine for Lotus Notes can be 
installed and used, you must install the TIBCO ActiveMatrix Adapter for Lotus 
Notes. The following documents form the standalone adapter documentation set:

• TIBCO ActiveMatrix Adapter for Lotus Notes Concepts Read this manual before 
reading any other book in the documentation set. This manual describes the 
adapter, adapter features, and the applications with which the adapter 
interacts.

• TIBCO ActiveMatrix Adapter for Lotus Notes Installation Read this manual for 
instructions on how to install and uninstall the standalone adapter on 
Windows and UNIX platforms.

• TIBCO ActiveMatrix Adapter for Lotus Notes Configuration and Deployment Read 
this manual to learn how to create and configure standalone adapter projects. 
Information on deploying adapter projects is also included.
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• TIBCO ActiveMatrix Adapter for Lotus Notes Examples Read this manual to 
work through the examples provided with the adapter.

• TIBCO ActiveMatrix Adapter for Lotus Notes Release Notes Read the release 
notes for information about new features, changed features, and open and 
closed issues.

Other TIBCO Product Documentation
You may find it useful to read the documentation for the following TIBCO 
products:

• TIBCO ActiveMatrix® Administrator

• TIBCO ActiveMatrix BusinessWorks™

• TIBCO ActiveMatrix BusinessWorks™ Service Engine

• TIBCO ActiveMatrix® Service Grid

• TIBCO ActiveMatrix® Service Bus

• TIBCO Business Studio™

• TIBCO Enterprise Message Service™

• TIBCO Hawk® 

• TIBCO Rendezvous®

• TIBCO Runtime Agent™

Third-Party Documentation
You may also find it useful to read the following IBM Lotus Notes documentation:

• Lotus Notes Help

• Lotus Domino Server Documentation

• Lotus Domino Designer Documentation
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Typographical Conventions

The following typographical conventions are used in this manual.

Table 1   General Typographical Conventions

Convention Use

TIBCO_HOME

ENV_HOME

AMX_HOME

Many TIBCO products must be installed within the same home directory. This directory 
is referenced in documentation as TIBCO_HOME. The value of TIBCO_HOME depends 
on the operating system. For example, on Windows systems, the default value is 
C:\tibco.

Other TIBCO products are installed into an installation environment. Incompatible 
products and multiple instances of the same product are installed into different 
installation environments. The directory into which such products are installed is 
referenced in documentation as ENV_HOME. The value of ENV_HOME depends on the 
operating system. For example, on Windows systems the default value is C:\tibco.

TIBCO ActiveMatrix installs into a directory within TIBCO_HOME. This directory is 
referenced in documentation as AMX_HOME. The value of AMX_HOME depends on the 
operating system. For example on Windows systems, the default value is 
C:\tibco\amx\.

TIBCO ActiveMatrix Adapter Service Engine for Lotus Notes installs in a directory within 
AMX_HOME.

code font Code font identifies commands, code examples, filenames, pathnames, and output 
displayed in a command window. For example:

Use MyCommand to start the foo process.

bold code 
font

Bold code font is used in the following ways:

In procedures, to indicate what a user types. For example: Type admin. 

In large code samples, to indicate the parts of the sample that are of particular interest.

In command syntax, to indicate the default parameter for a command. For example, if no 
parameter is specified, MyCommand is enabled: 
MyCommand [enable | disable]

italic font Italic font is used in the following ways: 

To indicate a document title. For example: See TIBCO ActiveMatrix BusinessWorks 
Concepts.

To introduce new terms For example: A portal page may contain several portlets. Portlets 
are mini-applications that run in a portal.

To indicate a variable in a command or code syntax that you must replace. For example: 
MyCommand PathName
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Key 
combinations

Key name separated by a plus sign indicate keys pressed simultaneously. For example: 
Ctrl+C.

Key names separated by a comma and space indicate keys pressed one after the other. For 
example: Esc, Ctrl+Q.

The note icon indicates information that is of special interest or importance, for example, 
an additional action required only in certain circumstances.

The tip icon indicates an idea that could be useful, for example, a way to apply the 
information provided in the current section to achieve a specific result.

The warning icon indicates the potential for a damaging situation, for example, data loss 
or corruption if certain steps are taken or not taken.

Table 1   General Typographical Conventions (Cont’d)

Convention Use

Table 2   Syntax Typographical Conventions

Convention Use

[ ] An optional item in a command or code syntax.

For example: 

MyCommand [optional_parameter] required_parameter

| A logical OR that separates multiple items of which only one may be chosen.

For example, you can select only one of the following parameters: 

MyCommand para1 | param2 | param3

{ } A logical group of items in a command. Other syntax notations may appear within each 
logical group.

For example, the following command requires two parameters, which can be either the 
pair param1 and param2, or the pair param3 and param4.

MyCommand {param1 param2} | {param3 param4}

In the next example, the command requires two parameters. The first parameter can be 
either param1 or param2 and the second can be either param3 or param4:

MyCommand {param1 | param2} {param3 | param4}

In the next example, the command can accept either two or three parameters. The first 
parameter must be param1. You can optionally include param2 as the second parameter. 
And the last parameter is either param3 or param4.

MyCommand param1 [param2] {param3 | param4}
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Terminology and Acronyms

The following acronyms are used in this manual.

Table 3   Terminology and Acronyms

Acronym Meaning

API Application Programming Interface

dll Dynamic Linked Library File on Windows

EMS Enterprise Message Service

GUI Graphical User Interface

Inbound Events coming into the adapter. It refers to the inflow of data into the Lotus Notes 
application. It is applicable to Subscription and Request-Response services.

IOR Interoperable Object Reference

JMS Java Messaging Service

NSF Notes Storage Facility (Lotus Notes Database Files)

Outbound Events going out from the adapter. It refers to data being captured from the Lotus Notes 
application and being sent out. It is applicable to the Publication Service.

QoS TIBCO Rendezvous quality of service

RPC Remote Procedural Call

RV Refers to TIBCO Rendezvous reliable message quality of service, as opposed to certified 
message

RVCM Refers to TIBCO Rendezvous certified message quality of service

RVDQ Refers to TIBCO Rendezvous distributed queue

VPD Vital Product Database
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How to Contact TIBCO Support

For comments or problems with this manual or the software it addresses, please 
contact TIBCO Support as follows.

• For an overview of TIBCO Support, and information about getting started 
with TIBCO Support, visit this site:

http://www.tibco.com/services/support

• If you already have a valid maintenance or support contract, visit this site:

https://support.tibco.com

Entry to this site requires a user name and password. If you do not have a user 
name, you can request one.
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Chapter 1 Introduction

This chapter provides an introduction to TIBCO ActiveMatrix Adapter Service 
Engine for Lotus Notes (adapter service engine).

Topics

• Overview, page 2
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Overview

TIBCO ActiveMatrix Adapter Service Engine for Lotus Notes is a gateway for 
TIBCO ActiveMatrix Adapter for Lotus Notes to the Service Oriented 
Architecture (SOA) world. The TIBCO ActiveMatrix Adapter Service Engine for 
Lotus Notes provides an ActiveMatrix container to deploy adapter projects using 
the TIBCO ActiveMatrix Administrator.

This manual describes the process of creating and configuring an adapter 
instance, packaging it into a service assembly and then deploying the services.

The design time tool is TIBCO Business Studio and the services are deployed 
using TIBCO ActiveMatrix Administrator.

Before proceeding, you should be familiar with the concepts and the terminology 
used by TIBCO ActiveMatrix Adapter Service Engine for Lotus Notes and TIBCO 
ActiveMatrix platform.

Figure 1 shows the TIBCO ActiveMatrix product family.

Figure 1   TIBCO ActiveMatrix Product Family
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Chapter 2 Working with TIBCO Business Studio

The TIBCO ActiveMatrix development tools consist of TIBCO Business Studio 
Workbench and a set of TIBCO ActiveMatrix plug-ins. This chapter describes how 
to start TIBCO Business Studio, create a new adapter project, and import projects 
and files into the project.

For information on TIBCO Business Studio, refer to the Workbench User Guide in 
the Workbench online help. To view the online help, select Help > Help Contents.

Topics

• Starting TIBCO Business Studio, page 4

• Creating Adapter Projects, page 7

• Importing TIBCO Designer Projects, page 8

• Importing Projects into Workspace, page 10
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Starting TIBCO Business Studio

To start TIBCO Business Studio:

1. Execute one of the following platform-specific command:

— On Microsoft Windows:

select Start > All Programs > TIBCO > TIBCO Business Studio 2.2 > 
TIBCO Business Studio

or

run the executable from the command line

AMX_HOME\BusinessStudio\TIBCOBusinessStudio.exe

— On Unix:

run AMX_HOME/BusinessStudio/TIBCOBusinessStudio

2. In the Workspace Launcher, accept the default workspace or browse to or 
create a new workspace. Click OK.

3. The first time you run TIBCO Business Studio, it displays a Welcome screen. 
Dismiss the screen by clicking the Close button  in the title bar.

When you start TIBCO Business Studio for the first time after installing TIBCO 
ActiveMatrix Adapter Service Engine for Lotus Notes, ensure that you use the 
-clean option.
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Figure 2   TIBCO Business Studio Main Window

The screen contains the following area and views:

Menu  See Help > Help Contents > Workbench User Guide.

Toolbar See Help > Help Contents > Workbench User Guide.

Project Explorer Displays a tree containing all the project resources such as project 
folders, shared resource definition files, WSDL files, composite files, service 
assembly files, and so on.

Editor Displays editors for the objects currently being edited. Switch between 
editors by clicking tabs at the top of the Editor area. The Composite Editor 
contains a canvas on which you can drop elements and a palette that organizes 
the elements that you can add to the composite. Other editors allow you to 
configure shared resources and service assemblies.

Outline Provides an overview of the Composite Editor canvas. You can easily 
navigate from one part of a composite to another.

The Outline view also displays a content tree structure that contains the 
composite element inside the composite. In this view you can delete the contents 
of the composite. When you select a composite element in the Outline tree, the 
corresponding artifact in the composite becomes selected.

Editor
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Project
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Views Displays under the Editor Area. Contains the following views:

— Properties: Displays property sheets for editing composites and composite 
elements. When you select a composite or composite element in the 
Composite Editor canvas, this view shows the properties of the selected 
object in a vertical tabbed notebook.

— Problems: Displays validation and other errors.

— Registries: Lists UDDI registries and the WSDL files returned from 
searching a registry.

You open a view by selecting Window > Show View.
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Creating Adapter Projects

Adapter projects contain adapter service engine configurations, related shared 
resources and business functionality that needs to be enabled for the functioning 
of the adapter service engines. Adapter projects are created using TIBCO Business 
Studio. To begin the configuration process, you must first create a project for the 
adapter.

1. Start TIBCO Business Studio.

2. From the File menu, select New > Project.

3. In the New Project dialog, expand TIBCO ActiveMatrix Adapters, select 
Adapter Project as the wizard, and then click Next.

4. Type AdapterProjectName in the Project name field.

5. Specify names for folders.

— To specify custom names for Adapter Configurations and Shared 
Resources folders, click Next.

— To accept default values, click Finish.

A new project is created with the following folders: Adapter Configurations, 
AESchemas, defaultVars, and Shared Resources.

Figure 3 shows the structure of a project created using default values.

Figure 3   Create an Adapter Project

Global variables in TIBCO Designer are referred to as substitution variables in 
TIBCO Business Studio.
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Importing TIBCO Designer Projects

Adapter projects created using TIBCO Designer for the standalone component, 
TIBCO ActiveMatrix Adapter for Lotus Notes, can also be imported into the 
TIBCO Business Studio environment.

To import a TIBCO Designer adapter project:

1. From the File menu, select Import.

2. In the Import dialog, select TIBCO ActiveMatrix Adapter > Import TIBCO 
Designer Projects. Click Next

3. Choose between Select root directory and Select archive file.

a. Click Browse.

b. Navigate to the folder where the Adapter project or the archive file is 
located.

c. Click OK.

4. In the Projects pane, select the checkbox for the project you want to import as 
well as the services contained in the project.

Figure 4   Import TIBCO Designer Project

The checkbox for the Copy projects into workspace is checked by default and 
the projects are copied to the current workspace.
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5. Click Finish.

Differences in Imported Projects
When you import a TIBCO Designer adapter project, the following differences in 
the project and configuration should be noted:

• The value of the Class MicroAgentName field (located in the 
WebSphereMQAdapterConfiguration->Monitoring tab in Designer) has been 
changed from COM.TIBCO.adln.%%Deployment%%.%%InstanceId%% to 
COM.TIBCO.adln.%%Deployment%%.LotusNotesAdapterConfiguration.

• The value of the Standard MicroAgentName field (located in the 
WebSphereMQAdapterConfiguration->Monitoring tab in Designer) has been 
changed from 
COM.TIBCO.ADAPTER.adln.%%Deployment%%.%%InstanceId%% to 
COM.TIBCO.ADAPTER.adln.%%Deployment%%.LotusNotesAdapterConfigur

ation.

• The following fields (features) are not imported:

— Message Filter and version (in Configuration tab)

— Termination Subject or Topic (in General tab)
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Importing Projects into Workspace

To import projects created in another workspace to the current workspace:

1. From the File menu, select Import.

2. In the Import dialog, select General > Existing Projects into Workspace. Click 
Next.

3. Choose between Select root directory and Select archive file.

a. Click Browse.

b. Navigate to the folder where the Adapter project or the archive file is 
located. Click OK.

4. In the Projects pane, select the projects you want to import.

Figure 5   Import Projects Created in Another Workspace

5. Select the Copy projects into workspace checkbox if you want to copy files 
belonging to the project into the current workspace.

6. Click Finish.
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Chapter 3 Preparing Lotus Notes

This chapter explains how to prepare the Lotus Notes components for use with 
the adapter.

Topics

• Setting Up Connections, page 12

• Configuring Databases, page 14

• Configuring Agents, page 15

• Managing Lotus Notes Documents, page 20

Lotus Notes 7 is used in this book.
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Setting Up Connections

Depending on the location of the database which maintains the documents to be 
manipulated, you need set up different types of connections.

Setting Up Remote Connection
To access a remote database, set up a remote connection:

1. Start Lotus Domino Server.

2. Enable the HTTP service and DIIOP service on the server.

The HTTP service is used to get the IOR file from the Lotus Domino Server. 
The DIIOP service is used to establish the session for the adapter and the 
Domino server to interact. See TIBCO ActiveMatrix Adapter Service Engine for 
Lotus Notes Concepts for more information about session establishment.

If you haven’t set to start the HTTP service and DIIOP service automatically 
when installing Lotus Domino, enter the following commands at the Lotus 
Domino Server console:

> load http
> load diiop

If the Bypass HTTP Service of Domino checkbox is selected when configuring 
the adapter instance, you need not start the HTTP service.

See Setting Up Remote Connection on page 46 for instructions on how to 
configure the connection for the adapter instance.

3. (optional) To secure the connection between the adapter and the remote Lotus 
Domino Server, you can configure SSL for HTTP and DIIOP.

a. Configure SSL for HTTP and DIIOP on Lotus Domino applications.

b. After completing the configuration tasks for the Lotus Domino 
applications, you need to add the path of the TrustedCerts.class file to 
the tibco.env.CUSTOM_CP_EXT variable in the adln.tra file. The 
adln.tra file is located in the ADLN_HOME\bin directory.

See Setting Up SSL Connection on page 47 for instructions on how to 
configure the connection for the adapter instance.

It is strongly recommended that you refer to the Lotus Domino Administrator 
documentation for instructions on how to configure SSL for HTTP and DIIOP 
on Lotus Domino applications. Appendix B, Configuring SSL for HTTP and 
DIIOP, on page 227 in this book should be used only as a quick reference.
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Setting Up Local Connection
To access a local database, set up a local connection:

1. Add the Domino home or Notes home directory to the environment variable. 
This step is for the design-time connection.

For example, on Windows platforms add the directory C:/Program 
Files/IBM/Lotus/Domino or C:/Program Files/IBM/Lotus/Notes to the 
environment variable Path.

2. Add the Domino home or Notes home directory to the variable 
tibco.env.CUSTOM_PATH in the adln.tra file. This step is for the runtime 
connection.

For example, on Windows platforms add the directory C:/Program 
Files/IBM/Lotus/Domino or C:/Program Files/IBM/Lotus/Notes.

Ensure that the directories added are for the same version as that of the .jar files 
that you specified during the installation of the adapter.

Ensure that the local .nsf file is in the data subdirectory within the home 
directory of either Lotus Domino Server or Lotus Notes. Otherwise, the .nsf file 
can only be accessed exclusively.

See Setting Up Local Connection on page 52 for instructions on how to configure 
the connection for the adapter instance.

To set up a local connection with Lotus Domino R8 (8.0, 8.0.x, 8.5), you need add 
the following directories to the variable tibco.env.CUSTOM_CP_EXT in the 
adln.tra file.

<Notes/Domino Home>/jvm/lib
<Notes/Domino Home>/jvm/lib/ext
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Configuring Databases

The adapter installation package provides three sample databases, namely 
sample.nsf, source.nsf, and target.nsf. You can find these files in the 
ADLN_HOME\examples\Lotusdatabase directory. You can also create your own 
databases.

Task A Open a Database

1. Start Lotus Notes.

2. Open an existing database or create your own database.

Task B Enable a Database as a TIBCO-enabled Database

If you create a new database, you need copy forms and views to enable the newly 
created database as a TIBCO-enabled database.

1. In Lotus Domino Designer, select a sample database in the Applications panel. 
For example, sample.nsf.

2. Expand the Forms folder under the SAMPLE application, import forms by 
copying the following item to the Forms folder of your database:

Outbox, TIB Adapter Setup Form, TIB Client Request Form, TIB Client 
Request Processing, TIB Publisher Event Form, and Request Response 
Invocation Form.

3. Expand the Views folder under the SAMPLE application, import forms by 
copying the following item to the Views folder of your database:

Request Response Invocation View
TIB Administration\1. Setup View
TIB Administration\2. Events View
TIB Administration\3. Publishing Status
TIB Administration\4. Unpublished
TIB Administration\5. Defined Client Requests
TIB Administration\6. Client Requests Processing

To interact with a remote Lotus Domino Server, ensure that the database file 
has been uploaded to the remote server.

It is recommended that you copy forms from the sample databases shipped with 
the adapter and then add fields according to your requirements. All the inherited 
fields should be kept intact.
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Configuring Agents

Agents are used to trigger the Publication Service and Request-Response 
Invocation Service.

Creating and Configuring Agents
To configure agents for the adapter services, complete the following tasks.

Task A Create an Agent

1. Start Lotus Domino Designer.

2. Select Design > Agent from the Create menu.

3. In the Agent dialog, enter a name for the agent. For example, 
agentForReview1. Specify values according to the requirements.

Figure 6   Create an Agent

4. Click the Security tab, set the runtime security level if necessary.

This section is only for the Publication Service and Request-Response Invocation 
Service.

If you selected the Log to file checkbox or the Log to Database checkbox in the 
Setup Document of the database, you must set the runtime security level to 3. 
Allow restricted operations with full administration.
 TIBCO ActiveMatrix Adapter Service Engine for Lotus Notes Configuration and Deployment



16 | Chapter 3  Preparing Lotus Notes
Figure 7   Set Runtime Security Level

Task B Import Agent Classes Files

1. In the tab of the newly created agent, select Imported Java from the 
drop-down list.

2. Click the Import Class Files button.

3. In the Define Java Agent Files dialog, select the appropriate class file for your 
adapter service.

Agent class files are maintained in the ADLN_HOME/lib/agents directory:

ADLN_HOME/lib/agents/HTTP
ADLN_HOME/lib/agents/POLLING
ADLN_HOME/lib/agents/RV/RV_agents

See TIBCO ActiveMatrix Adapter Service Engine for Lotus Notes Concepts for 
more information about the Lotus Notes Agents class files.

4. Click the Add/Replace File(s) button or double-click the class file to add it.

Include one class file for each agent.
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Figure 8   Import Agent Class File

5. Click OK.

6. Repeat the steps above for each agent to be added.

Task C Set Document Selection Condition

To improve the efficiency of agents, you can add conditions to filter the 
documents. This task is optional.

1. In the Document Selection panel of the agent, click the Add Condition button.

2. In the Add Condition dialog, select a condition from the Condition 
drop-down list, and then specify more detailed terms to find documents.

There are several kinds of conditions that you can select from the drop-down 
list, such as By author, By date, By field, By form, etc. Multiple conditions 
can be added for one agent.

— For an HTTP agent that is created for Request-Response Invocation Service 
to process documents with their Status fields marked as UnProcessed, you 
need to add the following conditions:

field Status contains ’UnProcessed" AND uses ’Request Response 

Invocation Form’ form

— If you want the HTTP agent to process all documents in the Request 
Response Invocation View regardless of their status fields, you need only 
to add the following condition:

uses ’Request Response Invocation Form’ form
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Figure 9   Add Condition by Field

Figure 10   Add Condition by Form
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Setting Up RV Agents

1. Create a folder named rv_agents inside Notes_Installation_Home.

2. Copy the SendRvMsgPub.class and SendRvMsgInitClient.class from 
ADLN_HOME/lib/agents/RV/rv_agents to 
Notes_Installation_Home/rv_agents.

3. Copy the Windows batch files RvPub.bat and RvInitClient.bat from 
ADLN_HOME/lib/agents/RV/rv_batchfiles to Notes_Installation_Home.

4. In the batch files, specify the values for NOTES_INSTALLATION_HOME, 
TIBCO_HOME, and for the connection parameters NOTES_JAR_LOCATION, 
NCSO_JAR_LOCATION, DOMINO_HOST, DB_NAME, DB_USERNAME, and 
DB_PASSWORD.

To use the RV agents, perform the configurations discussed in this section.

The batch files and rv_agents directory can be in other locations. Ensure that 
the batch files are in the same folder with the rv_agents directory.

Rename the batch files only when the full path and file names are specified to 
for RV Batch File for Publish or RV Batch File for RPC in the Setup 
document. The directory name rv_agents cannot be changed.

Ensure that the configuration in the batch files is consistent with the 
application environment.

The arguments that are passed to the Java command in the Windows batch 
files are for remote connections to the Lotus Notes database. For a local 
connection, the -database argument is sufficient.
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Managing Lotus Notes Documents

In addition to the general documents that are used to hold the data, a 
TIBCO-enabled Lotus Notes Database provides administration documents to 
facilitate the data manipulation. This section describes how to work with the 
Lotus Notes Administration documents.

Lotus Notes Administration Documents

Every TIBCO-enabled Lotus Notes database that you create must include all the 
Lotus Notes administration documents.

Documents for TIBCO-enabled Lotus Notes databases are created based on the 
forms inherited from the TIBCO-enabled database template. The TIBCO-enabled 
database template also includes one instance of each document. The sample 
documents contain default data that is needed to set up and test a TIBCO-enabled 
database. Documents that are created based on the forms do not contain default 
data. Ensure that every new TIBCO-enabled database copies these documents 
from the templates.

The databases may contain other forms and you can also customize the standard 
TIBCO forms, but they must include the fields from the original forms.

Each document consists of a set of fields. For many of the fields, a corresponding 
repository object is listed. If changes are made to the field values, the 
corresponding repository object values must be modified. Additionally, the field 
values must be set to the same value as the corresponding repository object.

Setup Document
The Setup document is used by the publishing mechanism of the Publication 
Service and Request-Response Invocation Service. The Lotus Notes agents use the 
Setup document to establish a TIBCO Rendezvous or JMS session.

Creating a Setup Document

To create a Setup document:

1. Start Lotus Notes and open a TIBCO-enabled database.

2. From the Create menu, select TIB Adapter Setup Form.

3. Set the values according to your application requirements.
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Figure 11   Setup Document

4. Save the configuration.

Table 4 lists the fields in the setup document.

Table 4   Fields in Setup Document

Field Name Description

Queue Db Server Host name or IP address of the Domino server.

Queue Db Path Name of the database.

Log to file (Log File Path) The path where the agent log files are created. User can select either or both 
options to maintain the log files.

Log to Database (Server) Name of the server which hosts the database that contains log files. User can select 
either or both options to maintain the log files.

Log to Database 
(Database Name)

The name of the.nsf file where the agent logs should be created.

The .nsf file specified should have the Log Entry form and the Agent 
Activity View of the StdR4AgentLog template (ALOG4.NTF) copied into it. 
User can select either or both options to maintain the log files.

Host Name The host where the adapter is running.
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Maintaining the Setup Document

Once created, the Setup document appears in TIB Administration\1. Setup 
View. You can double-click the document to modify it at a later time.

Port Number A unique number that is configured in the adapter instance.

The HTTP port on which the adapter service listens to the Lotus Notes agent.

Applies to Publication Service and Request-Response Invocation Service for which 
triggers are configured and when HTTP are used as the transport type.

The value of this field must be the same as that of the Http Port to Listen to 
LotusNotes Events field in the Adapter Services tab of an adapter instance.

Publish Subject Subject used by the Lotus Notes agent to send a message to the adapter. This 
notifies the adapter of a Publish transaction.

Applies to Publication Service and Request-Response Invocation Service for which 
triggers are configured and when Rendezvous is used as the transport type.

The value of this field should be the same as that of the Subject to Listen to 
LotusNotes Events field in the Adapter Services tab of an adapter instance.

Publish Network TIBCO Rendezvous session parameter. Allows the user to publish on a different 
subnet.

Applies to the Publication Service and Request-Response Invocation Service.

Publish Service TIBCO Rendezvous session parameter. Allows the user to publish on a different 
subnet.

Applies to the Publication Service and Request-Response Invocation Service.

Publish Daemon TIBCO Rendezvous session parameter. Allows the user to publish on a different 
subnet.

Applies to the Publication Service and Request-Response Invocation Service.

Batch Size Handler for 
Publish

The number of documents to be processed by Standard Publisher (RV agent and 
HTTP agent) in batch.

The default value is 2000. The maximum allowed value is 5000. If the value is set 
to -1, the documents wouldn’t be processed in batch.

RV Batch File for Publish The batch file name. The RV agent calls the batch file which is used to run 
SendRvPub.class. The name can be specified for use by different databases. 
Specify the full path name for this field.

RV Batch File for RPC The batch file name. The RV agent calls the batch file which is used to run 
SendRvMsgInitClient.class. The name can be specified for use by different 
databases.

Table 4   Fields in Setup Document (Cont’d)

Field Name Description
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Event Setup Document
Event Setup document is only used by the Publication Service. An Event Setup 
document defines the conditions that a document must meet in order to be 
processed, and how the document is copied to the Publishing Status view.

Because they are started for publishing transactions, the Lotus Notes agents read 
data from the document. The document must match the formula defined in an 
event setup document before the publishing transaction can be initiated.

One form can be attached to multiple events, however each event must have a 
unique event name to ensure that there is no ambiguity about which event is to be 
applied.

Creating an Event Setup Document

To create an event setup document:

1. Start Lotus Notes and open a TIBCO-enabled database.

2. From the Create menu, select TIB Publisher Event Form.

3. Set the values according to your application requirements.

Figure 12   Event Setup Document

Specify values for the fields of Event Name, Host Name, Port Number, 
Override Subject, and Formula. Leave the other fields unchanged.

4. Save the configuration.
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Table 5 lists the fields in the event setup document.

Table 5   Fields in Events View

Field Name Description

Event Name A unique name that should match the schema name in the repository.

For the Publication Service, ensure that the Event Name matches the part after 
the dot. For example, if the value of the Class Reference field under the Schema 
tab in TIBCO Designer is 
/AESchemas/ae/lotusnotes/lnmetadata.aeschema#class.custome
r, then the Event Name should be customer.

Host Name The host name on which the adapter is running. It has higher priority than the 
host name in the Setup Document.

The combination of Host Name and Port Number for an event setup document 
must be unique in its database.

Port Number A port number that is configured in the adapter instance. It has higher priority 
than the port number in the Setup Document.

The combination of Host Name and Port Number for an event setup document 
must be unique in its database.

Override Subject Notify the adapter configuration of the published data. This is only used when 
the publish over-ride agent is started, rather than taking the subject from the 
XML file. It has higher priority than the override subject in the Setup Document.

Override Network The network parameter of the TIBCO Rendezvous transport. It has higher 
priority than the override network in the Setup Document.

Override Service The service parameter of the TIBCO Rendezvous transport. It has higher 
priority than the override service in the Setup Document.

Override Daemon The daemon parameter of the TIBCO Rendezvous transport. It has higher 
priority than the override daemon of the Setup View.

Formula An event-specific Lotus formula which defines the conditions that a document 
must meet in order to be published.

For example:

Form = "Customer" & Status = "MetaAddAttachmentsByValue" & 
rv_operation = "Add"

Queuing Method (Copy by 
Value)

Copies the contents of the document to the outbox document.

Queuing Method (Copy by 
Document UNID)

Only copies the universal ID of a document to the outbox document.
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Maintaining the Event Setup Document

Once created, the event setup document appears in TIB Administration\2. 
Events View. You can double-click the document to modify it at a later time.

Client Requests Document
The Client Requests document is used only for the Request-Response Invocation 
Service. The Request-Response Invocation View form in the sample.nsf file is a 
client-request-enabled form.

The TIB InitiateClientRequest agent is run against a client-request-enabled 
document. When the agent is invoked against one of these documents, it creates a 
Client Request Processing Document which is used by the adapter to process the 
client request. This kind of document is only used by the TIB 
InitiateClientRequest agent.

Creating a Client Requests Document

To create a client requests document:

1. Start Lotus Notes and open a TIBCO-enabled database.

2. From the Create menu, select TIB Client Request Form.

3. Set the values according to your application requirements. You can configure 
different RV parameters for different events which serve different services in 
the adapter.

Figure 13   Client Requests Document
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4. Save the configuration.

Table 6 lists the fields of the Defined Client Requests Document.

Table 6   Fields in Defined Client Requests Document

Field Description

Request Name The unique identifier of the Client Request Name. This field is used to match the 
document of the Request Response Invocation View.

To serve a Request-Response Invocation Service, the value of this field must be the 
same as the service name specified in TIBCO Designer.

Class Name The name of the meta data class that is associated with the request. This class must 
be defined in the Class Reference field in the Schema tab of the adapter service.

Operation Name Name of the operation which belongs to the meta data class defined in the Class 
Name field.

Host Name Name of the machine which hosts the adapter.

Port Number HTTP port number.

Override Subject Used by the RV agent to identify the subject for Rendezvous transport. Override 
Subject has higher priority than Publish Subject in the Setup View.

The RV agent first looks at the documents in the Defined Client Request View. If 
the RV parameter is configured, then the agent simply uses them. Otherwise, use 
the RV parameter configured in the document of the Setup view.

Override Network The network parameter of the TIBCO Rendezvous transport. It has higher priority 
than the override network of the Setup View.

Override Service The service parameter of the TIBCO Rendezvous transport. It has higher priority 
than the override service of the Setup View.

Override Daemon The daemon parameter of the TIBCO Rendezvous transport. It has higher priority 
than the override daemon of the Setup View.

Client Name The name of the SDK client that is to be used internally by this client request. This 
client object must be defined in the Configuration Data associated with the adapter.

The format of a Client Name is the Request Name of the same document appended 
with the string Endpoint. For example, if the Request Name is RPCC, then the 
Client Name should be RPCCEndpoint.

Operation Timeout The value in milliseconds for which the synchronous client request will wait for 
the response of the request. If this response does not come within this time limit, 
the entire operation will time out.

Operation Type Valid operation type is synchronous.
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Maintaining the Client Requests Document

Once created, the client requests document appears in TIB Administration\5. 
Defined Client Requests. You can double-click the document to modify it at a 
later time.

Request Response Invocation Document
The Request Response Invocation document is used to initiate a client request for 
Request-Response Invocation Service.

Creating a Request Response Invocation Document

To create a Request Response Invocation document:

1. Start Lotus Notes and open a TIBCO-enabled database.

2. From the Create menu, select Request Response Invocation Form.

3. Set the values according to your application requirements. You can configure 
different RV parameters for different events which serve different services in 
the adapter.

CorrespondingForm Refers to the Request-Response Invocation Form.

Operation Parameters Parameters that are defined in the metadata object. The values are given to this 
field as part of the operation definition. The logic is such that the value field must 
have valid parameters of the document fields associated with the parameters of the 
operation object containing the operation.

For example, parm1 and requestedField are attributes of 
RequestReplyOperations in the LOTUS_NOTES_RPC class. Use TIBCO 
Designer to access it in the following location: 
AESchemas/ae/lotusnotes/replymetadata/Classes.

If one of the document fields is not really part of the document or is part of the 
document but does not contain a value, then the value ^NO_VALUE^ will be given 
to the parameter and it will not be used in initiating the internal request.

Document Fields This field is related to the OperationParameters field.

For example, the RequestedFields attribute of the Request-Response 
Invocation View form has been mapped to requestedField of 
RequestReplyOperations in the LOTUS_NOTES_RPC class. Use TIBCO 
Designer to access it in the following location: 
AESchemas/ae/lotusnotes/replymetadata/Classes.

Table 6   Fields in Defined Client Requests Document (Cont’d)

Field Description
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Figure 14   Request Response Invocation Document

Table 7 lists the fields of the Request Response Invocation document.

Table 7   Fields in Request Response Invocation Document

Field Description

Request Name Name of request.

Operation Type The type of query operation. Valid values can be Query, View, FTSearch, and 
RunAgent. When communicating with a Request-Response Service whose 
operation type is query, specify detailed query information with this option.

Formula Query by formula. If the value of the Operation Type field is set to query, a Lotus 
formula needs to be specified in this field. See Guidelines for Using Formula on 
page 29.

Parameters Full text search. If the value of the Operation Type field is set to FTSearch, a 
parameter has to be specified in this field. See Guidelines for Setting FTSearch 
Parameters on page 30
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Guidelines for Using Formula

TIBCO ActiveMatrix Adapter Service Engine for Lotus Notes supports the 
formula language.

Agent Name Invokes a predefined agent to perform the query. If the value of the Operation 
Type field is set to RunAgent, an agent name has to be specified in this field.

The agent specified here must have a Target setting other than All selected 
documents when created in Lotus Domino Designer.

View Name Query by view. If the value of the Operation Type is set to View, a view name 
needs to be specified in this field. With this option, all documents in the specified 
view will be returned.

Result Policy Specifies whether the query result should be customized to be stored into different 
documents.

Result Form Priority Selects either of Client or Server has higher priority to determine the form of the 
result document.

Result Form Indicates which form will be used to contain the result. It takes effect at runtime if 
the Result Form Priority is set to be Client.

Requested Fields The field name of which the user requested will be listed here.

Status Indicates the status of the request. Valid statuses include Unprocessed, Processed, 
Exception, and Timed Out. When a document is first created, the status is set to 
Unprocessed.

Only Unprocessed documents will be executed when an agent is run.

Return Value The return value of the RPC operation. The structure of the return value is defined 
in the meta-class definition that is associated with this client request.

Return Data The return data of the RPC operation. The structure of the return data is defined in 
the meta-class definition that is associated with this client request.

Exception Name The exception name of the RPC operation, if any. The structure of the exception is 
defined in the meta-class definition that is associated with this client request.

Exception Data The return value of the RPC operation. The structure of the exception is defined in 
the meta-class definition that is associated with this client request. 

Table 7   Fields in Request Response Invocation Document (Cont’d)

Field Description
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For example,

— to search for documents in the form named test, enter Form="test" in the 
Formula field.

— to search for documents in the form named customer and have the key 
field customertype set to type3, enter 
Form="customer"&customertype="type3" in the Formula Field.

For more information about how to use the formula language, refer to the Lotus 
Domino Designer documentation.

Guidelines for Setting FTSearch Parameters

When setting the FTSearch parameters, follow the method syntax described 
below:

• queryStr

where queryStr is a string that defines the full-text query

— The character \ is defined as the escape mark.

— The characters * and ? are defined as the wildcards.

— To search strings that include the characters {, }, (, ), &, [, ], |, !, :, ', ;, <, 
or >, enclose the query string in double-quotes.

— To search strings that include the characters *, ?, or double-quotes, use | as 
the escape mark in the query string.

— To search strings that include commas or slashes, use \ as the escape mark 
in the query string.

For example,

— to search for fields that contain a plain string TIBexampleTIB, enter 
TIBexampleTIB in the Parameters field.

— to search for fields that contain string {}TIB(example&TIB[], enter 
"{}TIB(example&TIB[]" in the Parameters Field.

— to search for fields that contain string TIB"exa*ple?TIB, enter 
TIB|"exa|*ple|?TIB in the Parameters Field.

— to search for fields that contain string TIB,example\TIB, enter 
TIB\,example\\TIB in the Parameters Field.

• queryStr, max

Refer to the Lotus Notes documentation for more information about the syntax of 
the FTSearch parameters.
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where:

— queryStr is a string that defines the full-text query

— max is an integer that indicates the maximum number of documents to be 
returned from the query. Set max to 0 to receive all matching documents.

For example, to returned the first five documents which contain string 
TIBexampleTIB, enter TIBexampleTIB,5 in the Parameters Field.

• queryStr, max, sortopt, otheropt

where:

— queryStr is a string that defines the full-text query

— max is an integer that specifies the maximum number of documents to be 
returned from the query. Set max to 0 to receive all matching documents.

— sortopt is an integer that specifies a sorting option. Refer to the Lotus 
Domino Designer documentation for details about this option.

— otheropt is an integer that specifies additional search options. Refer to the 
Lotus Domino Designer documentation for details about this option.

For example, to use fuzzy search (FT_FUZZY) to return the first five 
documents that contain string TIBexampleTIB and the returned documents 
are sorted by creation date in descending order (FT_DATECREATED_DES), 
enter TIBexampleTIB,5,1542, 16384 in the Parameters Field.

Maintaining the Request Response Invocation Document

Once created, the Request Response Invocation document appears in the 
Request Response Invocation View. You can double-click the document to 
modify it at a later time.

Customizing Views for the Request Response Invocation Documents

You can define different views to manipulate the Request Response Invocation 
Documents.

For example, create views for each operation type.

1. In Lotus Notes, select Create > View.

2. Enter the view name and specify the View type as Shared.

3. In the Selection Conditions section, select the By Formula radio button.

4. In the Select Conditions text box, type SELECT Form="Request Response 
Invocation Form" & operationType="1". This selection condition ensures 
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that the view connects to the Request Response Invocation Form. Leave other 
fields unchanged.

5. Click OK.

6. Repeat the steps above to create views for other operation types. Change the 
value of the operationType in the Select Conditions text box accordingly.

Client Requests Processing View
This view lists the requests that are currently in process and are being processed 
by the adapter client configuration or that have already been processed by the 
adapter client configuration.

Documents listed in this view are created by the TIB InitiateClientRequest 
agent, which is used in conjunction with the adapter configuration to process the 
client request that has been initiated by the user agent.

Once the client request has been processed by the adapter configuration, the 
status field and response-related fields of the document are manipulated. The 
form for this view should contain the fields in the Defined Client Requests 
document in addition to the fields defined in Table 8.

When the adapter configuration completes the client request, the values of the 
status field and the response field change accordingly.
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Figure 15   Client Requests Processing Document

Table 8   Fields in Client Requests Processing Document

Field Description

Related Document ID The document ID of the original document that the agent was run against.

Time Initiated Time at which the client request was initiated.

Time Completed Time at which the client request was completed.

Status Valid statuses are as follows: Unprocessed, Processed, Exception, and TimedOut.

When the document is first created, the status is set to Unprocessed.

Return Value The return value of the RPC operation.

The structure of the return value is defined in the meta-class definition that is 
associated with this client request.

Return Data The return data of the RPC operation.

The structure of the return data is defined in the meta-class definition that is 
associated with this client request.
 TIBCO ActiveMatrix Adapter Service Engine for Lotus Notes Configuration and Deployment



34 | Chapter 3  Preparing Lotus Notes
Publishing Status View
The Publishing Status view lists all publishing transactions. It indicates the 
document ID which is to be published and the publishing status of the document.

The status flags available are as follows:

• UnPublished —Indicates that the document has been moved to the 
outbox by the Publisher agent and has not yet been taken for publishing by 
the adapter.

• Picked up for Publication —Indicates that the document has been taken 
up by the adapter for processing.

• Published Successfully —Indicates that the document has been published 
successfully.

• Picked up but Failed to Publish —Indicates that the document was picked 
up by the publisher but failed to publish.

Double-click an event to see more information about the document.

Exception Name The exception name of the RPC operation, if any.

The structure of the exception is defined in the meta-class definition that is 
associated with this client request.

Exception Data The return value of the RPC operation.

The structure of the exception is defined in the meta-class definition that is 
associated with this client request.

Table 8   Fields in Client Requests Processing Document (Cont’d)

Field Description

Table 9   Publishing Status Document Fields

Field Name Description

Source Server Name of the Lotus Domino server

Source DB Name of the database

Event Name Name specified in the Events field

Subject Name of the Subject

Event Received Time Time Received

Publish Time Time published
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Unpublished View
The Unpublished View lists all the publication requests that have not yet been 
executed.

Published By Username under which the document is published

Document Retrieval Method Method of retrieval

View Name Name of the View

Document ID ID of the Document

Table 9   Publishing Status Document Fields (Cont’d)

Field Name Description

If the publisher has been down for a substantial amount of time and an agent is 
still running, the Lotus Notes documents will be queued in the Publishing 
Status document of the database. Ensure that the documents are published 
before the count goes beyond 10,000. To do this, you can either use a TIBCO 
Hawk rule base to restart the adapter or restart the adapter manually.

Table 10   Unpublished Document Fields

Field Name Description

Source Server Name of the Lotus Domino server

Source DB Name of the database

Event Name Name specified in the Events field

Subject Name of the Subject

Event Received Time Time received

Published By Username

Document Retrieval Method Method of retrieval

View Name Name of the View

Document ID ID of the Document
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Chapter 4 Getting Started

This chapter describes the basic steps to configure and run the adapter service 
engine. Details for each step are provided later in the manual.

Topics

• Overview, page 38

• Prerequisites, page 39

• Configuring the Adapter Service Engine, page 40

• Configuring an ActiveMatrix SOA Project, page 54

• Running the Adapter Service Engine, page 55
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Overview

The TIBCO ActiveMatrix Adapter Service Engine for Lotus Notes (adapter service 
engine) enables the adapter to run in the ActiveMatrix environment as a container 
and to provide services.

The adapter service engine supports both the AE and ActiveMatrix endpoints. 
Adapter AE endpoints can be converted as ActiveMatrix endpoints that let the 
adapter service engine communicate seamless with other ActiveMatrix services. 
All adapter endpoint types are converted to Web Services Description Language 
(WSDL) and can be used for configuration in the ActiveMatrix environment.

The adapter service engine supports communication with TIBCO ActiveMatrix 
BusinessWorks and TIBCO ActiveMatrix BusinessWorks Service Engine using 
only the AE transport.
TIBCO ActiveMatrix Adapter Service Engine for Lotus Notes Configuration and Deployment



Prerequisites | 39
Prerequisites

Before starting the configuration, ensure that all required software have been 
installed and are operating correctly. For a list of required software, see TIBCO 
ActiveMatrix Adapter Service Engine for Lotus Notes Installation.

You are supposed to know how to drag icons in TIBCO Business Studio and save 
projects. If you are not familiar with these topics, refer to the Workbench User 
Guide, which can be accessed from the Help > Help Contents menu option in 
TIBCO Business Studio.

See Preparing Lotus Notes on page 11 for information on preparing the Lotus 
Notes applications to work with the adapter service engine.
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Configuring the Adapter Service Engine

TIBCO ActiveMatrix Adapter Service Engine for Lotus Notes is configured with 
TIBCO Business Studio.

Configuration Task Sequence
To configure the adapter service engine, complete the following tasks:

• Task A, Start TIBCO Business Studio, page 40

• Task B, Create an Adapter Project, page 41

• Task C, Create an Adapter Instance, page 41

• Task D, Create Lotus Notes Connection, page 42

• Task E, Import Lotus Objects, page 43

• Task F, Configure a Service, page 44

Task A Start TIBCO Business Studio

To start TIBCO Business Studio:

1. Execute one of the following platform-specific command:

— On Microsoft Windows:

select Start > All Programs > TIBCO > TIBCO Business Studio 2.2 > 
TIBCO Business Studio

or

run the executable from the command line

AMX_HOME\BusinessStudio\TIBCOBusinessStudio.exe

— On Unix:

run AMX_HOME/BusinessStudio/TIBCOBusinessStudio

2. In the Workspace Launcher, accept the default workspace or browse to or 
create a new workspace. Click OK.

3. The first time you run TIBCO Business Studio, it displays a Welcome screen. 
Dismiss the screen by clicking the Close button  in the title bar.
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Task B Create an Adapter Project

A project contains the configuration files that define runtime options for the 
adapter.

To create an adapter project:

1. From the File menu, select New > Project.

2. In the New Project dialog, expand TIBCO ActiveMatrix Adapters, select 
Adapter Project as the wizard, and then click Next.

3. In the Project name field, enter a name for the project. Click Next.

4. In the Assets pane, select the asset types that are required for your project. 
This example uses the default setting, that is, only the Adapters asset type is 
selected.

Figure 16   Select Asset Types

5. Specify names for the selected assets.

— To accept the default names, click Finish.

— To use different names, click Next, and then enter new names in 
corresponding fields.

Task C Create an Adapter Instance

An adapter instance can contain Publisher, Subscriber, RPC Server, RPC Client, 
Login, Logout, or all of them.
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To create an adapter instance:

1. In the Project Explorer, right-click Adapter Configurations, and then select 
New > Other from the shortcut menu.

2. In the New dialog, expand TIBCO ActiveMatrix Adapters > Configurations, 
select LotusNotes Adapter, and then click Next.

3. In the LotusNotes Adapter Configuration dialog, click Finish. This creates an 
adapter instance named, by default, LotusNotesAdapterConfiguration. 
You can change the name in the Configuration tab later.

Task D Create Lotus Notes Connection

To configure the connection parameters:

1. Create a Lotus Connection Shared Resource.

a. From the File menu, select New > Adapter Resources.

b. In the Create New Adapters Resource dialog, expand Shared Resources, 
select Lotus Connection. Click Next.

c. Select the parent folder for the Lotus Notes Connection shared resource. 
For example, the Shared Resources folder under the adapter project 
folder.

d. Click Finish.

2. Configure the Lotus Notes Connection. See Configuring Lotus Notes 
Connection on page 45 for details.

3. Deploy the Lotus Notes Connection for Runtime Connection.

a. Go to the adapter instance editor.

b. Click the Adapter Options tab.

c. In the Runtime Connection section, click Connection Configuration.

d. In the Connection Configuration dialog, select the Lotus Notes connection 
that you want to use.
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Figure 17   Connection Configuration

e. Click OK.

Task E Import Lotus Objects

1. From the File menu, select Import.

2. In the Import dialog, expand TIBCO ActiveMatrix Adapter > Metadata, 
select Lotus Objects, and then click Next.

3. In the Lotus Objects Import Wizard dialog, enter the name of the file to store 
the metadata.

4. In the Download Location filed, browse to select the download location. For 
example, proj/Shared Resources.

5. In the Adapter Connection field, browse to select a Lotus Connection 
resource.

6. Click Next.

7. In the Lotus Objects Import Wizard dialog, select the objects you want to 
import from the Lotus Objects pane.
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Figure 18   Import Lotus Objects

8. Click Finish.

Task F Configure a Service

The next step is to configure an adapter service that performs the publication, 
subscription, or request-response data passing operations for the adapter service 
engine.

1. In the adapter instance editor, click the Adapter Services tab.

2. Click the corresponding buttons to add the services you want to use. See 
Adapter Services on page 63 for how to configure different services.

3. From the File menu, select Save to save the project information.
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Configuring Lotus Notes Connection
This section explains the options of a connection configuration, and demonstrates 
how to set up different types of connections, as follows:

• Setting Up Remote Connection, page 46

• Setting Up SSL Connection, page 47

• Setting Up Local Connection, page 52

Table 11   Field Description of Connection Configuration

Field Description

Configuration

Name Name of the connection configuration.

Description A short description of the connection configuration.

LotusNotes Connection

Lotus Domino 
Server Name

The host name or IP address of the machine that hosts the Lotus Domino Server.

If the default TCP/IP port number or SSL port number for HTTP has been changed in IBM 
Domino Administrator, the port number should be specified in this field. For example, 
192.168.66.10:8081. You need not do extra configuration in this field if the port number for 
DIIOP has been changed.

To access a local database through a local connection, leave this field empty.

Database The name of the .nsf file. If the .nsf file resides in the local file system, specify the full 
path to access the database.

ID File The User ID file location in the local file system.

Username The username used to log into Lotus Notes.

Password The password associated with the username that is used to log into Lotus Notes.

Bypass HTTP 
Service of 
Domino

If selected, the adapter runtime will read from the specified file instead of using HTTP 
service of Domino to get the IOR.

If you select this checkbox, specify the full path of the IOR file, including the filename. For 
example, C:\Program 
Files\lotus\Domino\data\domino\html\diiop_ior.txt.
 TIBCO ActiveMatrix Adapter Service Engine for Lotus Notes Configuration and Deployment



46 | Chapter 4  Getting Started
You can also click the Set Bindings button to launch the Binding Editor and then 
pick substitution variables to bind with the properties.

Setting Up Remote Connection

Before proceeding with the steps listed in this section, see Setting Up Remote 
Connection on page 12 for configurations to be completed in advance. The 
following steps guide you through a simple configuration to set up a remote 
connection:

1. In the Lotus Domino Server Name field, enter the host name or IP address of 
the machine that hosts the Lotus Domino Server.

2. In the Database field, enter the name of the .nsf file to be accessed.

3. Empty the ID File field.

4. Enter the username and password to log into Lotus Domino Server in the 
Username field and the Password field.

5. Select the Bypass HTTP Service of Domino checkbox if necessary. Use this 
option in the following conditions:

— anonymous HTTP access to the Domino server is restricted.

— HTTP service of the Domino server is disabled.

— you do not want to use the HTTP service of the Domino server.

6. If you selected the Bypass HTTP Service of Domino checkbox, browse to 
locate the IOR file in the IOR File field.

IOR File Available only if the Bypass HTTP Service of Domino checkbox is selected.

Enter the full path including the filename of the IOR file. The IOR file is used by the 
adapter to connect to the Domino server. The file should be on the local machine and the 
default location of the diiop_ior.txt is 
Domino_Installation_Home/data/domino/html.

Enable SSL on 
HTTP

Enables the adapter to obtain the IOR file from Lotus Domino Server through HTTPS 
service.

Enable SSL on 
DIIOP

Enables the adapter to be authenticated by Lotus Domino Server through SSL on DIIOP.

Test Connection Provides an option to test whether the adapter can successfully connect to Domino Server 
in design phase.

Table 11   Field Description of Connection Configuration (Cont’d)

Field Description
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7. Save the configuration.

8. Click the Test Connection button to test the connection.

Setting Up SSL Connection

To secure the connection between the adapter and the remote Lotus Domino 
Server, you can set up an SSL connection.

Before proceeding with the steps listed in this section, see Setting Up Remote 
Connection on page 12 for configurations to be completed in advance. The 
following tasks guide you through a simple configuration to set up an SSL 
connection. Note that the configurations described in Task A on page 47 through 
Task E on page 51 are for the design time connection.

Task A Create a Fragment Project

1. From the File menu, select New > Project.

2. In the New Project dialog, expand Plug-in Development, select Fragment 
Project as the wizard, and then click Next.

3. In the New Fragment Project dialog, enter a name for the project. Leave the 
other options unchanged. Click Next.

Figure 19   Create a Fragment Project
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4. In the Host Plug-in area, click the Browse button next to the Plug-in ID field, 
and select the com.tibco.adln.tpvl.ibmdrivers(1.0.0.003) plug-in. Then click 
OK.

5. In the Maximum Version field, enter 2.0.0.

Figure 20   Configure the Fragment Project

6. Click Finish.

7. Click Yes to open the associated perspective when prompted.

8. In the perspective of the fragment project, click the MANIFEST.MF tab. You 
should be able to find the following entry:

Fragment-Host: com.tibco.adln.tpvl.ibmdrivers; 
bundle-version="(1.0.0, 2.0.0)"

Task B Import the Certificate JAR File

1. Right-click the fragment project in the Project Explorer and select Import.

2. In the Import dialog, select General > File System, and then click Next.

3. Click the Browse button next to the From directory field, locate the folder 
where the certificate JAR file resides. Select the checkbox next to the certificate 
JAR file. Click Finish.
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Figure 21   Import Certificate JAR File

4. Click the Runtime tab in the perspective.

5. In the Classpath section, click Add to add the JAR file that is just imported.

6. In the Exported Packages section, click Add to add the package.
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Figure 22   Configure the Runtime Tab

7. Save the configuration of the fragment project.

Task C Create a Feature Project

1. From the File menu, select New > Project.

2. In the New Project dialog, expand Plug-in Development, select Feature 
Project as the wizard, and then click Next.

3. In the New Feature dialog, enter a name for the project. Click Next.

4. Select the fragment project that is created in Task A. Click Finish.

5. Click Yes to open the associated perspective when prompted.

6. Click the Plug-ins tab. Ensure that the fragment is selected in the Plug-ins and 
Fragments list.

7. Click the Versions button, select Copy versions from plug-in and fragment 
manifests, and then click Finish.

8. In the Plug-in Details section, select the Unpack the plug-in archive after the 
installation checkbox.

9. Save the Configuration of the feature project.
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Task D Create Deployable Archive

1. Right-click the feature project and select Export.

2. In the Export dialog, select Plug-in Development > Deployable features, and 
then click Next.

3. In the Available Features section, ensure that the feature project is selected.

4. In the Destination tab, select the Archive file radio button, and then click the 
Browse button to specify the path as well as file name of the archive file.

5. Click Finish.

Task E Install Feature into TIBCO ActiveMatrix Environment

1. Extract the archive file that is created in the previous step.

Two folders are created after the extraction, one is named as features and the 
other is plugins.

2. Copy the subfolders into corresponding subdirectories in 
AMX_HOME/components/eclipse:

— Copy the sub folder within the features folder to 
AMX_HOME/components/eclipse/features.

— Copy the sub folder within the plugins folder to 
AMX_HOME/components/eclipse/plugins.

3. At the command prompt, go to the directory AMX_HOME/tools/bin.

4. Run the following command:

tibcommander -Dfeature.name=featureID -f 
AMX_HOME/tools/scripts/addfeature.xml

where the parameter featureID can be found in TIBCO Business Studio, on the 
Overview tab of the feature project.

5. Restart TIBCO Business Studio for the features to take effect in TIBCO 
ActiveMatrix Environment.

Task F Enable SSL for Lotus Connection

1. In the Lotus Domino Server Name field, enter the host name or IP address of 
the machine that hosts the Lotus Domino Server.

2. In the Database field, enter the name of the .nsf file to be accessed.

3. Empty the ID File field.

4. Enter the username and password to log into Lotus Domino Server in the 
Username field and the Password field.
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5. Select the Bypass HTTP Service of Domino checkbox if necessary. Use this 
option in the following conditions:

— anonymous HTTP access to the Domino server is restricted.

— HTTP service of the Domino server is disabled.

— you do not want to use the HTTP service of the Domino server.

6. If you selected the Bypass HTTP Service of Domino checkbox, browse to 
locate the IOR file in the IOR File field.

7. Depending on the requirements, select the Enable SSL on HTTP checkbox or 
the Enable SSL on DIIOP checkbox.

Guidelines for Using SSL on HTTP

The IOR file is cached after the adapter gets it through a HTTP or HTTPS 
connection. If the adapter tries to get the IOR file through another HTTP or 
HTTPS connection from the same Domino server later, the cached IOR file will be 
used instead of getting a new one from the designated connection.

To avoid such a problem, follow the rules below when you need to access a 
Domino Server which enables both HTTP service and HTTPS service on it:

• Do not add adapter instances with different connection types (HTTP or 
HTTPS) to the same TIBCO ActiveMatrix Adapter project.

• If you have opened a project with HTTP connection in TIBCO Business 
Studio, open another project with HTTPS connection from a different 
workspace.

• If you have changed the connection type (from HTTP to HTTPS or vice versa) 
for an adapter instance, restart TIBCO Business Studio for the change to take 
effect.

Setting Up Local Connection

Before proceeding with the steps listed in this section, see Setting Up Local 
Connection on page 13 for configurations to be completed in advance. The 
following steps guide you through a simple configuration to set up a local 
connection:

1. Empty the Lotus Domino Server Name field.

2. In the Database field, enter the full path of the .nsf file that resides in the local 
file system.

3. In the ID File field, enter the path of the user ID file.

4. Empty the Username field and the Password field.
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5. Leave the other options unchanged, which are not applicable for a local 
connection.

6. Save the configuration.

7. Click the Test Connection button to test the connection.
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Configuring an ActiveMatrix SOA Project

After configuring the adapter project, you need to create an SOA project and 
generate service assembly file and deployable archive.

See Configuring an ActiveMatrix SOA Project on page 79 for instructions on how 
to do that.
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Running the Adapter Service Engine

To run the adapter service engine, you need to deploy the service assembly in 
TIBCO ActiveMatrix Administrator. See Deploying the Service Assembly on 
page 103 for instructions on how to do that.
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Chapter 5 Configuring an Adapter Instance

This chapter describes the options available for configuring an adapter instance 
and for adding services. All configuration tasks are done using TIBCO Business 
Studio.

Topics

• Configuration, page 58

• Adapter Options, page 61

• Adapter Services, page 63

• Log Sinks, page 75
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Configuration

In the Configuration tab, you can provide basic configuration information in 
several sections for the adapter instance.

Table 12   Field Description of Adapter Instance Configuration

Field Description

Generic Adapter Configuration

Instance Name Use the default name or replace it with a name of your choice. See Guidelines for Choosing 
an Instance Name on page 59.

Description A short description of the adapter configuration.

Startup

Show Startup 
Banner

The startup banner displays the runtime adapter version, the infrastructure version on 
which the adapter service engine is built, and the copyright information in the console 
window when the adapter service engine is started.

The content of the start banner is pre defined and cannot be changed.

Clear this checkbox if you do not want the startup banner to be displayed.

Monitoring

(TIBCO Hawk functionality is not supported in current release.)

Enable Standard 
MicroAgent

This checkbox allows you to turn on or turn off the standard TIBCO Hawk Microagent.

Standard 
MicroAgent 
Name

The name for the standard microagent that will be registered with the TIBCO Hawk 
system.

Click the Set Bindings button on the title bar to launch the Binding Editor. In the Binding 
Editor, you can pick substitution variables to bind with properties Standard MicroAgent 
Name.

In most cases, the default value is used. The InstanceId variable need not be set because it 
is automatically set at runtime by the runtime adapter.

Standard 
MicroAgent 
Timeout(ms)

The timeout value for the standard microagent in milliseconds.
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Guidelines for Choosing an Instance Name

• The entire instance name must be less than 80 characters.

• The following characters cannot be used in an instance name: /, \, <, >, |, *, %, 
:, +, #, ?, and ".

• The space character and dot character cannot be used to begin or end an 
instance name.

• An instance name cannot use substitution variables.

• An instance name must be unique with respect to other adapter instances for 
the same adapter in the project.

Enable Class 
MicroAgent

This checkbox allows you to turn on or turn off the instance or class-specific standard 
TIBCO Hawk Microagent.

Click the Set Bindings button on the title bar to launch the Binding Editor. In the Binding 
Editor, you can pick substitution variables to bind with properties Enable Class 
MicroAgent.

Class 
MicroAgent 
Name

The name for the class microagent that will be registered with the TIBCO Hawk system.

In most cases, the default value is used.

Class 
MicroAgent 
Timeout(ms)

The timeout value for the class microagent in milliseconds.

Default 
MicroAgent 
Session

The name of the TIBCO Rendezvous session that will be used by the standard, class, and 
custom microagents.

Do not change the session name and the corresponding session, which are automatically 
generated by TIBCO Business Studio. However, you can double-click the 
HawkSession.rvtransport under the instancename_genresources folder in the 
Project Explorer to modify the session parameters if required.

Ensure that you have set the correct parameter value for the substitution variables that 
correspond to the TIBCO Hawk configuration. Otherwise, the microagents will not appear 
in the TIBCO Hawk Display.

Administration

Language 
Encoding

Encoding values that can be used by the adapter service engine. See TIBCO ActiveMatrix 
Adapter for Lotus Notes Concepts for more information.

Table 12   Field Description of Adapter Instance Configuration (Cont’d)

Field Description
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The same instance name can be used to name an adapter instance for a 
different adapter in the same project. For example, a Lotus Notes adapter 
instance named TEST and a Sieble adapter instance named TEST can coexist 
in the same project.

Each instance name must be unique per adapter within a project even if each 
instance is defined in a different folder. That is, configuring same-named 
adapter instances in different folders will not make their names unique.

When you create an adapter instance, the palette automatically creates several 
resources for it. The names of these resources derive from the name of the instance 
to which they belong. Changing the adapter instance name results in an 
automatic regeneration of the resources names. If you manually modify any 
resource name, that particular name will not be automatically regenerated the 
next time you rename the adapter instance.
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Adapter Options

Provide information for Runtime Connection on this tab.

Table 13   Field Description of Adapter Options

Field Description

Runtime Connection

Connection 
Configuration

Associates the adapter instance with a predefined connection configuration. See 
Create Lotus Notes Connection on page 42 for instructions on how to define a 
connection.

Maximum Number of 
Reconnect Attempts

The total number of reconnection attempts to make before the run-time adapter or 
adapter service is stopped. The default value of -1 means reconnection attempts 
will continue indefinitely.

Number of Reconnect 
Attempts before 
Suspending impacted 
services

The number of reconnection attempts to make before suspending a run-time 
adapter or adapter service.

Retry Interval The time interval in milliseconds to elapse between each reconnection attempt.

LotusNotes Service Options

Number of Publication 
Service Threads

The total number of threads to run the Publisher.

Polling Interval (ms) Only for the Publisher. The time taken between polling sessions.

Polling Batch Size Only for the Publisher. The maximum number of documents or messages to be 
fetched by the adapter per polling session. The value of Polling Batch Size is 
10000 (the maximum) if 0 or a value greater than 10000 is specified. The default 
value is 100.

Transport Type to listen 
to LotusNotes Events

Only for the Publisher or RPC client. The transport type to listen to Lotus Notes 
events.

If None is selected, then the polling option must be enabled for the Publisher and 
RPC client.

Http Port to listen to 
LotusNotes Events

Only for the HTTP transport.

The HTTP port number to listen to the Lotus Notes agent. The port number 
specified here must be the same as the Port Number in the Setup Document or the 
Event Setup Document of the database, which is configured in Lotus Notes.
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Subject to listen to 
LotusNotes Events

Only for the Rendezvous transport.

The subject to listen to the Lotus Notes agent. The subject specified here must be 
the same as the Publish Subject in the Setup Document or the Event Setup 
Document of the database, which is configured in Lotus Notes.

Number of Subscription 
Service Threads

The total number of threads required to run the Subscriber.

Number of 
Request-Response 
Service Threads

The total number of threads required to run the RPC server.

At run time, there will be one more thread created in addition to the threads 
configured at design-time for the Request-Response Service. This extra thread is 
the default SDK thread.

Session Idle Timeout (m) Only for dynamic login services.

The duration of idle time in minutes after which a session (corresponding to any 
user who has dynamically logged in using the login service in the instance) gets 
automatically logged out.

The default value is 30 minutes. The maximum allowed value is 65535. If the 
value is specified as 0, the session will not idle out.

Session Expiry Time (m) Only for dynamic login services.

The duration in minutes after which a session (corresponding to any user who has 
dynamically logged in using the login service in the instance) gets automatically 
logged out.

The default value is 0. This means the session never expires. The maximum 
allowed value is 65535.

Table 13   Field Description of Adapter Options (Cont’d)

Field Description
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Adapter Services

This tab provides options for adding and configuring adapter services:

• Publisher, page 63

• Subscriber, page 65

• RPC Server, page 67

• RPC Client, page 70

• Login Service, page 72

• Logout Service, page 73

Publisher
Publisher sends messages from Lotus Notes to applications configured for the 
TIBCO environment. Publisher extracts data from the fields of Lotus Notes 
documents in the database and publishes them on configured subject names.

Click Add Publisher and then specify values for the fields listed in Table 14.

Table 14   Publisher Options

Field Description

Configuration

Name Name of the Publisher.

A service name must use alphanumeric characters. An underscore (_) character can be 
used. The entire instance name must be less than 80 characters. The space character cannot 
be used in an instance name. A service name cannot use substitution variables.

Description Additional information about the Publisher being configured.

Schema

Class Reference The AE Schema that is automatically generated from the selected BO when the adapter 
configuration is saved.

You can view the type and attributes of the class by double-clicking the Classes folder 
under AESchemas > ae > lotusnotes > metadatafile.schemamodel. For more 
information about schema, see the TIBCO Designer User’s Guide.

Business Object Browse to select business object child from any of the previously imported BOs.
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Guidelines for Saving the Schema by Another Name

Within a project, all schema classes of Publishers are located in the 
/AESchemas/ae/lotusnotes/lnmetadata.schemamodel/classes folder, even 
if the services belong to different adapter instances.

Figure 23   Schema Classes Location

To avoid ambiguity, save the schema by a different name under the following 
circumstances:

Publication Service Option

Save As Save the schema by another name in the publisher schema. The value you enter here will 
appear in the Class Reference field when you specify the Business Object field. See 
Guidelines for Saving the Schema by Another Name on page 64.

Enable Poller If selected, the adapter polls the Lotus Notes database. If not selected, the Lotus Notes 
database is not polled.

Update Mode If Update is selected, the operation will be either Insert or Update.

If Upsert is selected, the operation will be either Insert or Upsert.

Run Agent Click the FetchAgents button to list Lotus Notes agents that are defined in the Lotus Notes 
database. The agent specified in this field is invoked by the adapter after publishing the 
document.

Table 14   Publisher Options (Cont’d)

Field Description
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• If you do not want more than one Publisher to point to the same schema class.

A schema class is generated with a schema name by default. If the schema 
name for two Publishers is the same, the corresponding schema class for both 
will be the same.

• If two Publishers have the same schema name and if any changes are made to 
one of the them through the Schema Editor.

The changes made to one schema class will affect the other schema class with 
the same schema name. To avoid loss of data in one or both the schemas, save 
one of them by a different name.

• If you need to configure two or more publisher events for the same form.

Specify different names in the Save As field of these services and create entries 
corresponding to each service in the Events View of the form.

Running Publisher

Publisher gets messages from a Lotus Notes application and sends the message to 
the TIBCO environment. Publisher is triggered by standard publisher agents. See 
Configuring Agents on page 15 about creating agents in Lotus Domino Designer.

Subscriber
Subscriber sends messages from the applications configured for the TIBCO 
environment to the Lotus Notes. Click Add Subscriber and then specify values 
for the fields listed in Table 15.

Table 15   Subscriber Options

Field Description

Configuration

Name Name of the Subscriber.

A service name must use alphanumeric characters. An underscore (_) character can be 
used. The entire instance name must be less than 80 characters. The space character cannot 
be used in an instance name. A service name cannot use substitution variables.

Description Additional information about the Subscriber being configured.

Schema

Class Reference The AE Schema that is automatically generated from the selected BO when the adapter 
configuration is saved.
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Guidelines for Saving the Schema by Another Name

Within a project, all schema classes of Subscribers are located in the 
/AESchemas/ae/lotusnotes/lnmetadatasub.schemamodel/classes folder, 
even if the services belong to different adapter instances.

To avoid ambiguity, save the schema by a different name under the following 
circumstances:

• If you do not want more than one subscriber to point to the same schema 
class.

A schema class is generated with a schema name by default. If the schema 
name for two services is the same, the corresponding schema class for both 
will be the same unless a different name is specified in the Save As field.

• If two Subscribers have the same schema name and if any changes are made to 
one of them through the Schema Editor.

The changes made to one schema class will affect the other schema class if 
they have the same schema name. To avoid loss of data in one or both the 
schemas, save one of them by another name.

Business Object Select Browse from the menu next to the Business Object field and choose from any of the 
previously imported BOs.

Subscription Service Option

Save As Save the schema by another name in the publisher schema. The value you enter here will 
appear in the Class Reference field when you specify the Business Object field. See 
Guidelines for Saving the Schema by Another Name on page 66.

Type The type of Subscription Service to be used by the runtime adapter, normal or 
withlogin. See Guidelines for Setting Type on page 67.

Enable Key 
fields On Insert

This checkbox takes effect only when the operation type is insert.

When the checkbox is selected, the values of the key fields in the document will be checked 
for duplication. For the document, if the values of the key fields are new to the document 
in the database, an insert operation will be performed. This ensures that no new document 
will be inserted if the values of the key fields are the same.

Run Agent Click the Fetch Agents button to get the list of Lotus Notes agents defined in the Lotus 
Notes database. The agent specified in this field is invoked by the adapter after subscribing 
the document.

Table 15   Subscriber Options (Cont’d)

Field Description
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Guidelines for Setting Type

There are two approaches for the runtime adapter to use a Subscriber:

• Normal—The runtime adapter uses the username and password specified in 
the LotusNotes Connection shared resource of the adapter instance to connect 
to the Lotus Notes application.

• Withlogin—The runtime adapter uses credentials of the dynamically logged 
in user instead of the default parameters provided in the LotusNotes 
Connection shared resource to connect to the Lotus Notes application.

To configure a Subscriber with dynamic login, you also need a Login Service 
and a Logout Service.

Running Subscriber

Subscriber receives messages from the TIBCO environment and performs insert, 
update, delete, or upsert operation in the Lotus Notes database.

Subscriber uses ADAPTER_OPCODE to learn what kind of operation is to be 
performed. There are two ways to run a Subscriber:

• with Publisher: If a Subscriber communicates with a Publisher within TIBCO 
ActiveMatrix environment, the Subscriber detects the value of 
ADAPTER_OPCODE from the Publisher at runtime.

• with TIBCO ActiveMatrix BusinessWorks: If a Subscriber gets messages from 
TIBCO ActiveMatrix BusinessWorks, the Subscriber reads the 
ADAPTER_OPCODE field specified in the activity. See Configuring SOAP 
Activity for Subscriber on page 94 for more information.

RPC Server
RPC Server responds to messages from applications configured for the TIBCO 
environment. Click Add RPC Server and then specify values for the fields listed 
in Table 16.

Table 16   RPC Server Options

Field Description

Configuration

Name Name of the RPC Server.

A service name must use alphanumeric characters. An underscore (_) character can be 
used. The entire instance name must be less than 80 characters. The space character cannot 
be used in an instance name. A service name cannot use substitution variables.
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Guidelines for Setting Type

There are two types of how a RPC Server can be used by the runtime adapter:

• Normal—The runtime adapter uses the username and password specified in 
the LotusNotes Connection shared resource of the adapter instance to connect 
to the Lotus Notes application.

• Withlogin—The runtime adapter uses the credentials of the dynamically 
logged-in user instead of the default parameters provided in the LotusNotes 
Connection shared resource of the adapter instance to connect to the Lotus 

Description Additional information about the RPC Server being configured.

Schema

Class Reference The AE Schema that is automatically generated from the selected BO when the adapter 
configuration is saved. The class reference for query operation is LOTUS_NOTES_RPC.

Business Object Available for operation types other than query.

Select Browse from the menu next to the Business Object field and choose from any of the 
previously imported BOs.

Request-Response Service Option

Operation Type Select one of the following options:

query Updates the required response service to the pre-defined LOTUS_NOTESRPC 
schema, available in the repository.

insert Associates the schema generated by the Request-Response Service to perform an 
insert operation in the Lotus Notes database.

update Associates the schema generated by the Request-Response Service to perform an 
update operation in the Lotus Notes database.

delete Associates the schema generated by the Request-Response Service to perform a 
delete operation in the Lotus Notes database.

upsert Associates the schema generated by the Request-Response Service to perform a 
upsert operation in the Lotus Notes database.

Type The type of RPC Server to be used by the runtime adapter, normal or withlogin. See 
Guidelines for Setting Type on page 68.

Enable Key Field 
On Insert

Available only for operation type Insert. When the checkbox is selected, the key fields 
will take effect to avoid data absence and duplication; otherwise, the new document will be 
inserted.

Table 16   RPC Server Options (Cont’d)

Field Description
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Notes application. The sessionID returned by the Login Service needs to be 
attached as user closure.

To configure a RPC Server with dynamic login, you also need a Login Service 
and a Logout Service.

Running RPC Server

RPC Server receives requests from the TIBCO environment, performs insert, 
update, delete, upsert, or query operation in the Lotus Notes database, and 
then returns the response to the TIBCO environment.

The way to run a RPC Server varies with the operation type to be performed.

Insert, Update, Delete, Upsert

For operation types insert, update, delete, and upsert, TIBCO ActiveMatrix 
BusinessWorks provides input of the request that will be retrieved by RPC Server 
later.

See Configuring SOAP Activity for RPC Server on page 99 for more information 
about how to use the activity.

Query

For the operation type query, there are several ways to provide input of the 
request that will be retrieved by the RPC Server later.

• Configure a RPC Client to act as a client for the RPC Server directly.

Detailed information about how to perform the query is defined in a client 
request form document, which can be found under the Request Response 
Invocation View folder in a TIBCO-enabled Lotus Notes database.

In this case, a TIB InitiateClientRequest agent is required to initiate the client 
request.

• Configure a SOAP Request Reply activity and manually enter the detailed 
information about how to perform the query in the Activity Input panel.

See Configuring SOAP Activity for RPC Server on page 99 for more 
information about how to use the activity.

• Establish a mapping of fields between a RPC Client and a SOAP 
Request-Reply activity in TIBCO Designer.

RPC Client fetches detailed query information from a client request form 
document defined in Lotus Notes database. SOAP Request Reply activity gets 
query information from RPC Client.
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Similar to the first approach, a TIB InitiateClientRequest agent is required to 
initiate the client request.

See Configuring SOAP Activity for RPC Server on page 99 for more 
information about how to use the activity.

RPC Client
RPC Client responds to the messages from applications configured for the TIBCO 
environment. To add a Request-Response Invocation Service, click Add RPC 
Client and then specify values for the fields listed in Table 17.

The Request-Response Invocation Request Document Editor facilitates users with 
a friendly GUI when they are performing the configuration in TIBCO Business 
Studio. Users can apply the configuration in two ways:

• Write to Request Response Invocation view manually.

–or–

• Update the view document in Lotus Notes through the Request-Response 
Invocation Request Document Editor.

Table 17   RPC Client Options

Field Description

Configuration

Name Name of the RPC Client.

A service name must use alphanumeric characters. An underscore (_) character can be 
used. The entire instance name must be less than 80 characters. The space character cannot 
be used in an instance name. A service name cannot use substitution variables.

By default, the name is rpcClient.

This name is the same as the Request Name of a client-request-enabled document from the 
Request Response Invocation View folder in Lotus Notes database.

Description Additional information about the RPC Client being configured.

Schema

Class Reference The AE Schema that is automatically generated from the selected BO when the adapter 
configuration is saved. The default value is LOTUS_NOTES_RPC.

Business Object Not available for RPC Client.
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Request-Response Invocation Service Option

Enable Poller If this checkbox is selected, Polling agent is actively processed.

Request-Response Invocation Request Document Editor

Operation Type Type of query operation. It can be query, view, FTSearch, or RunAgent.

When communicating with a Request-Response Service whose operation type is query, 
specify detailed query information with this option.

Formula Available only for the operation type query.

The querying formula which corresponds to the Formula field in the 
client-request-enabled document. See Guidelines for Using Formula on page 29.

View Name Available only for the operation type view.

The view name which corresponds to the View Name field in the client-request-enabled 
document.

Parameters Available only for the operation type FTSearch.

The parameters of FTSearch. This field corresponds to the Parameter field in the 
client-request-enabled document. See Guidelines for Setting FTSearch Parameters on 
page 30.

Agent Name Available only for the operation type RunAgent.

The agent to be invoked. With this option, you can configure to invoke Lotus agents at 
Request-Response Service side. This field corresponds to the Agent Name field in the 
client-request-enabled document.

Do not set the target field to All selected documents when defining the target agent 
in Lotus Domino Designer.

Result 
Customized

Configure whether the query result will be customized. This option corresponds to the 
Result Policy field in the client-request-enabled document.

Result Form 
Priority

Configure which decides the form of the result document first, local configuration or the 
form attribute of each record of the query result. This option corresponds to the Result 
Policy field in the client-request-enabled document. It is applicable only when the Result 
Customized checkbox is selected.

Result Form The form name of the result documents. It corresponds to the Result Form field in the 
client-request-enabled document. This field functions when the Result Customized 
checkbox is selected and the Result Form Priority is set to Client. At runtime, when you 
select Server, although the corresponding Requested Fields remains active, the Requested 
Fields does not take effect.

Table 17   RPC Client Options (Cont’d)

Field Description
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Running RPC Client

RPC Client gets a request from a Lotus Notes application and sends the request 
through the TIBCO environment, then returns the response back to the 
application. In TIBCO ActiveMatrix Adapter Service Engine for Lotus Notes, RPC 
Client carries detailed information of a RPC Server query operation.

RPC Client is triggered by TIB InitiateClientRequest agents. See Configuring 
Agents on page 15 about creating agents in Lotus Domino Designer.

Login Service
When the type of how a Subscriber or a RPC Server is to be used by the runtime 
adapter is withlogin, you need to configure a Login Service and a Logout 
Service.

Login Service responds to login requests from applications configured for the 
TIBCO environment. Click Add Login and then specify values for the fields listed 
in Table 18.

Requested 
Fields

The field names of the result documents. It corresponds to the Requested Fields field in the 
client-request-enabled document. Click the Get Fields button next to this field to set the 
requested fields.

Read Target Click this button to fetch a client-request-enabled document, whose Request Name is the 
same as the service name, from the Request Response Invocation View folder in 
Lotus Notes database.

—The first matching document with Request Status as UnProcessed will be fetched. And 
only one document can be fetched.

—If there are no UnProcessed matching documents, clicking this button creates a new 
document with the service name and you can edit it in the Request-Response Invocation 
Request Document Editor.

Apply Change Click this button to save the document in the Request Response Invocation View 
folder as UnProcessed.

Table 17   RPC Client Options (Cont’d)

Field Description

Table 18   Login Service Options

Field Description

Configuration
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Running Login Service

Login Service is used with Subscriber and RPC Server for the dynamic login 
feature.

Logout Service
When the type of how a Subscriber or RPC Server is to be used by the runtime 
adapter is set to withlogin, you need to configure a Login Service and a Logout 
Service.

The Logout Service responds to logout requests from applications configured for 
the TIBCO environment. The dynamically logged in user can be logged out of the 
Lotus Notes Application by sending a request to the Logout Service specifying the 
sessionID. Click Add Logout and then specify values for the fields listed in 
Table 19.

Name Name of the Login Service.

A service name must use alphanumeric characters. An underscore (_) character can be 
used. The entire instance name must be less than 80 characters. The space character cannot 
be used in an instance name. A service name cannot use substitution variables.

Description Additional information about the Login Service being configured.

Schema

Class Reference The AE Schema that is automatically generated from the selected BO when the adapter 
configuration is saved. The default value is LOGIN_RPC.

Business Object Not available for Login Service.

Table 18   Login Service Options (Cont’d)

Field Description

Table 19   Logout Service Options

Field Description

Configuration

Name Name of the Logout Service.

A service name must use alphanumeric characters. An underscore (_) character can be 
used. The entire instance name must be less than 80 characters. The space character cannot 
be used in an instance name. A service name cannot use substitution variables.

Description Additional information about the Logout Service being configured.
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Running Logout Service

Logout Service is used with Subscriber and RPC Server for the dynamic login 
feature.

Schema

Class Reference The AE Schema that is automatically generated from the selected BO when the adapter 
configuration is saved. The default value is LOGOUT_RPC.

Business Object Not available for Logout Service.

Table 19   Logout Service Options (Cont’d)

Field Description
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Log Sinks

Specify the output destination (sinks) for the trace messages in the Log Sinks tab.

Figure 24   Log Sinks

All Log Sinks
In this section, you can perform following tasks:

• Add a log sink

• Add a role to a log sink

• Remove a log sink

• Remove a role from a log sink

By default, there are a File sink and a STDIO sink. You can add more sinks. The 
available sink types are: File, Hawk, Network, and STDIO.
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General Options
Trace messages of the selected levels will be collected in the log sinks.

There are three types of logs (log sinks) that you can configure to hold trace 
messages, corresponding to three levels (roles) of trace messages, Information, 
Warning, and Error. A fourth level of trace messages, Debug, is reserved and 
should not be enabled unless requested by the TIBCO Product Support Group. To 
hold Debug trace messages will write a lot of information to the log file and 
significantly degrades the performance of the adapter service engine.

Turning on the levels can affect the performance of the adapter service engine. 
Therefore, it is recommended to turn on the required levels only.

Configuration
The configuration options varies with the sink types.

Table 20   Field Description of Log Sinks Configuration

Field Description

File Sink

Name The name of the log sink.

Description Description about the log sink.

File Name The path and name of the trace file.

File Limit (bytes) Maximum size of the file in bytes. The default value is 30000 bytes.

File Count The number of rollover files. The default value is 3.

Append Mode If checked, traces are appended to the existing file at startup.

If unchecked, the exisiting file is overwritten at startup if one of the same name exists.

STDIO Sink

Name The name of the log sink.

Description Description about the log sink.

Output Stream The option to write to out or error.
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Hawk Sink

(TIBCO Hawk functionality is not supported in current release.)

Name The name of the log sink.

Description Description about the log sink.

MicroAgent 
Name

Name of the microagent for traces from this Hawk sink. The Hawk sink uses the hawk 
session, created and used by the adapter for monitoring purposes, to send tracing 
messages to the TIBCO Hawk monitor or Display.

Network Sink

Name The name of the log sink.

Description Description about the log sink.

Subject The subject on which the trace messages need to be published. The Network sink is used 
to publish tracing message on TIBCO Rendezvous.

Session Reference Browse to select one of the previously defined sessions.

Table 20   Field Description of Log Sinks Configuration (Cont’d)

Field Description
 TIBCO ActiveMatrix Adapter Service Engine for Lotus Notes Configuration and Deployment
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Chapter 6 Configuring an ActiveMatrix SOA Project

Previous chapters described how to create an adapter project and configure an 
adapter instance. This chapter describes the process of creating an adapter 
component, adding services and references to the adapter component, and 
creating a service assembly.

Topics

• Creating an ActiveMatrix SOA Project, page 80

• Generating WSDL Files, page 81

• Configuring Composites, page 82

• Creating Service Assembly and Service Assembly Archive, page 87
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Creating an ActiveMatrix SOA Project

ActiveMatrix SOA projects contain assets that you can develop with TIBCO 
Business Studio. Before creating any type of asset you must first create an 
ActiveMatrix SOA project.

To create an ActiveMatrix SOA project:

1. From the File menu, select New > Project.

2. In the New Project dialog, expand TIBCO ActiveMatrix, select ActiveMatrix 
SOA Project. Click Next.

3. In the Project name field, enter a name for the project, for example, 
soa_proj01.

4. Select Basic SOA Project from the Available Templates list. The Basic SOA 
Project template creates a project with an empty composite. Click Next.

5. In the New ActiveMatrix SOA Project dialog, select the asset types that are 
required for your project.

6. Specify names for selected assets.

— To accept the default names, click Finish.

— To use different names, click Next, and then enter new names in 
corresponding fields.
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Generating WSDL Files

TIBCO ActiveMatrix services are described using WSDL files. To generate the 
WSDL file:

1. In the Project Explorer, right-click the adapter instance of the Adapter Project 
that you want to deploy, select Generate Adapter WSDL from the shortcut 
menu.

2. In the Target Project dialog, select the SOA project that you want to use, click 
OK.

Two folders will be created once the process is done:

• schema: this folder contains the adapter XSD schema.

• adapterConfigurationFilename_genresources: this folder contains following 
supporting resources:

— adapterConfigurationFilename_number.dat: contains information used by the 
Adapter container.

— adapterConfigurationFilename.adendpoints: the adapter service endpoints file 
which contains information about the service endpoints supported by the 
adapter. The file is used later to select service types.

— adapterConfigurationFilename.substvar: contains substitution variables that 
are imported from the adapter configuration file.

— adapterConfigurationFilename.wsdl: the generated WSDL file which references 
the schema and .dat files contains the service definition endpoints.

The shared resource that defines the transport used to communicate with the 
adapter is created. If the adapter project referenced global variables, the shared 
resource will reference substitution variables defined in the 
adapterConfigurationFilename.substvar file.

After using a WSDL in a composite, ensure that you do not overwrite the WSDL.
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Configuring Composites

In the ActiveMatrix platform, a composite exports a cohesive set of business 
functions as services. A composite contains of one or more components. A 
component contains a configured implementation, where the implementation 
provides the business functions.

The component configures the implementation with specific values for custom 
properties and by connecting component references to component services or 
composite references. The connections between references and services are 
represented by wires.

To configure a composite, follow the tasks below:

• Task A, Launch the Composite Editor, page 82

• Task B, Create a Shared Resource, page 82

• Task C, Add the Shared Resource to Composite, page 83

• Task D, Add Components, page 83

• Task E, Add Composite Service, page 84

For more information, refer to the TIBCO ActiveMatrix Service Grid 
documentation.

Task A Launch the Composite Editor

The Composite Editor is a graphical editor for developing composites.

In a SOA project, the composite file, SOAProjectName.composite is located at The 
Composite folder. You can double-click the SOA Project name.composite file to 
launch the Composite Editor.

Task B Create a Shared Resource

In order for the ActiveMatrix service to be accessible from external client, a shared 
resource must be added.

1. From the File menu, select New > TIBCO Shared resources.

2. In the TIBCO Resource Wizard dialog, select wizard approriate to the 
composite service type:

— For JMS service, select JMS.

— For SOAP service, select HTTP Server.

Click Next.
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3. Enter a name for the shared resource or accept the default. Specify the parent 
folder.

4. Click Finish.

5. Change the configuration in the Shared Resource Editor if necessary.

Task C Add the Shared Resource to Composite

To add the HTTP Server or JMS shared resource to the composite:

1. Click the canvas in the Composite Editor.

2. Click the Shared Resource Profiles tab in the Properties notebook.

3. In the Composite panel, click  in the name column. A new shared 
resource profile is created. Enter a name or accept the default name.

4. In the type column, choose HTTP or JMS.

5. In the Target column, click to bring up the Select Shared Resource dialog.

6. Choose the shared resource and click OK.

Task D Add Components

A component contains a configured implementation. To add a component to a 
composite:

1. In the Composite Editor, drag the LotusNotesAdapter component from the 
Palette to the Components column. And enter a name for the component.

2. In the Properties notebook, click the Services tab. Click Add.

3. In the Resource Picker dialog, select an adapter endpoint from the left hand 
pane, and then click Add to add the adapter service to the component.

4. Click OK.
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Figure 25   Add Resources to a Component

Table 21 lists the fields displayed in the General tab of the adapter component.

Task E Add Composite Service

A composite serive represents a port type and it enables consumers outside the 
ActiveMatrix environment to access port types implemented within 
ActiveMatrix.

To add a composite service:

Table 21   Fields of the General Tab

Property Name Description

Name The adapter component name.

Description The adapter component description.

Version The adapter component version number.

Type (Read-only) The adapter type.

SDK Application Name (Read-only) The instance name of your adapter configuration. Gets populated 
after adding services to the component.

Configuration URI (Read-only) The adapter configuration that the service uses. Gets populated after 
adding services to the component.

Repository URI (Read-only) This file contains information used by the container to communicate 
with the adapter service engine. Gets populated after adding services to the 
component.

TRA File Name The TRA file to use.
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1. In the Composite Editor, drag a service from the Palette to the Services 
column.

For TIBCO ActiveMatrix Adapter Service Engine for Lotus Notes, only JMS 
and SOAP services are available.

— Publisher and RPC Client can only use JMS.

— Subscriber, RPC Server, Login, and Logout can use either JMS or SOAP.

2. Enter a name for the service.

3. If you have added the component to the composite, click the Target tab of the 
Properties view, then select the target component to bind with the composite 
service.

Figure 26   Component and Composite Service Binding

Corresponding information is populated to the General tab and the Binding 
tab.

Figure 27   General Tab of Composite Service
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4. Click the Binding tab in the Properties notebook to add the shared resource 
profile:

— For JMS service, specify the shared resource profile in the Endpoint section.

— For SOAP service, specify the transport type and shared resource profile in 
the Transport Configuration section.

For the SOAP service, you calso need to click the Generate WSDL button to 
generate another .wsdl file in the Composites folder of the SOA project. This 
.wsdl file will later be used by an external client to access the service within 
ActiveMatrix.
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Creating Service Assembly and Service Assembly Archive

The adapter services that were created in the design phase have to be packaged 
into a service assembly before they can be deployed.

A service assembly contains service units and a descriptor that indicates the 
container into which each service unit is to be deployed into. The service 
assembly is then used to created a deployable archive, the service assembly 
archive.

Task A Create or Refresh a Service Assembly

• To create a service assembly:

1. In the Project Explorer, select the SOA project, expand the Composites folder.

2. Right-click the composite file, and then select Service Assembly from the 
shortcut menu.

3. Save the composite if prompted.

The deployment package, projectname.saf is created in the Deployment 
Packages folder.

• To refresh a service assembly:

1. In the Project Explorer, select the SOA project, expand the Deployment 
Packages folder.

2. Right-click the service assembly file, and then select Refresh Service 
Assembly from the shortcut menu.

Task B Create a Deployable Archive

To create a deployable archive:

1. In the Project Explorer, select the SOA project, expand the Deployment 
Packages folder.

2. Right-click the .saf file, and then select Build Archive from the shortcut 
menu.

3. Save the .saf file if prompted.

When the building process finished, you can find a .zip file in the 
Deployment Packages folder.

This service assembly archive can now be deployed and started using TIBCO 
ActiveMatrix Administrator. See Deploying the Service Assembly on page 103.
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Chapter 7 Working with TIBCO ActiveMatrix 
BusinessWorks

This chapter explains how to use TIBCO ActiveMatrix BusinessWorks adapter 
activities to work with the adapter service engine.

Topics

• Overview, page 90

• Importing Resources from WSDL File, page 91

• Selecting Web Service for SOAP Activity, page 92

• Configuring SOAP Activity for Subscriber, page 94

• Configuring SOAP Activity for RPC Server, page 99

• Running the Process, page 102
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Overview

TIBCO ActiveMatrix BusinessWorks provides ways to access the adapter services 
that are provided in the form of composites within ActiveMatrix.

JMS Palette

The JMS palette is used to send and receive JMS messages in a process definition. 
Both the JMS point-to-point (queues) and publish/subscribe (topics) models are 
supported.

SOAP Palette

For TIBCO ActiveMatrix Adapter Service Engine for Lotus Notes, Subscriber and 
RPC Server need to be accessed by TIBCO ActiveMatrix BusinessWorks processes 
from outside the ActiveMatrix. The SOAP palette, along with the WSDL Palette 
allow you to implement web services. SOAP Request Reply activity provides 
input information.

The SOAP Request Reply activity performs a request on the specified web service 
and optionally expects a reply from the web service. You can invoke both 
documents and RPC web services with this activity.

For more information about business process and activities, see the TIBCO 
ActiveMatrix BusinessWorks documentation.
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Importing Resources from WSDL File

To work with TIBCO ActiveMatrix BusinessWorks, you need create a project in 
TIBCO Designer, and then import resources from the WSDL file which is 
generated in TIBCO Business Studio for the SOAP service of the composite.

In TIBCO Designer:

1. Create a new project.

2. From the Project menu, select Import Resources from File, Folder, URL.

3. In the Import Resources or File dialog, select File (.xsd, .xslt, .wsdl, .*) from 
the Format list.

4. Click the Select a file from the file system button next to the File field to 
locate the .wsdl file which enables the TIBCO ActiveMatrix BusinessWorks 
activity to access the composite within ActiveMatrix.

Typically, the .wsdl file is located under the composite folder of the SOA 
project.

Figure 28   Import Resources from WSDL File

5. Click OK.

6. Save the project.

If there are more than one WSDL files generated under the same composite, 
import resources from all of them.
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Selecting Web Service for SOAP Activity

To invoke a Subscriber or RPC Server from outside ActiveMatrix, you need 
associate the web service with a SOAP Request Reply activity.

In TIBCO Designer:

1. In the Palette panel, select the Process palette.

2. Drag a Process Definition resource from the Palette panel to the Design 
panel.

3. Double-click the Process Definition icon in the Design panel.

4. In the Palette panel, select the SOAP palette.

5. Drag a SOAP Request Reply activity from the Palette panel to the Design 
panel.

6. Click the Create transition button on the Toolbar. Then connect the Start 
activity, SOAP Request Reply activity, and the End activity.

Figure 29   Process Definition

7. Select the SOAPRequestReply activity in the Design panel.

8. In the Configuration tab, click the Browse resources button next to the Service 
field.

9. In the Select a Resource dialog, click the By Location tab, and then select the 
WSDL file that you imported earlier. Click OK.
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Figure 30   Select a Resource for SOAP Activity

Information related with the web service gets populated into the activity 
fields.
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Configuring SOAP Activity for Subscriber

Most configurations for a SOAP Request Reply activity are carried out in the 
Activity Input panel under the Input tab.

Figure 31   Input Tab of the SOAP Request Reply Activity

ADAPTER_OPCODE

Subscription Service uses ADAPTER_OPCODE to learn what kind of operation is to 
be performed on a Lotus Notes database.

You can specify following values in the ADAPTER_OPCODE field: 1 stands for 
insert, 2 for update, 3 for delete, and 4 for upsert.

Type Coercion

For a document that has fields of type Any, if these fields are to be handled by the 
adapter in the TIBCO ActiveMatrix BusinessWorks process, you need to change 
their types in the Input Activity to be specific.
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For example, for a document that has attachment to be processed by the adapter, 
the corresponding field must be changed according to the type of the attachment 
in the Input activity.

1. In the Input tab, select the field that has an attached file that will be processed 
by the adapter later.

2. Click the Edit Statement button in the Activity Input pane.

3. In the Edit Statement dialog, click the Type tab, select the Type Substitute 
checkbox, and then change the field type according to the type of the 
attachment.

4. Click OK.

Determining Target Documents

Use the following fields to determine which documents will be operated:

• ^view^: select all documents in this view. When the adapter performs update 
or delete operation, this option has the highest priority.

• ^viewKey^: select documents in a view with key fields. This option is used 
together with ^view^. Multiple key fields are separated by comma.

• ^formula^: select documents with a formula. When performing update or 
delete operation, this attribute has lower priority than the ^view^ attribute.

• ^form^: select documents with this from name. This is the default option.

If the ADAPTER_OPCODE is set to perform update or delete operation, this 
field represents the form name of a document to be updated or deleted. This 
attribute has lower priority than ^formula^.

• ^formKey^: select documents of a form with key fields. This option is used 
together with ^from^. Multiple key fields are separated by comma. Only 
documents that match the values of this field will be updated or deleted. The 
formkey in the incoming message has higher priority over the local properties

You can also refer to the following conditions when perform the update or 
delete operation:

• Runtime View style: the attributes ^view^ and ^viewKey^ will be used if 
neither of them are blank.

• Runtime Formula style: the attribute ^formula^ will be used if neither of 
them are blank.

• Runtime Form style: the attributes ^form^ and ^formKey^ will be used if 
neither of them are blank.
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Designing Form style is similar to the previous style, except that the form and key 
are not decided at run time but configured at design time.

Guidelines on Using the ^viewKey^ Option

When working with the ^viewKey^ option, follow the rules below:

• The key fields specified with this option are columns of the view in Lotus 
Domino Designer. The field name must be the same as its corresponding 
column name.

• Only sortable columns can be key fields.

To verify whether a column is sortable, right-click the column name in Lotus 
Domino Designer, select Column Properties, and then click the Sorting tab in 
the Column dialog. The column is sortable when the Sort setting is Ascending 
or Descending.

Figure 32   Column Properties

• The sequence of key fields appeared in the ^viewKey^ option must be the 
same as that of the corresponding columns in the view.

• It’s not required to make all sortable columns key fields.

• When a sortable column is used as a key field, all the preceding sortable 
columns in the view must also be key fields, no matter whether the columns 
are continuous or not.

Take the SalesOrder view in the sample.nsf database as an example.

If the Enable Key Field on Insert checkbox is selected, and the key field in the 
View Schema tab has been selected, you should not change the corresponding 
values of the key field.
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Figure 33   Columns in Sample Database

Assume that there are only three sortable columns: customernumber, 
ordernumber, and dateordered. In such a case, valid key field options are as 
follows:

• customernumber

• customernumber,ordernumber

• customernumber,ordernumber,dateordered

Any other combinations are invalid.

Configuring for Subscriber with Dynamic Login

For TIBCO ActiveMatrix Adapter Service Engine for Lotus Notes, if you 
configure a Subscriber of type With Dynamic Login, you need to specify the 
sessionID in the Header section and the data to be subscribed in the Data section 
of the message.

The Input tab of SOAP Request Reply activity displays a sshWithHeader message 
consisting of a Header section and a Data section.
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Header Section

Under the sessionID field of the Header section, specify the sessionID 
corresponding to the login obtained from the Login Service.

Figure 34   Mapping Session ID in the Header Section

Data Section

Under the data fields of the Data section, specify the values corresponding to the 
fields in the form for which the Subscription Service is configured.

For Subscriber with Dynamic Login, you need configure SOAP Request Reply 
activities for Login Service and Logout Service.
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Configuring SOAP Activity for RPC Server

There are five types of operations for a RPC Server: insert, update, delete, 
upsert, and query. SOAP Request Reply activity gets the operation type from its 
corresponding RPC Server, while detailed information of all types of operations 
are defined in the Activity Input panel.

Fields in the Activity Input panel for query operation are different from other 
types of operations.

Insert, Update, Delete, Upsert

For operation types insert, update, delete, and upsert, the detailed 
information about how to perform the operation is manually input in the Data 
section or mapped from other applications. Figure 35 shows the Input tab of an 
insert operation.

Figure 35   Input Tab of Insert Operation

Query

For operation type query, specify the query type in the _caret_operationType_caret_ 
field: formula, runagent, view, or ftsearch. Then enter detailed information 
according to the query type.
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• For the query type formula, enter the formula to be executed in the 
_caret_formula_caret_ field. See Guidelines for Using Formula on page 29.

• For the query type runagent, enter the name of the agent to be called in the 
_caret_agentname_caret_ field.

The target field of the agent should not be All selected documents when 
created in the Lotus Domino Designer.

• For the query type view, enter the name of the view to be searched into in the 
_caret_view_caret_ field.

• For the query type ftsearch, enter full text search parameters in the 
ftSearchParameters field. See Guidelines for Setting FTSearch Parameters 
on page 30.

If TIBCO ActiveMatrix BusinessWorks is used alone to communicate with a 
Request-Response Service, you must manually input the information mentioned 
above.

If TIBCO ActiveMatrix BusinessWorks is used together with a Request-Response 
Invocation Service to communicate with a Request-Response Service, you should 
establish a mapping of their fields.

Type Coercion

For a document that has fields of type Any, if these fields are to be handled by the 
adapter in the TIBCO ActiveMatrix BusinessWorks process, you need to change 
their types in the Input Activity to be specific.

For example, for a document that has attachment to be processed by the adapter, 
the corresponding field must be changed according to the type of the attachment 
in the Input activity.

1. In the Input tab, select the field that has an attached file that will be processed 
by the adapter later.

2. Click the Edit Statement button in the Activity Input pane.

3. In the Edit Statement dialog, click the Type tab, select the Type Substitute 
checkbox, and then change the field type according to the type of the 
attachment.

4. Click OK.

Configuring for RPC Server With Dynamic Login

For RPC Server with dynamic login, three SOAP Request Reply activities are 
needed. One for Login, one for Logout, and one for RPC Server.
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Login Service

For the activity associated with the Login Service, you need map the username 
and password to the Activity Input fields.

Request-Response Service

For the activity associated with the Request-Response Service, you need map the 
sessionID from the Login Service to the _caret_userClosure_caret_ field:

1. In the Input tab, select the _caret_userClosure_caret_ field.

2. Click the Edit Statement button in the Activity Input pane.

3. In the Edit Statement dialog, click the Type tab, select the Type Substitute 
checkbox, and then change the field type to String.

4. Map the sessionID obtained through the Login Service to the 
_caret_userClosure_caret_ field.

Logout Service

For the activity associated with the Logout Service, you need map the SessionID 
to the Activity Input fields.
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Running the Process

After the service assembly has been started successfully using TIBCO 
ActiveMatrix Administrator, run the process in TIBCO Designer:

1. Click the Tester tab, and click the Start testing viewed process button.

2. Select the process that you want to run.

3. Click Load Selected.

See Deploying the Service Assembly on page 103 for information about how to 
start service assembly using TIBCO ActiveMatrix Administrator.
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Chapter 8 Deploying the Service Assembly

This chapter describes how you can deploy a service assembly archive using 
TIBCO ActiveMatrix Administrator.

Topics

• Overview, page 104

• Using the EAR2SA Tool, page 105

• Deploying a Service Assembly Archive, page 106
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Overview

The adapter service engine enables the adapter to run in the ActiveMatrix 
environment as a container and to provide services.

Adapter projects created using TIBCO Designer can also be packaged for 
deployment in the ActiveMatrix environment. Adapter projects can be designed 
to run in the following modes:

• Wired Mode—The adapter component is wired with other composite 
elements in the ActiveMatrix SOA project. Projects running in this mode 
interact with other components in the ActiveMatrix environment.

Projects created using TIBCO Business Studio always run in the wired mode. 
See Creating Service Assembly and Service Assembly Archive on page 87 for 
more information about creating the service assembly archive.

• Unwired Mode—The adapter component in the ActiveMatrix SOA project is 
not wired with other composite elements and does not participate in the 
ActiveMatrix environment. Projects running in the unwired mode do not 
provide services to or consume services from other ActiveMatrix components. 
The adapter configurations merely run in the ActiveMatrix node but the 
deployments can be life-cycled using TIBCO ActiveMatrix Administrator.

Projects imported using the .ear file always run in the unwired mode. See 
Using the EAR2SA Tool on page 105 for more information about creating 
service assembly archive from a .ear file.
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Using the EAR2SA Tool

An adapter EAR file created using TIBCO Designer is first imported into TIBCO 
Business Studio.

To create a service assembly archive from an EAR file:

1. From the File menu, select New > Project.

2. In the New Project dialog, expand TIBCO ActiveMatrix, select ActiveMatrix 
SOA Project. Click Next.

3. Type a name in the Project name field and click Finish.

4. In the Project Explorer view, right-click the folder and select Import....

5. Choose General > File System.

6. Click the Browse button to navigate to the directory where the .ear file is 
located.

7. Choose the .ear file and click OK.

8. In the Project Explorer view, right-click the imported .ear file and then select 
Build Service Assembly Archive.

9. The service assembly archive, EAR_fileName.zip, is created under the 
Deployment Packages folder.

The service assembly archive that is created can now be deployed.

The project will continue to use the encoding set in the Designer project.
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Deploying a Service Assembly Archive

This section describes the tasks to configure and deploy a service assembly. These 
tasks are performed using TIBCO ActiveMatrix Administrator. Deploying a 
service assembly archive involves the following activities:

• Uploading a Service Assembly Archive, page 106

• Configuring the Service Assembly, page 106

• Deploying the Service Assembly, page 107

• Starting the Service Assembly, page 108

Uploading a Service Assembly Archive
The following steps describe how to upload the service assembly archive:

1. Select the Deploy to an Environment perspective.

2. Choose the Environment, and then click Upload Service Assembly.

3. In the Name field, enter a name for the service assembly.

4. Click Browse to select an archived ZIP file (the SA project) which was 
generated in TIBCO Business Studio.

5. Select the Import Shared Resource Definitions checkbox to create the shared 
resources definitions from the definitions in the service assembly archive.

6. Click OK.

The service assembly will appear in the Service Assemblies table.

Configuring the Service Assembly
To configure a service assembly, you need complete the following tasks.

Task A Configure the Service Unit

Specify the nodes on which the service units in the service assembly will be 
deployed.

1. In the Service Assemblies table, select the service assembly.

Before proceeding, ensure that the environment for TIBCO ActiveMatrix has been 
configured correctly. See TIBCO Activematrix documentation for more 
information about how to configure the environment.
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2. Click Service Units to view the service units in the selected service assembly.

3. For each service unit in the service assembly, do the following:

a. Select a service unit in the Service Units table.

b. In the Node Mapping tab, click Edit, select the nodes that you want to 
deploy the service unit to in the Available Nodes list, and then click the 
right arrow button. The nodes will appear in the Mapped Nodes list.

c. Click Save.

The service unit properties are displayed in the following tabs:

• Node Mapping — you can map the nodes to service units. See TIBCO 
ActiveMatrix Administration for details.

• Substitution Variables — you can specify the value of the service unit’s 
substitution variables. See TIBCO ActiveMatrix Administration for details.

Task B Start Node and Install Shared Resources

If an ActiveMatrix Service (JMS or SOAP) is included in the SA project, you need 
install the corresponding Shared Resource for the appropriate node.

1. In the web browser, select Configure an Environment in the Perspective 
drop-down list, and then select the appropriate Environment.

2. In the Nodes table, select the appropriate node. Click Start.

3. In the node detail panel, select Shared Resources.

4. Select the corresponding shared resource. Click Edit.

5. In the Enabled at Startup column, select the Yes radio button. Click Save.

6. On the top of the Shared Resources table, click Install.

Deploying the Service Assembly
A service assembly is ready to be deployed once the service assembly is uploaded 
and configured. Before proceed with deploying the service assembly, verify the 
following:

• All nodes required for deployment are running.

• All containers required for deployment are activated.

• All shared resources are installed.

To deploy a service assembly:

1. In the Service Assemblies table, select the service assembly.
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2. Click Deploy.

Once the service assembly is deployed, the status changes to Deployed.

Starting the Service Assembly
After a service assembly has been successfully deployed, you can start it, and if 
required, stop it.

1. In the Service Assemblies table, select one or more service assemblies.

2. To start the selected service assemblies, click Start. The status changes to 
Running.

3. To stop the selected service assemblies, click Stop. The status changes to 
Deployed.
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Chapter 9 Advanced Topics

This chapter explains advance topics of advanced features of TIBCO ActiveMatrix 
Adapter Service Engine for Lotus Notes.

Topics

• Managing Logging, page 110

• Using the Adapter Service Engine with a Revision Control System, page 111

• Using Substitution Variables, page 112

• Lotus Notes Language Support, page 117
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Managing Logging

Trace messages are used to trace and troubleshoot an exception condition when 
an exception occurs at runtime.

You can configure the logging of trace messages using the TIBCO Common 
Logging framework by leveraging on the availability of Common Logging 
libraries in the ActiveMatrix environment. The Common Logging framework 
provides common messages and error codes that can be used across TIBCO 
products to log messages in a uniform manner. 

To enable the common logging feature, the following properties are used:

• application.ase.consoleoutput

• tibco.env.ADAPTER_ENABLE_CL

The following table describes the usage of these properties.

Table 22   Properties for Common Logging Feature

Property Values Behavior

application.ase.consoleoutput = false

tibco.env.ADAPTER_ENABLE_CL = false

The common logging feature is disabled and the trace 
messages are written to the adapter log files.

application.ase.consoleoutput = true

tibco.env.ADAPTER_ENABLE_CL = false

The common logging feature is disabled and the trace 
messages are displayed on the console.

When the application.ase.consoleoutput 
property is set to true, any value assigned to the 
tibco.env.ADAPTER_ENABLE_CL property is 
ignored.

application.ase.consoleoutput = false

tibco.env.ADAPTER_ENABLE_CL = true

The common logging feature is enabled.
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Using the Adapter Service Engine with a Revision Control System

TIBCO Business Studio supports revision control systems such as Microsoft 
Visual SourceSafe, TortoiseSVN, and Perforce.

To add a project to the revision control system:

1. Start TIBCO Business Studio.

2. In the Project Explorer, right-click the project that you want to add, select 
Team > Share Project.

3. In the Share Project dialog, select a repository type to share the project. Click 
Next.

4. Enter necessary parameters when prompted.

Figure 36   Add Files to the Revision Control System
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Using Substitution Variables

The variable substitution mechanism can override substitution variables 
predefined in the project in a restricted manner. Predefined variables can be 
viewed and set in TIBCO Business Studio. Variables are specified as %%VARNAME%% 
and cannot contain any white space.

Variable substitution allows you to accomplish the following.

• Substitute string variables specified in the project at startup time.

• Locally define the value for a variable for a specific project. The local value 
takes precedence over any global value.

• Specify the value for a variable in a properties file. This overrides the project 
repository and values set in code, but not variables set on the command line. 

• Enforce the pre-defined variables listed in Predefined Substitution Variables 
on page 114.

Variables can be used anywhere in the configuration and will be replaced by 
the locally defined adapter instance. 

Variable Specification
The adapter service engine can specify variables in the project during 
configuration using TIBCO Business Studio. It can also specify variables in a 
properties file. The properties file values overwrite values set in the project.

Specifying Substitution Variables Using TIBCO Business Studio

Substitution variables provide an easy way to set defaults for use throughout 
your project.

For example, you could assign the value 7600 to the predefined substitution 
variable RvaPort. And then use the variable in different sessions in the adapter 
service engine. To change the TIBCO Rendezvous daemon for the adapter service 
engine, globally set it to a different value or override it from the command line.

To use substitution variables in your project:

1. In the Project Explorer, expand defaultVars, double-click 
defaultVars.substvar. 

2. All currently defined substitution variables are displayed in the editor view.
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You can do the following:

— To assign or change a variable value, select the variable from the Defined 
Substitution Variables section, then go to the Details section, enter the new 
value in the Value field.

— To add a substitution variable, click Add in the Defined Substitution 
Variables section. A new substitution variable entry is added to the bottom 
of the list. Enter the variable name, type, and, optionally, the value and 
description.

Figure 37   Substitution Variables

3. To use the substitution variable in the fields of a resource, enter the variable 
name enclosed with %% on both sides or pick a substitution variable from the 
Binding Editor.

When the project is deployed and the configured components are run, all 
occurrences of the substitution variable name are replaced with the 
substitution variable value (unless it was overridden in a way that had higher 
precedence). For example, RvService would be replaced with 7500.

Changing Substitution Variables at Runtime

At runtime, you can update the values of the substitution variables using TIBCO 
ActiveMatrix Administrator.
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The following figure shows the Substitution Variables editor in TIBCO 
ActiveMatrix Administrator, where you can specify runtime values for 
substitution variables

Figure 38   Substitution Variables in TIBCO ActiveMatrix Administrator

A number of substitution variables are predefined. See Predefined Substitution 
Variables on page 114 for information. You can add definitions of any variables 
you need to the predefined variables.

Predefined Substitution Variables
Table 23 lists and explains the predefined substitution variables. Some of them are 
automatically used within the system when an adapter instance is configured.

Table 23   Predefined Substitution Variables

Variable Description

Deployment Defaults to the project name. This variable is used by the system to partially define 
the subject name defined for a service.

DirLedger Used by the system when defining the path name of the TIBCO Rendezvous 
certified messaging ledger file. The default is root installation directory.

DirTrace Used by the system to partially create the path name for log file used by the 
adapter. The default is the root installation directory.

Domain The default value is Domain. This value can be any string value. This variable is 
used by the system to partially define the subject name defined for a service.

HawkEnabled Used by the system to indicate whether TIBCO Hawk is used to monitor the 
adapter. True indicates that a Hawk microagent is defined for the adapter. False 
indicates the microagent is not to be used.

JmsProviderUrl  Specifies where the EMS server is located. Setting this value mostly makes sense in 
early stages of a project, when only one EMS server is used.
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JmsSslProviderUrl Specifies where the EMS SSL daemon is located.

RemoteRvDaemon Used by the system to identify the TIBCO Rendezvous routing daemon. See TIBCO 
Rendezvous Administration for details about specifying the routing daemon name.

RvDaemon Used by the system to identify the TIBCO Rendezvous daemon parameter. The 
parameter instructs the transport object about how and where to find the 
Rendezvous daemon and establish communication. The default value is "tcp: 
7500", which is the default value used by the Rendezvous daemon. See TIBCO 
Rendezvous Concepts for details about specifying the daemon parameter.

RvNetwork Used by the system to identify the TIBCO Rendezvous network parameter. Every 
network transport communicates with other transports over a single network 
interface. On computers with more than one network interface, the network 
parameter instructs the TIBCO Rendezvous daemon to use a particular network for 
all outbound messages from this transport. See TIBCO Rendezvous Concepts for 
details about specifying the network parameter.

RvService Used by the system to identify the TIBCO Rendezvous service parameter. The 
Rendezvous daemon divides the network into logical partitions. Each transport 
communicates on a single service; a transport can communicate only with other 
transports on the same service. The default value is 7500.You can change the 
default value depending on your service requirement. See TIBCO Rendezvous 
Concepts for details about specifying the service parameter.

RvaHost Used by the system to identify the computer on which the TIBCO Rendezvous 
agent runs. See TIBCO Rendezvous Administration for details about specifying the 
rva parameters.

RvaPort Used by the system to identify the TIBCO Rendezvous agent TCP port where the 
agent listens for client connection requests. See TIBCO Rendezvous Administration 
for details about specifying the rva parameters.

TIBHawkDaemon Used by the system to identify the TIBCO Hawk daemon parameter. See the TIBCO 
Hawk Installation and Configuration manual for details about this parameter. 

TIBHawkNetwork Used by the system to identify the TIBCO Hawk network parameter. See the TIBCO 
Hawk Installation and Configuration manual for details about this parameter.

TIBHawkService Used by the system to identify the TIBCO service parameter. See the TIBCO Hawk 
Installation and Configuration manual for details about this parameter.

adln.attachmentlo
cation

Used by the runtime adapter to identify the location of the attachment file that has 
to be attached with the Lotus Notes Document.

Table 23   Predefined Substitution Variables (Cont’d)

Variable Description
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adln.connection.d
atabase

Used at design-time to identify the name of the .nsf file to connect to. If the .nsf file 
resides in the local file system, specify the entire path in order to access the 
database.

adln.connection.d
ominoserver

Used at design-time to identify the name of the machine that hosts the Lotus 
Domino Server.

adln.connection.i
dfile

Used at the design-time to identify the ID file is the User ID file location in the local 
file system.

adln.connection.p
assword

Used at the design-time to identify the password associated with the username that 
is used to log on to Lotus Notes.

adln.connection.u
sername

Used at the design-time to identify the username used to log on to Lotus Notes.

Table 23   Predefined Substitution Variables (Cont’d)

Variable Description
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Lotus Notes Language Support

Language support refers to the ability of a product to support basic input, display, 
and data integrity (during storage and/or transmission) for character sets of 
various languages. Multiple language support is often grouped by region, 
because different code pages are used by different operating systems to support 
the characters found in various languages:

• English and Western Languages;

• Eastern European and Cyrillic languages;

• other single byte character set languages such as Greek, Turkish, Thai, Hindi, 
etc.;

• DBCS languages, as listed earlier;

• bi-directional languages, like Arabic or Hebrew.

The advantage of having multiple language support is the ability to create 
documents that can contain characters from any of the supported languages.

Encoding Support

The adapter service engine supports the character sets listed in Table 24.

For details on language support for Lotus Notes, refer to the Lotus White Paper 
on Globalization.

Table 24   Encoding Support

Encoding  Description

ASCII 7-bit ASCII

Shift_JIS (CP943) Japanese Shift-JIS, CP943

BIG 5 Traditional Chinese BIG5 (with Euro Sign)

For the Lotus Notes agents, the data sent over HTTP are strings, which are in Java 
unicode by default. The Java strings are converted to UTF8 encoding so that there 
will be no issues in globalization.
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Prerequisite for Globalization

For the adapter service engine to run against the Japanese and Chinese (BIG5) 
character sets, it is recommended to install the Lotus Notes application software 
on Japanese and Chinese languages.

How the Adapter Service Engine Handles Unicode and Date Formats

The adapter extracts and inserts character data and dates from and into the Lotus 
Notes application using Lotus Notes APIs.

Character data is processed as standard Java Strings (java.lang.String).

Date data is returned as a Lotus data type called 
DateTime(lotus.domino.DateTime) which can be converted to a standard Java 
Date(java.util.Date) regardless of date formats. Similarly a standard 
java.util.Date can be converted into a lotus.domino.DateTime to insert a date 
value in the Lotus Notes application.
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Appendix A Trace Messages

This appendix explains the trace messages that are logged to a location specified 
at configuration time.

Topics

• Overview, page 120

• Trace Message Fields, page 122

• Status Messages, page 123
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Overview

Trace messages provide information about adapter activities. The messages are 
logged to the console where the runtime adapter was started and to a log file. 
Trace messages can also be redirected to the TIBCO Hawk Display application, or 
sent to other applications using the TIBCO Rendezvous transport.

Each trace message includes the following fields:

<Timestamp> <Adapter Identifier> <Role> <Category> <Status Code>

The above fields are explained in Trace Message Fields on page 122. Figure 39 
shows an example trace message and calls out the fields.

Figure 39   Trace Message

Example Trace Messages

The following trace messages were written during a session where TIBCO 
ActiveMatrix Adapter Service Engine for Lotus Notes received an insert request 
and create a new document in Lotus database.

The first message indicates that TIBCO ActiveMatrix Adapter Service Engine for 
Lotus Notes received a request. The timestamp indicates when the request is 
received, and the role indicates that the message is informational, which means 
the activity is normal for the adapter. The category is identified, and the 
corresponding status code is displayed.

2009 Jun 29 13:57:37:829 GMT +8 LotusNotesAdapterConfiguration Info 
[Server] AELN-2000333 "Received a New Request. The tracking ID is: 
Q1G-AVZi8dQ90-elx4QccFOkb3o"

The next set of trace messages indicates the adapter performs the insert operation 
and a new document is created in the database.

2009 Jun 29 13:57:38:188 GMT +8 LotusNotesAdapterConfiguration Info 
[Adapter] AELN-2000303 "Performing the Inserts ............"

2009 Jun 29 13:57:38:579 GMT +8

AELN-2000300 "Request processed successfully. The tracking ID is : Q1G-AVZi8dQ90-
elx4QccFOkb3o"

LotusNotesAdapterConfiguration Info [Adapter]

Timestamp

Adapter Identifier Role Category

Status Code
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2009 Jun 29 13:57:38:579 GMT +8 LotusNotesAdapterConfiguration Info 
[Server] AELN-2000274 "Document successfully created in the 
database..."

The final trace message indicates the request has been processed successfully. The 
tracking identifier included in the message uniquely identifies the message.

2009 Jun 29 13:57:38:579 GMT +8 LotusNotesAdapterConfiguration Info 
[Adapter] AELN-2000300 "Request processed successfully. The 
tracking ID is : Q1G-AVZi8dQ90-elx4QccFOkb3o"
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Trace Message Fields

Table 25 lists the fields in each trace message.

Table 25   Tracing Fields

Field Name Description

Timestamp Timestamp of occurrence. For example, 2009 Jun 29 13:57:38:579 GMT +8.

Adapter Identifier Name of the adapter that wrote the trace message. This is the adapter configuration 
name.

Role A role can be:

Info Indicates normal adapter operation. No action is necessary. A tracing message 
tagged with Info indicates that a significant processing step was reached and has been 
logged for tracking or auditing purposes. Only info messages preceding a tracking 
identifier are considered significant steps.

Warn An abnormal condition was found. Processing will continue, but special 
attention from an administrator is recommended.

Error An unrecoverable error occurred. Depending on the error severity, the adapter 
may continue with the next operation or may stop altogether.

Debug A developer-defined tracing message. In normal operating conditions, debug 
messages should not display.

When configuring the adapter you define what roles should or should not be logged. 
For example, you may decide not to log Info roles to increase performance.

Category One of the following:

Adapter The adapter is processing an event.

Application The adapter is interacting with the Lotus Notes application.

Client The Request-Response Invocation Service is reporting this trace message.

Server The Request-Response Service is reporting this trace message.

Status Code Unique code for the message and description. Status codes are identified by a unique 
number and description. If a trace message includes an error or warn role, the status 
code documentation includes a resolution. See Status Messages on page 123 for details.

Tracking Identifier A unique identifier that is "stamped" on each message by the originating adapter. The 
tracking identifier remains in effect from a message’s beginning to its completion as it is 
exchanged by TIBCO applications. If the adapter is the termination point of the 
message, the tracking identifier is not displayed in the trace message. 

You cannot modify the tracking identifier format or configure what information is 
displayed.

In TIBCO ActiveMatrix Adapter Service Engine for Lotus Notes, the tracking identifier 
is within the status code.
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Status Messages

In environments where multiple applications are used simultaneously, the 
possible status of messages increases as well. This appendix lists the various 
messages in numerical order.

Table 26   Status Message

Status Code Role Category Resolution

AEADLN-500001 Fatal Error/Error in creating staticmetadata classes and sequences

Error Configuration Check the adapter configuration settings.

AEADLN-500002 Fatal Error/Error in creating replymetadata class

Error Configuration Check the adapter configuration settings.

AEADLN-500003 Fatal Error/Error in creating onewaymetadata class

Error Configuration Check the adapter configuration settings.

AEADLN-500004 Configuration Rename Error/ Adapter Configuration names must have only 
alphanumeric characters with no embedded spaces and can be up to 80 characters 
long. Type in a valid name.

Error Configuration Enter a valid name without spaces and less 
than 80 characters.

AEADLN-500005 Lotus Notes Adapter Instance/Do you want to rename the configuration instance 
%1'?

Warning Configuration Indicates normal adapter operation. No action 
required.

AEADLN-500006 Message/Design-Time Connection is successful

Information Configuration Indicates normal adapter operation. No action 
required. 

AEADLN-500007 Design-Time Connection Failed/%1

Error Configuration Check the design-time connection parameters.

AEADLN-500008 Message/ Specify a valid Lotus Notes Database name

Warning Configuration Check if the database exists and the name is 
entered properly.
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AEADLN-500009 Message/Run-Time Test Connection is successful

Information Configuration Indicates normal adapter operation. No action 
required.

AEADLN-500010 Run-Time Test Connection Failed/%1

Error Configuration Check the run-time connection parameters.

AEADLN-500011 Message/Specify a valid Lotus Notes Database name

Warning Configuration Check if the database exists and the name is 
entered properly.

AEADLN-500012 Error Occurred/Error updating RPC class

Error Configuration Check if the database exists and the name is 
entered properly.

AEADLN-500013 Error Occurred/Error updating Record class with noteId field

Error Configuration Check if the database exists and the name is 
entered properly.

AEADLN-500014 Fatal Error/Error in reading the Design-time panel connection parameters

Error Configuration Check if the design-time connection-time 
parameters are entered correctly.

AEADLN-500015 Field:Instance Name/Palette error. Adapter Configuration names must have only 
alphanumeric characters with no embedded spaces and can be up to 80 characters 
long. Type in a valid name.

Error Configuration Enter a valid name without spaces and less 
than 80 characters.

AEADLN-500016 Field:No Retries Before Suspend/Palette error. The Number of Reconnect 
Attempts must be greater than or equal to 0, and less than or equal to 65535

Error Configuration Enter a number between 0 and 65535.

AEADLN-500017 Field:HTTP Port to Listen to LotusNotes Events/Palette error. The Port must be 
greater than 0, and less than or equal to 65535.

Error Configuration Enter a number greater than zero and less 
than or equal to 65535.

Table 26   Status Message (Cont’d)

Status Code Role Category Resolution
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AEADLN-500018 Field:Max No of Retries/Palette error. The Maximum Number of Retries must be 
greater than or equal to -1, and less than or equal to 65535

Error Configuration Enter a number greater than or equal to -1 and 
less than or equal to 65535.

AEADLN-500019 Field:Sleep Between Retries/Palette error. The Sleep Between Retries must be 
greater than or equal to 0, and less than or equal to 65535

Error Configuration Enter a number greater than or equal to 0 and 
less than or equal to 65535.

AEADLN-500020 Field:Polling Interval/The value entered should be greater than 0 and less than 
65535

Error Configuration Enter a number greater than zero and less 
than 65535.

AEADLN-500021 Field:Polling Batch Size/The value entered should be greater than or equal to 0 
and less than 65535

Error Configuration Enter a number greater than or equal to 0 and 
less than 65535.

AEADLN-500022 Field:Termination Subject/Palette error. This field is mandatory

Error Configuration Enter a value for the termination subject and 
do not leave the field blank.

AEADLN-500023 Field:Database/Palette error. This field is mandatory

Error Configuration Enter a value for database field and do not 
leave the field blank.

AEADLN-500024 Connection Retry Mechanism Warning/This adapter version does not support 
connection retry mechanism. The values configured in the Run-time Connection 
tab will be ignored

Warning Configuration You are probably using an older version of the 
adapter which does not support connection 
retry mechanism.

Table 26   Status Message (Cont’d)

Status Code Role Category Resolution
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AEADLN-500025 Connection Retry Mechanism Warning/This adapter version does not suspend 
services on connection failure. The configured value 'Number of Reconnect 
Attempts Before Suspending Impacted Service(s)' will be ignored

Warning Configuration You are probably using an older version of the 
adapter which does not support suspending 
services on connection failure.

AEADLN-500026 JMS Service Configured/This adapter's version does not support JMS services, 
but one was found. Use the GO TO button to select it.

Error Configuration Do not use JMS service if you are using an 
older version of the adapter which does not 
support JMS services.

AEADLN-500027 XML Wire Format found/This adapter version does not support XML Wire 
Format

Error Configuration Do not use XML wire format if you are using 
an older version of the adapter which does not 
support XML wire format.

AEADLN-500028 Multiple Type of services found/This adapter version does not support multiple 
type of services to reside in the same adapter instance configuration

Error Configuration Do not configure more than one service in an 
instance if you are using an older version of 
the adapter.

AEADLN-500029 Field:Instance Name/Names for adapters of the same type should be unique

Error Configuration Check if there is another adapter instance with 
the same name. If so, enter a unique name.

AEADLN-500030 Palette Error/Palette error. The value of ’Number of Reconnect Attempts Before 
Suspending Impacted Service(s)' should be less than the value of 'Maximum 
Number of Reconnect Attempts'/'

Error Configuration Check if the value of number of reconnect 
attempts is less than the maximum number of 
reconnect attempts.

AEADLN-500031 Global Variable File Read-Only File/Global Variable files needs to be checked 
out in order to successfully create the adapter

Error Configuration Check if the global variable file is locked.

Table 26   Status Message (Cont’d)

Status Code Role Category Resolution
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AEADLN-500032 Error During Delete : Read-Only File/The resource " %1 " could not be deleted. 
Delete requires that " %2 " must be checked out. Check out the resource and try 
deleting again. You can select the resource to be checked out by clicking the "Go 
To Resource" button.

Error Configuration Check out the associated resource and try 
again.

AEADLN-500033 Error During Rename : Read-Only File/The resource " %1 " could not be 
renamed. Rename requires that " %2 " must be checked out. Check out the 
resource and try renaming again. You can select the resource to be checked out 
by clicking the "Go To Resource" button.

Error Configuration Check out the associated resource and try 
again.

AEADLN-500034 Warning:Add File to RCS

Warning Configuration Add file to RCS. 

AEADLN-500035 Message: "%1" was created during schema generation. Ensure that this resource 
"%2" is added to RCS and checked in. Click the Go To Resource button to select 
the resource

Warning Configuration Add file to RCS.

AEADLN-500036 Transformation Plugin Warning/Warning: This adapter version does not support 
transformation plugin. The transformation plugin configuration will be ignored.

Warning Configuration Check the AE version. Older AE versions do 
not have the Message Filter.

AEADLN-500037 Fatal Error/Error in creating HeaderClass for Subscriber

Error DTA Check the project file if it is proper; else 
re-open the project. 

AEADLN-500038 Field:Session Idle Timeout/The value entered should be greater than or equal to 
0 and less than 65535

Error DTA Enter a valid value for Session Idle Timeout. 

AEADLN-500039 Field:Session Expiry Time/The value entered should be greater than or equal to 0 
and less than 65535

Error DTA Enter a valid value for Session Expiry Time.

Table 26   Status Message (Cont’d)

Status Code Role Category Resolution
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AEADLN-500040 Field:Session Idle Timeout/.The Session Idle Timeout value should be less than 
or equal to Session Expiry Time value.

Error DTA Enter a valid value for Session Expiry Time 
and Session Idle Timeout.

AEADLN-510001 Operation Schema Generation Successful/Request-Response Operation Schema 
for handling query requests is successfully associated with the service

Information SRVC Indicates normal adapter operation. No action 
required.

AEADLN-510002 Message/View Name Not chosen/Select a Lotus View name using Fetch Schemas

Error SRVC Select a view name using the FetchSchema 
option and check whether a valid database 
name has been specified in the instance level.

AEADLN-510003 Message/%1

Information SRVC Indicates normal adapter operation. No action 
required.

AEADLN-510004 Message/Publisher Schema regenerated with user Specified Name %1

Information SRVC Indicates normal adapter operation. No action 
required.

AEADLN-510005 Message/Publisher Schema regenerated with default Name %1

Information SRVC Indicates normal adapter operation. No action 
required.

AEADLN-510006 Message/Schema regeneration failed

Information SRVC Indicates normal adapter operation. No action 
required.

AEADLN-510007 Error occurred/Form property chosen. Specify a Lotus Form

Information SRVC Indicates normal adapter operation. No action 
required.

Table 26   Status Message (Cont’d)

Status Code Role Category Resolution
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AEADLN-510008 Message/Subscriber Schema will be generated with user Specified Name %1

Information SRVC Indicates normal adapter operation. No action 
required.

AEADLN-510009 Message/Subscriber Schema will be generated with default Name %1

Information SRVC Indicates normal adapter operation. No action 
required.

AEADLN-510010 Message/Schema regeneration failed

Error SRVC Check if the schema exists in the Lotus Notes 
database.

AEADLN-510011 Schema Generation Failed/No Lotus Notes documents available in the requested 
view. Create a sample document in the database for the chosen view name

Information SRVC Make sure that there is at least one document 
in the requested view. If not, create a sample 
document.

AEADLN-510012 Multiple Type of services found/This adapter version does not support multiple 
type of services to reside in the same adapter instance configuration

Warning SRVC Do not configure more than one service in an 
instance if you are using an older version of 
the adapter.

AEADLN-5100015 Error/The name WithHeader for class names is reserved. Specify a different 
name

Information DTA Indicates normal adapter operation. No action 
required.

AEADLN-5100016 Message/Classname cannot end with ’WithHeader’. This string will be removed 
and the new class name will be updated in SaveAs:column

Information DTA Indicates normal adapter operation. No action 
required.

AEADLN-5100017 Message/You have selected Subscriber Type: With Dynamic Login

Information DTA Indicates normal adapter operation. No action 
required.

Table 26   Status Message (Cont’d)

Status Code Role Category Resolution
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AEADLN-520013 Illegal Operation/Selected Resource Cannot Be Moved

Warning SRVC Check if the associated schema of the resource 
is locked.

AEADLN-520014 Deleting Schema Reference/%1 Schema already exists. Do you want to Update 
Schema?

Warning SRVC Indicates normal adapter behavior. No action 
required.

AEADLN-520015 Schema Generation Successful/RPC Operation Schema generated with name %1 
Special characters in View Names will be removed when generating schemas

Information SRVC Indicates normal adapter operation. No action 
required.

AEADLN-520016 Error During Move|Paste : Read-Only File /The resource " %1 " could not be 
moved|pasted. Move|Paste requires the " %2 "  must be checked out. Check out 
the resource and try move|paste again. You can select the resource to be checked 
out by clicking the "Go To Resource" button.

Error SRVC Check out the associated resource and try 
again.

AEADLN-520017 Error During Delete : Read-Only File/The resource " %1 " could not be deleted. 
Delete requires that " %2 " must be checked out. Check out the resource and try 
deleting again. You can select the resource to be checked out by clicking the "Go 
To Resource" button.

Error SRVC Check out the associated resource and try 
again.

AEADLN-520018 Error During Move:Read-Only File/The resource " %1 " could not be moved. 
Move requires that " %2 " must be checked out. Check out the resource and try 
moving again. You can select the resource to be checked out by clicking the "Go 
To Resource" button.

Error SRVC Check out the resource and try moving again.

AEADLN-520019 Error during GetSchema:Read Only File/The Schema fetched cannot be written 
into the Read-Only File

Error SRVC Get edit permissions for the file. 

Table 26   Status Message (Cont’d)

Status Code Role Category Resolution
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AEADLN-520001 %1/Agents are not defined in the Lotus Notes Database

Warning DTA Define an agent in the Lotus Notes database 
and try again.

AEADLN-520002 Message/%1

Error DTA The error is generic. Check the description of 
the error message. 

AEADLN-520003 Fetch Schemas Error/Possible reasons : Views are not defined in the Lotus Notes 
database or unable to access the views defined in the Lotus Notes database

Error DTA Check if views are defined in the Lotus Notes 
database. If not, define them.

AEADLN-520004 Message/%1

Error DTA The error is generic. Check the description of 
the error message.

AEADLN-520005 Error occurred/Adapter Service names must only have alphanumeric characters 
and must be at most 80 characters long. Type in a valid name.

Error DTA Type in a valid name and try again.

AEADLN-520006 Login Schema Successfully associated with Service

Information DTA Indicates normal adapter operation. No action 
required.

AEADLN-520007 Logout Schema Successfully associated with Service

Information DTA Indicates normal adapter operation. No action 
required.

AEADLN-520008 Warning/You have selected Subscriber Type: With Dynamic Login. Selecting 
this option will not allow you to change the subscriber type anymore. Press OK 
to confirm, cancel to revert.

Warning DTA Selecting this option will not allow you to 
change the subscriber type anymore. Make 
sure that you require this option.

Table 26   Status Message (Cont’d)

Status Code Role Category Resolution
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AEADLN-520009 Warning/You have selected Subscriber Type: With Dynamic Login. Selecting 
this option will not allow you to make further changes to Configuration form. 
Press OK to confirm, cancel to revert.

Warning DTA Make sure that all the settings are finalized.

AELNDTA-0000001 Lotus Notes DTA (RV) ready to serve requests

Information Adapter Indicates normal adapter operation. No action 
required.

AELNDTA-0000002 Exception in storing Lotus Notes Session and Database Objects

Error Adapter Check the database connection parameters.

AELNDTA-0000003 Exception In OnInitialization of the DTA server

Error Adapter Check the DTA settings. 

AELNDTA-0000004 Error in Sequence creation

Error Adapter Check the DTA settings. 

AELNDTA-0000005 The View %1 is not found in the database

Error Adapter Specify a valid View Name.

AELNDTA-0000006 Connecting to Lotus Notes : Server %1 Database %2

Information Adapter Indicates normal adapter operation. No action 
required.

AELNDTA-0000007 Error in getting the IPAddress of the Host

Error Adapter Specify a valid IP address for the Host.

AELNDTA-0000008 Error in activating the components

Error Adapter Check the DTA settings. 

AELNDTA-0000009 Exception in the run method : %1

Error Adapter Check the DTA settings. 
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AELNDTA-0000010 Duplicate DTA (RV) Instance [Host: %1, service: %2] detected...Stopping DTA 
Server Instance

Error Adapter Check if any other instance of DTA is running

AELNDTA-0000011 Exception in OnEvent : %1

Error Adapter Check the DTA settings. 

AELNDTA-0000012 The parameters in the request object  are invalid

Error Adapter Specify valid parameters for DTA interaction.

AELNDTA-0000013 Error in reading the request parameters

Error Adapter Specify valid request parameters for DTA.

AELNDTA-0000014 GUID generation failed : %1

Error Adapter Check the connection to be valid.

AELNDTA-0000015 Application Id : %1

Information Adapter Indicates normal adapter operation. No action 
required.

AELNDTA-0000016 Connecting to Lotus Notes using parameters [Server: %1, Database %2]

Information Adapter Indicates normal adapter operation. No action 
required.

AELNDTA-0000017 Error In Remote Connection

Error Adapter Check the connection parameters.

AELNDTA-0000018 Error In Local Connection

Error Adapter Check the connection parameters.

AELNDTA-0000019 Error in method invocation on the database object: %1

Error Adapter Check the connection to be valid.
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AELNDTA-0000020 Connection to Lotus Notes using parameters:[ Server: %1, Database: %2] 
successful

Information Adapter Indicates normal adapter operation. No action 
required.

AELNDTA-0000021 Access to the Database: %1 denied

Error Adapter Check the user access. 

AELNDTA-0000022 Cannot get Access to the Database: %1 specified

Error Adapter Check the user access. 

AELNDTA-0000023 DTA connection error has occurred. Authentication failed for target Lotus Notes 
application with connection parameters username=%1, password=%2, 
database=%3

Error Adapter Check the connection parameters.

AELNDTA-0000024 Unable to fetch Views from the database: %1

Error Adapter Check whether views have been created in the 
Lotus Notes database.

AELNDTA-0000025 No Schemas found in the database: %1 

Error Adapter Check whether schemas are present in the 
Lotus Notes database.

AELNDTA-0000026 Schema Fetch Request Failed. Error Message: %1

Error Adapter Check the connection parameters and the user 
access rights for the database.

AELNDTA-0000027 No Attributes defined in the Document: %1

Information Adapter Indicates normal adapter operation. No action 
required.

AELNDTA-0000028 -------------------------View List------------------------

Information Adapter Indicates normal adapter operation. No action 
required.
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AELNDTA-0000029 -------------------------End View List--------------------------

Information Adapter Indicates normal adapter operation. No action 
required.

AELNDTA-0000030 ---------------------Field List----------------------------

Information Adapter Indicates normal adapter operation. No action 
required.

AELNDTA-0000031 ------------------------End Field List-----------------------

Information Adapter Indicates normal adapter operation. No action 
required.

AELNDTA-0000032 "Item Name : %1, Item Type : %2

Information Adapter Indicates normal adapter operation. No action 
required.

AELNDTA-0000033 No documents in the View : %1 to fetch the Fieldlist

Information Adapter Indicates normal adapter operation. No action 
required.

AELNDTA-0000034 Fetch Fields Request Failed. Error Message: %1

Error Adapter Check the connection parameters and the user 
access rights for the database.

AELNDTA-0000035 No Agents Found in the database : %1

Information Adapter Indicates normal adapter operation. No action 
required.

AELNDTA-0000036 ---------------------------Agent List---------------------

Information Adapter Indicates normal adapter operation. No action 
required.

AELNDTA-0000037 ----------------------------End Agent List-----------------------

Information Adapter Indicates normal adapter operation. No action 
required.
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AELNDTA-0000038 Fetch Agents Request Failed. Error Message: %1

Error Adapter Check the connection parameters and the user 
access rights for the database.

AELNDTA-0000039 Timer is null

Information Adapter Indicates normal adapter operation. No action 
required.

AELNDTA-0000040 Generated GUID: %1

Information Adapter Indicates normal adapter operation. No action 
required.

AELNDTA-0000041 View  %1: %2

Information Adapter Indicates normal adapter operation. No action 
required.

AELNDTA-0000042 Agent  %1: %2

Information Adapter Indicates normal adapter operation. No action 
required.

AELNDTA-0000043 Duplicate DTA (JMS) Instance [Host: %1, JmsProviderUrl: %2] 
detected...Stopping DTA Server Instance

Error Adapter Check if any other instance of DTA is running.

AELNDTA-9100001 DTA start up error. Property %1 needs to be set in the .tra file.

Error Adapter Set the specified property in the .tra file.

AELNDTA-9100002 DTA start up error. Unable to create discovery subscriber  %1 using repository 
file %2.

Error Adapter Check the DTA settings.

AELNDTA-9100003 DTA start up error. Unable to create Request-Response Service (to listen to 
palette requests) %1 using repository file %2.

Error Adapter Check the DTA settings.
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AELNDTA-9100004 DTA error. SDK exception %1 occurred while creating discovery reply for 
discovery request.

Error Adapter Check the DTA settings.

AELNDTA-9100005 DTA error. Error occurred while sending the discovery response for discovery 
request. SDK error is %1.

Error Adapter Check the DTA settings.

AELNDTA-9100006 DTA error. Shutdown of DTA caused exception %1.

Error Adapter Check the DTA settings.

AELNDTA-9100007 DTA error. The event %1 received by the discovery subscriber is not of expected 
type MDataEvent.

Error Adapter Check the DTA settings or check if the event 
source is valid.

AELNDTA-0000044 Received Reply to Discovery Request

Information Adapter Indicates normal adapter operation. No action 
required.

AELNDTA-0000045 Discovering other Lotus Notes Design Time Adapters (DTAs)...

Information Adapter Indicates normal adapter operation. No action 
required.

AELNDTA-0000046 No other Lotus Notes DTAs were discovered

Information Adapter Indicates normal adapter operation. No action 
required.

AELNDTA-0000047 Lotus Notes DTA (JMS) ready to serve requests [JmsProviderUrl: %1]

Information Adapter Indicates normal adapter operation. No action 
required.

AELNDTA-0000048 Closing the connection created by the previous palette request...

Information Adapter Indicates normal adapter operation. No action 
required.
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AELNDTA-0000049 Recycling the Session created by the previous palette request...

Information Adapter Indicates normal adapter operation. No action 
required.

AELNDTA-0000050 Recycling the DataBase created by the previous palette request...

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000001 Initializing the Outgoing Event Manager ...

Debug Adapter Indicates normal adapter operation. No action 
required.

AELN-0000002 Initializing the adapter...

Debug Adapter Indicates normal adapter operation. No action 
required.

AELN-0000003 Extracted the services information...

Debug Adapter Indicates normal adapter operation. No action 
required.

AELN-0000004 The Instance Control Mechanism will not be enabled ...

Warning Adapter Indicates normal adapter operation. No action 
required.

AELN-0000005 Created the Stop Subscriber...

Debug Adapter Indicates normal adapter operation. No action 
required.

AELN-0000006 Checking for any configured RPC services...

Debug Adapter Indicates normal adapter operation. No action 
required.

AELN-0000007 No configured Publisher or Subscriber services...

Debug Adapter Indicates normal adapter operation. No action 
required.

Table 26   Status Message (Cont’d)

Status Code Role Category Resolution
TIBCO ActiveMatrix Adapter Service Engine for Lotus Notes Configuration and Deployment



Status Messages | 139
AELN-0000008  No Hawk Agents Exist to be set as monitored objects ...

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000009  Hawk Exception:  %1

Error Adapter Failed to register Hawk Methods. Check the 
Hawk Monitoring panel.

AELN-0000010 Exception:  %1

Error Adapter Hawk Exception. Check the Hawk Monitoring 
panel.

AELN-0000011 Processing started...

Debug Adapter Indicates normal adapter operation. No action 
required.

AELN-0000012  -----------------------------------------------------------

Debug Adapter Indicates normal adapter operation. No action 
required.

AELN-0000013  Trigger: [%1] listening to: [%2] ...

Debug Adapter Indicates normal adapter operation. No action 
required.

AELN-0000014 Trigger: [%1] Failed to start ...

Error Adapter Failed to activate RV trigger. Check trigger 
settings.

AELN-0000015 Note engine: [%1] started ...

Debug Adapter Indicates normal adapter operation. No action 
required.

AELN-0000016 Note engine: [%1] failed to start ...

Error Adapter Failed to start Note Engine. Pleas check the 
adapter configuration.
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AELN-0000018 Subscriber:: [%1] subscribing to subject:: [%2] using event manager:: [%3]

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000019 Processing ::: Utilised as an RPC instance ....

Debug Adapter Indicates normal adapter operation. No action 
required.

AELN-0000027 No services found in the configuration...adapter will shut down

Error Adapter Configure services under the instance and 
restart the adapter.

AELN-0000028 Notes Connection Information ...

Debug Adapter Indicates normal adapter operation. No action 
required.

AELN-0000029 Database name has not been specified

Error Adapter Specify a valid database name.

AELN-0000030 Server: %1

Debug Adapter Indicates normal adapter operation. No action 
required.

AELN-0000031 Database: %1

Debug Adapter Indicates normal adapter operation. No action 
required.

AELN-0000032 IDFile: %1

Debug Adapter Indicates normal adapter operation. No action 
required.

AELN-0000033 Connection Pool Size: %1

Information Adapter Indicates normal adapter operation. No action 
required.
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AELN-0000034 retryCount: %1

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000035 Subject: %1

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000036 Database Polling Mechanism has NOT been enabled ...

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000037 NotesConnection has not been specified ...

Error Adapter Specify Notes Connection attributes.

AELN-0000038 The database connection parameters are not correct

Error Adapter Specify correct values for connection 
attributes.

AELN-0000039 Exception in initConnections().Class: %1 

Error Adapter Check the adapter configuration settings.

AELN-0000040 Starting the Lotus Client Request Mechanism ...

Debug Adapter Indicates normal adapter operation. No action 
required.

AELN-0000041 RequestName: [%1]  has been duplicated

Error Adapter Specify a unique Request Name.

AELN-0000042 RequestName has not been specified for LotusClientRequest 

Error Adapter Specify a request name for Client Request.

AELN-0000043 LotusClientRequest should not subscribe to the same subject as subscribers

Warning Adapter Specify a unique subject name for the Client.
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AELN-0000044 Subject has not been specified for LotusClientRequest

Error Adapter Specify a subject name for the Client.

AELN-0000045 Session does not exist for LotusClientRequest

Error Adapter Specify a valid session for the Client Request.

AELN-0000046 Lotus Client Request Mechanism Started ...

Debug Adapter Indicates normal adapter operation. No action 
required.

AELN-0000047 Lotus Client Request Mechanism has NOT been configured ...

Debug Adapter Indicates normal adapter operation. No action 
required.

AELN-0000048 An exception has occurred in initLotusClientRequest() .

Error Adapter Check the adapter configuration settings.

AELN-0000049 Starting the Request/Reply Server Mechanism ...

Debug Adapter Indicates normal adapter operation. No action 
required.

AELN-0000050 Name has not been specified for LotusServer

Error Adapter Specify a name for the Lotus Server.

AELN-0000051 The type has not been specified for LotusServer: [%1]

Error Adapter Specify a value for the type 'attribute'.

AELN-0000052 The type specified for LotusServer: [%1] must be either of the two 
[NoReply,WithReply]

Error Adapter The type specified for Lotus Server must be 
either of the two: NoReply or WithReply.

AELN-0000056 Operation Name has not been specified for LotusServer: [%1]

Error Adapter Specify an operation name for the server.
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AELN-0000057 Operation Name: [%1] specified for LotusServer: [%2] does not exist in the class 
registry

Error Adapter Specify a valid operation name for the server.

AELN-0000058 Class specified for LotusServer: [%1] does not exist in the registry

Error Adapter Specify a valid class which exists in the 
registry for the Lotus Server.

AELN-0000059 Server specified for LotusServer: [%1] does not exist in the registry

Error Adapter Specify a valid server which exists in the 
registry for the Lotus Server.

AELN-0000060 Server has not been specified for LotusServer: [%1]

Error Adapter Specify a value for the server attribute.

AELN-0000061 LotusServer: [%1] has been duplicated ...

Error Adapter Server already exists. Specify a different name.

AELN-0000063 An exception has occurred in initServers() .

Error Adapter Check the adapter configuration settings.

AELN-0000064 Defined Queues ...

Debug Adapter Indicates normal adapter operation. No action 
required.

AELN-0000065 All Defined Queues must have a unique name

Error Adapter Specify a unique name for the queue.

AELN-0000066 Queues cannot have Identical names.

Error Adapter Specify a unique name for the queue.

AELN-0000067 Queue name: %1 Queue Size: %2 Queue Depth: %3

Debug Adapter Indicates normal adapter operation. No action 
required.
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AELN-0000068 The Queue details are not specified in the Configuration File

Warning Adapter Check the adapter configuration settings.

AELN-0000069 The queue parameters are not correct

Error Adapter Specify correct parameters for the queue.

AELN-0000070 Exception in initQueues()...

Error Adapter Check the adapter configuration settings.

AELN-0000071 Initiating the Notes Engines ...

Debug Adapter Indicates normal adapter operation. No action 
required.

AELN-0000072 Note Engine Name cannot be null ...

Error Adapter Specify  name for the Note engine

AELN-0000073 Note Engine Name cannot be empty ...

Error Adapter Specify  name for the Note engine

AELN-0000074 Note Engine Name: [%1] has been duplicated

Error Adapter Specify a unique name for the Note engine

AELN-0000075 Event Queue: [%1] attached to the engine: [%2] does not exist

Error Adapter Attach a valid queue to the Note engine

AELN-0000076 The queue has not been specified for Note Engine: %1

Error Adapter Specify a queue for the Note engine

AELN-0000077 The Engines have not been specified in the config file

Warning Adapter Check the adapter configuration settings.

AELN-0000078 The engine parameters are not correct.Class: %1

Error Adapter Specify correct values for engine parameters
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AELN-0000079 Exception in initNoteEngines()...Class: %1 

Error Adapter Check the adapter configuration settings.

AELN-0000080 Loading the Server Exits ...

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000081 The name has not been specified for server exit ...

Error Adapter Specify a name for the server exit

AELN-0000082 Server Exit: %1 has been duplicated

Error Adapter Check the adapter configuration settings.

AELN-0000083 The type has not been specified for server exit: %1

Error Adapter Check the adapter configuration settings.

AELN-0000084 The class has not been specified for server exit: %1

Error Adapter Check the adapter configuration settings.

AELN-0000085 No Server Exits have been defined

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000086 Class: %1 

Error Adapter Check the adapter configuration settings.

AELN-0000087 ServerExit class specified is not found ...

Error Adapter Specify a valid server exit class.

AELN-0000088 Exception in initServerExits()...

Error Adapter Check the adapter configuration settings.

AELN-0000089 Loading the Notes Exits ...

Debug Adapter Indicates normal adapter operation. No action 
required.
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AELN-0000090 The ’name’ attribute of the NoteExit CANNOT be null

Error Adapter Specify a value for the name 'attribute of the 
note exit'.

AELN-0000091 The ’name’ attribute of the NoteExit CANNOT be empty

Error Adapter Specify a value for the name 'attribute of the 
note exit'.

AELN-0000092 Note Exit: %1 has been duplicated

Error Adapter Check the adapter configuration settings.

AELN-0000093 The type has not been specified for exit: %1

Error Adapter Check the adapter configuration settings.

AELN-0000094 The class has not been specified for exit: %1

Error Adapter Check the adapter configuration settings.

AELN-0000095 The object has not been specified for exit: %1

Error Adapter Check the adapter configuration settings.

AELN-0000096 No Note Exits have been defined

Debug Adapter Indicates normal adapter operation. No action 
required.

AELN-0000097 NoteExit class specified is not found .Class: %1 

Error Adapter Specify a valid note exit class.

AELN-0000098 Exception in initNoteExits().Class: %1 

Error Adapter Check the adapter configuration settings.

AELN-0000099 Header Information

Debug Adapter Indicates normal adapter operation. No action 
required.
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AELN-0000100 The attachment location must be specified in the Header tag ...

Error Adapter Specify an attachment location in the header 
tag.

AELN-0000101 The version attribute cannot be parsed into a numeric value

Error Adapter Modify the value of this attribute in the 
configuration data.

AELN-0000102 Project Created on Adln Version: %1

Debug Adapter Check the adapter configuration settings.

AELN-0000108 Enable HAWK: %1

Debug Adapter Check the adapter configuration settings.

AELN-0000111 Exception in InitHeader().Class: %1 

Error Adapter Check the adapter configuration settings.

AELN-0000112 Publish Routing Table ...

Debug Adapter Check the adapter configuration settings.

AELN-0000113 Event is linked to a publisher that does not exist.

Error Adapter Link the event to a valid existing publisher.

AELN-0000114 The Publish Table is Empty. No Events will be published

Warning Adapter Check the adapter configuration settings.

AELN-0000115 Exception in initPublishRoutingTable().Class: %1 

Error Adapter Check the adapter configuration settings.

AELN-0000116 Business Event Managers ...

Debug Adapter Check the adapter configuration settings.

AELN-0000117 Output Queue does not exist for: %1

Error Adapter Check the adapter configuration settings.
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AELN-0000118 Output queue has not been specified for: %1

Error Adapter Check the adapter configuration settings.

AELN-0000119 There is a duplicate event manager : %1

Error Adapter Check the adapter configuration settings.

AELN-0000120 The event manager name has not been specified

Error Adapter Check the adapter configuration settings.

AELN-0000121 Event Manager: [%1] has not subscribed to any events ...

Error Adapter Check the adapter configuration settings.

AELN-0000122 Event Manager: 1% is subscribing to event: %2 which already exists in another 
Event Manager

Warning Adapter Check the adapter configuration settings.

AELN-0000123 The Business Event Manager Table is Empty.No Events will be received

Warning Adapter Check the adapter configuration settings.

AELN-0000124 Exception in initLotusEventManager().Class: %1 

Error Adapter Check the adapter configuration settings.

AELN-0000125 Subscribe Routing Table ...

Debug Adapter Check the adapter configuration settings.

AELN-0000126 Subscriber does not exist: %1

Error Adapter Check the adapter configuration settings.

AELN-0000127 Event Manager [%1] specified for Subscriber: [%2] does not exist

Warning Adapter Check the adapter configuration settings.

AELN-0000128 Duplicate Event Manager [%1] linked to the Subscriber: [%2]

Error Adapter Specify a unique event manager for the 
subscriber.
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AELN-0000129 Event Managers have not been specified for subscriber: %1

Warning Adapter Check the adapter configuration settings.

AELN-0000130 The Subscribe Table is Empty.  No Events will be received

Debug Adapter Check the adapter configuration settings.

AELN-0000131 Exception in initSubscribeRoutingTable().Class: %1 

Error Adapter Check the adapter configuration settings.

AELN-0000133 RvSession specified for Business Advisory does not exist ...

Error Adapter Check the adapter configuration settings.

AELN-0000136 Exception in initBusinessAdvisory().Class: %1 

Error Adapter Check the adapter configuration settings.

AELN-0000137 The Exception Event Structure has not been specified correctly in the config file

Error Adapter Specify the exception event structure 
correctly.

AELN-0000138 Exception in initExceptionManager(). Class: %1 Message: %2

Error Adapter Check the adapter configuration settings.

AELN-0000139 Exception: %1

Error Adapter Check the adapter configuration settings.

AELN-0000140 Creating Triggers ...

Debug Adapter Check the adapter configuration settings.

AELN-0000141 Output Queue does not exist for: %1

Warning Adapter Check the adapter configuration settings.

AELN-0000142 Output queue has not been specified for: %1

Warning Adapter Check the adapter configuration settings.
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AELN-0000143 Trigger: [%1] should not subscribe to the same subject as subscribers

Warning Adapter Check the adapter configuration settings.

AELN-0000144 Subject has not been specified for: %1

Warning Adapter Check the adapter configuration settings.

AELN-0000145 Session does not exist for trigger: %1

Warning Adapter Check the adapter configuration settings.

AELN-0000146 Event for trigger: [%1] should be NotesEvent

Warning Adapter Check the adapter configuration settings.

AELN-0000147 Exception in createTriggers().Class: %1 

Error Adapter Check the adapter configuration settings.

AELN-0000148 Creating Pollers ...

Debug Adapter Check the adapter configuration settings.

AELN-0000149 Output Queue does not exist for: %1

Warning Adapter Check the adapter configuration settings.

AELN-0000150 Output queue has not been specified for: %1

Warning Adapter Check the adapter configuration settings.

AELN-0000151 Poller Operation for: [%1] must be ADD

Warning Adapter Check the adapter configuration settings.

AELN-0000152 Poller event: %1 for poller: %2 has been duplicated in the order sequence

Warning Adapter Check the adapter configuration settings.

AELN-0000153 Poller event: %1 for poller: %2 is not in the Publish Routing Table

Warning Adapter Check the adapter configuration settings.

AELN-0000154 Poller Event has not been specified for: %1

Warning Adapter Check the adapter configuration settings.
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AELN-0000155 Poller: [%1] writing events: %2 ....

Debug Adapter Check the adapter configuration settings.

AELN-0000156 Poller interval parameter is incorrect.Class: %1 

Error Adapter Specify a correct value for poller interval 
attribute.

AELN-0000157 Exception in createPollers().Class: %1 

Error Adapter Check the adapter configuration settings.

AELN-0000159 Incorrect Element...

Warning Adapter Check the adapter configuration settings.

AELN-0000161 Exception in initEventRegistry().Class: %1 

Error Adapter Check the adapter configuration settings.

AELN-0000162 The datatype specified is not supported

Warning Adapter Check the adapter configuration settings.

AELN-0000163 The operator specified is not supported

Warning Adapter Check the adapter configuration settings.

AELN-0000164 Exception in ValidateParms().Message: %1

Error Adapter Check the adapter configuration settings.

AELN-0000165 Exception in ValidateAttrs().Message: %1

Error Adapter Check the adapter configuration settings.

AELN-0000166 Validating event: %1

Information Adapter Check the adapter configuration settings.

AELN-0000167 Event name: %1 has been duplicated in the registry

Warning Adapter Check the adapter configuration settings.
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AELN-0000168 Validating action: [%1] for event: %2 ...

Information Adapter Check the adapter configuration settings.

AELN-0000169 No event name has been specified for: %1

Warning Adapter Check the adapter configuration settings.

AELN-0000170 Event name: [%1] is not in Publish Routing Table

Warning Adapter Check the adapter configuration settings.

AELN-0000171 Event name: [%1] does not have a correct node

Warning Adapter Check the adapter configuration settings.

AELN-0000172 Actions were not validated for event: %1

Warning Adapter Check the adapter configuration settings.

AELN-0000173 Exception in ValidateEvent() ...

Error Adapter Check the adapter configuration settings.

AELN-0000174 Action: [%1] specified for event: %2 is not supported ..

Warning Adapter Check the adapter configuration settings.

AELN-0000175 Action: [%1] specified for event: %2 cannot be performed within the specified 
[import] mode

Warning Adapter Check the adapter configuration settings.

AELN-0000176 Action: [%1] specified for event: %2 cannot be performed within the specified 
[export] mode

Warning Adapter Check the adapter configuration settings.

AELN-0000177 searchType or form  for event: %1 are either incorrect or have not been specified

Warning Adapter Check the adapter configuration settings.

AELN-0000178 Form name for Add action of event: %1 has not been specified

Warning Adapter Check the adapter configuration settings.
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AELN-0000179 Agent Name or Note Exit for event: %1 has not been specified

Warning Adapter Check the adapter configuration settings.

AELN-0000180 searchType for event: %1 has either the view, formula, or form missing

Warning Adapter Check the adapter configuration settings.

AELN-0000181 NoteParms for event: %1 do not exist for PublishFromUNID Action Type

Warning Adapter Check the adapter configuration settings.

AELN-0000182 NoteAttributes for event: %1 do not exist

Warning Adapter Check the adapter configuration settings.

AELN-0000183 Processing for event: %1 is an update or delete which requires a search key to be 
specified

Warning Adapter Check the adapter configuration settings.

AELN-0000184 Event: %1 is an evaluate event which requires a formula or parameters to be 
specified

Warning Adapter Check the adapter configuration settings.

AELN-0000185 Exception in ValidateAction() ...

Error Adapter Check the adapter configuration settings.

AELN-0000187 The Fault Tolerance Component was NOT started ...

Warning Adapter Check the adapter configuration settings.

AELN-0000189 Incorrect Parameters specified for the FT listeners.Class: %1 

Error Adapter Specify correct parameters for FT listeners.

AELN-0000190 Exception caught in initFT().Class: %1 

Error Adapter Check the adapter configuration settings.

AELN-0000194 Unable to disconnect from the Lotus Notes database .....

Error Adapter Check the adapter configuration settings.
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AELN-0000195 The specified engine: [%1] does not exist

Warning Adapter Check the adapter configuration settings.

AELN-0000196 Exception in starting the engine: %1 - %2

Warning Adapter Check the adapter configuration settings.

AELN-0000197 The specified engine: [%1] does not exist

Warning Adapter Check the adapter configuration settings.

AELN-0000198 Exception in stopping the engine: [%1] -  %2 

Warning Adapter Check the adapter configuration settings.

AELN-0000199 Exception in resuming the engine: [%1] -  %2

Warning Adapter Check the adapter configuration settings.

AELN-0000200 Exception in pausing the engine: [%1] -  %2

Warning Adapter Check the adapter configuration settings.

AELN-0000201 Shutting Down Component ..........

Information Adapter Check the adapter configuration settings.

AELN-0000202 Stopping the adapter ...

Information Adapter Check the adapter configuration settings.

AELN-0000203 Exception in construction of the Lotus Adapter Control ...

Error Adapter Check the adapter configuration settings.

AELN-0000204 Exception description: %1, data = %2

Error Adapter Check the adapter configuration settings.

AELN-0000205 Duplicate Instance exists ...

Error Adapter Check the adapter configuration settings.

AELN-0000208 The version attribute has not been set ...

Error Adapter Set the version attribute.
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AELN-0000210 ----------------------------------------------------------

Error Adapter Check the adapter configuration settings.

AELN-0000211 LotusDatabasePoller: cannot poll NULL database ...

Error Adapter Specify a valid database.

AELN-0000220 Exception in construction of the LotusDatabasePoller.Class: %1 

Error Adapter Check the adapter configuration settings.

AELN-0000222 Exception in database poller thread as a result of an Interruption

Error Adapter Check the adapter configuration settings.

AELN-0000223 Standard Exception in database poller ...

Error Adapter Check the adapter configuration settings.

AELN-0000224 Exception in database poller :: sendPollStatus() ...

Error Adapter Check the adapter configuration settings.

AELN-0000228 Poller: [%1] initiated ...

Debug Adapter Check the adapter configuration settings.

AELN-0000229 Unable to start the event poller: %1. Class: %1 - Message: %2

Error Adapter Check the adapter configuration settings.

AELN-0000230 %1:: [%2] Started 

Debug Adapter Check the adapter configuration settings.

AELN-0000231 [Poller], Notifying event 

Debug Adapter Check the adapter configuration settings.

AELN-0000232 Exception in poller thread as a result of an Interruption

Error Adapter Check the adapter configuration settings.

AELN-0000233 Exception in poller thread as a result of writing to the queue

Error Adapter Check the adapter configuration settings.

Table 26   Status Message (Cont’d)

Status Code Role Category Resolution
 TIBCO ActiveMatrix Adapter Service Engine for Lotus Notes Configuration and Deployment



156 | Appendix A  Trace Messages
AELN-0000243 RvException in LotusFTListener - %1

Error Adapter Check the adapter configuration settings.

AELN-0000244 In creating a lotus instance field: %1, 

Error Adapter Check the adapter configuration settings.

AELN-0000247 Checking the event type:Publisher or Subscriber...

Debug Adapter Indicates normal adapter operation. No action 
required.

AELN-0000248 The event type is: %1

Debug Adapter Indicates normal adapter operation. No action 
required.

AELN-0000249 Successfully processed the Agent: [%1].

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000265 ::::: Exit Translating Outgoing Event Data to XML document ....

Information Adapter Check the adapter configuration settings.

AELN-0000266 ::::: Exit Translating Outgoing Class Data to XML document ....

Information Adapter Check the adapter configuration settings.

AELN-0000267 ::::: Field: [%1] has been defined as an attachment field in the NoteExit but not in 
the EventRegistry 

Warning Adapter Check the adapter configuration settings.

AELN-0000268 ::::: Field: [%1] has been defined as an attachment field in the EventRegistry but 
not in the NoteExit

Error Adapter Check the adapter configuration settings.

AELN-0000269 Exception in retrieving the rich text item: %1

Error Adapter Check the adapter configuration settings.
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AELN-0000270 Exception in getRichText of the NoteInstance Class ...

Error Adapter Check the adapter configuration settings.

AELN-0000271 Rich text has been updated ...

Debug Adapter Check the adapter configuration settings.

AELN-0000272 Exception in setting the rich text item: %1

Error Adapter Check the adapter configuration settings.

AELN-0000273 Resetting the rich text styles ...

Debug Adapter Check the adapter configuration settings.

AELN-0000274 Maintaining the rich text styles ...

Debug Adapter Check the adapter configuration settings.

AELN-0000275 Exception in setting the rich text style: %1

Error Adapter Check the adapter configuration settings.

AELN-0000276 Date being updated ...

Debug Adapter Check the adapter configuration settings.

AELN-0000277 Retrieving the attachment names ...

Debug Adapter Check the adapter configuration settings.

AELN-0000278 Field: %1 contains an embedded object.

Warning Adapter Check the adapter configuration settings.

AELN-0000279 Field: %1 contains an embedded object link.

Warning Adapter Check the adapter configuration settings.

AELN-0000280 Field: %1 is not a richtext item and has been inaccurately defined in the 
configuration data

Warning Adapter Check the adapter configuration settings.
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AELN-0000281 Removing attachment: %1

Debug Adapter Check the adapter configuration settings.

AELN-0000282 Attachment removal exception: %1

Error Adapter Check the adapter configuration settings.

AELN-0000283 Attachment being added by value ...

Debug Adapter Check the adapter configuration settings.

AELN-0000284 Attachment being added by reference ...

Debug Adapter Check the adapter configuration settings.

AELN-0000285 FileName: %1

Debug Adapter Check the adapter configuration settings.

AELN-0000286 AttachmentName: %1

Debug Adapter Check the adapter configuration settings.

AELN-0000287 Link Attachment Exception: %1

Error Adapter Check the adapter configuration settings.

AELN-0000288 Note Engine is running on platform: [%1]

Debug Adapter Check the adapter configuration settings.

AELN-0000289 Connecting to Notes [Server = %1,Database= %2] ......

Debug Adapter Check the adapter configuration settings.

AELN-0000290 Connection Successful.....

Debug Adapter Check the adapter configuration settings.

AELN-0000291 Cannot get access to the database server = [%1] Database = [%2]

Error Adapter Check the adapter configuration settings.

AELN-0000292 Retrieving collection using formula: %1

Debug Adapter Check the adapter configuration settings.
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AELN-0000293 Retrieving from the database: %1

Debug Adapter Check the adapter configuration settings.

AELN-0000294 Storing Agent: %1

Debug Adapter Check the adapter configuration settings.

AELN-0000295 Committing the transaction........

Debug Adapter Check the adapter configuration settings.

AELN-0000296 Executing Any Agents ........

Debug Adapter Check the adapter configuration settings.

AELN-0000297 Exception in activation of trigger: %1. 

Error Adapter Check the adapter configuration settings.

AELN-0000299 Overriding the subject name to be published. 

Debug Adapter Check the adapter configuration settings.

AELN-0000300 ------------ Exception in Trigger ------------ Trigger Name: %1 Trigger Subject: %2 
Event Name: %3 Error Code: %4 Original Error: %5 
----------------------------------------------

Error Adapter Check the adapter configuration settings.

AELN-0000301 ------------ Exception in trigger ------------Trigger Name: %1 Trigger Subject: %2 
Event Name: %3 This exception is most probably due to the fact that data has 
been sent using the same subject that this trigger is listening to but the format of 
the incoming data is not of the required format.

Error Adapter Check the adapter configuration settings.

AELN-0000302 Original Error Class: %1 Original Error Message: %2 
----------------------------------------------

Error Adapter Check the adapter configuration settings.

AELN-0000303 %1 Started, listening to %2

Information Adapter Check the adapter configuration settings.
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AELN-0000304 %1 Stopped, listening to %2

Information Adapter Check the adapter configuration settings.

AELN-0000308 The Note Exit Attributes have not been specified correctly ...

Error Adapter Specify the Note exit parameters correctly.

AELN-0000309 Object: %1,Parameter: %2,PublishType: %3

Information Adapter Check the adapter configuration settings.

AELN-0000310 There are no attachments to be processed by the exit ...

Information Adapter Check the adapter configuration settings.

AELN-0000311 Attachments being processed by the exit ...

Information Adapter Check the adapter configuration settings.

AELN-0000312 %1 ::  [%2] Started 

Debug Adapter Check the adapter configuration settings.

AELN-0000313 Recovering any unpublished transactions .........

Information Adapter Check the adapter configuration settings.

AELN-0000314 %1 Exception in run() of note engine in connecting to the database

Error Adapter Check the adapter configuration settings.

AELN-0000315 Step Engine: %1 ::::: Waiting for an Event"

Information Adapter Check the adapter configuration settings.

AELN-0000317 %1 : Received Event

Debug Adapter Indicates normal adapter operation. No action 
required.

AELN-0000318 %1 - data instance: %2

Debug Adapter Indicates normal adapter operation. No action 
required.
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AELN-0000319 Ignoring, Unregistered Event Name = %1

Debug Adapter Indicates normal adapter operation. No action 
required.

AELN-0000320 class: %1

Error Adapter Check the adapter configuration settings.

AELN-0000321 Event Name: %1

Debug Adapter Indicates normal adapter operation. No action 
required.

AELN-0000322 DATA :: %1

Debug Adapter Indicates normal adapter operation. No action 
required.

AELN-0000323 -----------------EXCEPTION-------------------Event Name    : %1 Error Code    : %2 
Error Text    : %3 Original Error: %4

Error Adapter Check the adapter configuration settings.

AELN-0000324 EXCEPTION :: Event Name: %1

Error Adapter Check the adapter configuration settings.

AELN-0000325 Error : %1

Error Adapter Check the adapter configuration settings.

AELN-0000326 Error : %1

Error Adapter Check the adapter configuration settings.

AELN-0000327 Error :: %1

Error Adapter Indicates normal adapter operation. No action 
required.

AELN-0000328 -----------------EXCEPTION-------------------- FATAL :: An Exception has occurred in 
the exception handler

Error Adapter Check the adapter configuration settings.
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AELN-0000329 Processing Operation No, %1  %2

Debug Adapter Indicates normal adapter operation. No action 
required.

AELN-0000330 Using OutBox ...................

Debug Adapter Indicates normal adapter operation. No action 
required.

AELN-0000331 Using OutBox and Formula ...................

Debug Adapter Indicates normal adapter operation. No 
action required.

AELN-0000332 There are no documents in the OUTBOX to be published ...

Debug Adapter Indicates normal adapter operation. No 
action required.

AELN-0000333 Creating an External Process: [%1] ...

Debug Adapter Indicates normal adapter operation. No 
action required.

AELN-0000334 Exception in creating process:

Error Adapter Check the adapter configuration settings.

AELN-0000335 %1

Error Adapter Check the adapter configuration settings.

AELN-0000336 Placing sequence: [%1] into business document

Debug Adapter Indicates normal adapter operation. No 
action required.

AELN-0000337 Sequence: [%1] does NOT have a value

Debug Adapter Indicates normal adapter operation. No 
action required.
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AELN-0000338 Placing attribute: [%1] containing rich text into business document

Debug Adapter Indicates normal adapter operation. No 
action required.

AELN-0000339 Attribute: [%1] of type any was not identified as a rich Text and was not 
processed.

Error Adapter Check the adapter configuration settings.

AELN-0000340 attribute: [%1] of class: [%2] must have a primitive and not user-defined 
type to be published

Error Adapter Check the adapter configuration settings.

AELN-0000341 The Attribute: [%1] has been defined as a single value field in the meta 
data and is not expecting a vector. Only the first element in the vector is 
taken as the value of this attribute

Warning Adapter Indicates normal adapter operation. No 
action required.

AELN-0000342 Placing attribute: [%1] with value: [%2] into business document

Debug Adapter Indicates normal adapter operation. No 
action required.

AELN-0000343 Placing attribute: [%1] containing attachment sequence by reference into 
business document

Debug Adapter Indicates normal adapter operation. No action 
required.

AELN-0000344 Placing attribute: [%1] containing attachment sequence by reference into 
business document

Debug Adapter Indicates normal adapter operation. No action 
required.

AELN-0000345 Placing attribute: [%1] containing attachment sequence by name\value into 
business document

Debug Adapter Indicates normal adapter operation. No action 
required.
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AELN-0000346 Placing attribute: [%1] containing attachment sequence by value into business 
document

Debug Adapter Indicates normal adapter operation. No action 
required.

AELN-0000347 Attribute: [%1] of type attachment sequence does not have the required property 
and was not processed

Warning Adapter Indicates normal adapter operation. No action 
required.

AELN-0000348 Attribute: [%1] must be defined as an attachment sequence in the configuration 
to be processed

Debug Adapter Indicates normal adapter operation. No action 
required.

AELN-0000349 attribute: [%1] of class: [%2] must have a primitive and not user-defined type to 
be published

Warning Adapter Indicates normal adapter operation. No action 
required.

AELN-0000350 keyWord: [%1] specified for one of attributes of class: [%2] is not supported or is 
null

Warning Adapter Indicates normal adapter operation. No action 
required.

AELN-0000351 Placing attribute: [%1] with default value: [%2] into business document

Debug Adapter Indicates normal adapter operation. No action 
required.

AELN-0000352 Attribute: [%1] does NOT have a value

Debug Adapter Indicates normal adapter operation. No action 
required.

AELN-0000353 Published Event with subject: %1.The tracking ID is: %2.

Information Adapter Indicates normal adapter operation. No action 
required.
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AELN-0000354 attribute: [%1] of class: [%2] must have a primitive and not user-defined type to 
be published

Warning Adapter Indicates normal adapter operation. No action 
required.

AELN-0000355 Placing attribute: [%1] into business document

Debug Adapter Indicates normal adapter operation. No action 
required.

AELN-0000356 Processing Multi-Meta Add .............

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000357 Processing the HEADER .............

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000358 In Processing the multi-meta add operation, the header field: [%1]  contains a 
value that is a sequence but not a sequence of MultiValueFields

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000359 Multi-creation of documents via class: [%1] does not include any header 
information

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000360 Processing the RECORDS .............

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000361 In Processing the multi-meta add operation, the record field: [%1]  contains a 
value that is a sequence but not a sequence of MultiValueFields

Information Adapter Indicates normal adapter operation. No action 
required.
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AELN-0000362 The attachment: [%1] was not found and will not be embedded in the field: [%2]

Error Adapter Check if the attachment exists.

AELN-0000363 Multi-creation of documents via class: [%1] does not include any records

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000364 Executing addition of a sequence of documents ..........

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000365 processing HEADER sequence: [%1]

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000366 processing HEADER attachment: [%1]

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000367 Processing Attachment:: placing data into file: %1

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000368 processing HEADER richtext: [%1]

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000369 processing HEADER Class: [%1]

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000370 Processing [useNodes/useValues] option for attribute: [%1] as a sub-form

Information Adapter Indicates normal adapter operation. No action 
required.
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AELN-0000371 Processing the class attribute: [%1] as a sub-form

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000372 processing HEADER field: [%1]

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000373 Processing the Sequence: [%1] ........

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000374 Processing Rich Text item ...

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000375 Processing the [useNodes/useValues] option for attribute: [%1]

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000376 Nodes Retrieved: %1

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000377 --------- Processing repeat on field: [%1] ....

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000378 --------- Instance: [%1] added ....

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000379 Rich Text value retrieved ...

Information Adapter Indicates normal adapter operation. No action 
required.
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AELN-0000380 Determining the method of execution: [view, formula, query]

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000381 Key = %1, Value = %2 , Class = %3

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000382 Execution by View: [%1] , Identified Search Keys: %2

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000383 Execution by Formula: [%1] ................

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000384 Execution by Query, formName : [%1], Identified Query Keys: %2

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000385 Performing the deletes ............

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000386 Performing the updates ............

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000387 Updating the multi-value field: [%1]

Debug Adapter Indicates normal adapter operation. No action 
required.

AELN-0000388 Updating the richtext field: [%1]

Information Adapter Indicates normal adapter operation. No action 
required.
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AELN-0000389 Updating the attachment field: [%1]

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000390 Updating the Subform field of class: [%1]

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000391 Processing the [useNodes/useValues] option for attribute: [%1]

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000392 Values Retrieved: %1

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000393 Updating the field: [%1]

Debug Adapter Indicates normal adapter operation. No action 
required.

AELN-0000394 Processing Sequence Publish ...........

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000395 The attribute class: [%1] is not a supported data type for publishing of meta data 
sequences

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000396 keyWord: [%1] specified for one of attributes of class: [%2] is not supported or is 
null

Information Adapter Indicates normal adapter operation. No action 
required.
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AELN-0000397 Attribute: [%1] of type any was not identified as a rich Text and was not 
processed.

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000398 Processing multi-tree publish ...........

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000399 The Multi-tree outgoing event does not include any header information

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000400 There is a mismatch in the number of header keys and number

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000401 The Multi-tree outgoing event does not include any records

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000402 Record [%1] did not process field: %2

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000403 Processing attachment for: %1 ...

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000404 Using File Name  %1

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000405 Using [[[[NULL]]]] File Name 

Information Adapter Indicates normal adapter operation. No action 
required.
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AELN-0000406 Multiple Attachments have been received ...

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000407 No attachment required for Name = %1 Attachment Name %2 File Name = %3 
Data = %4

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000408 The attachment filename is: %1

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000409 Calling Attach With Name = %1 Attachment Name %2 File Name = %3 Data = 
%4

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000410 Single Attachment has been received ...

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000411 Setting the rich text style of format: %1

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000412 Resetting the rich text style ...

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000413 Text Received for Rich Text Item is null ...

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000414 ** FIELD = %1  VALUE = %2 CLASS = %3

Information Adapter Indicates normal adapter operation. No action 
required.
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AELN-0000415 Adding the Note Instance ...

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000416 Attachments being published as a group ...

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000417 Attachments being published as a group BY VALUE ...

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000418 Node Name = %1 Value = %2 Class = %3

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000419 Date = %1 Format = %2

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000420 Adjusting the time field ...

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000421 Timezone = %1

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000422 DateField = %1

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000423 Published Date = %1

Information Adapter Indicates normal adapter operation. No action 
required.
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AELN-0000424 The attribute: [%1] was not a field in the Lotus Form or did not have a value and 
will not be published

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000425 Creating a tree published instance via the event registry ...

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000426 Formula used to retrieve documents: %1

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000427 There are no documents in the OUTBOX to be published using the formula: [%1]

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000428 There are no documents in the OUTBOX with UNID: %1

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000429 ******************* View Search Keys...

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000430 Updating the document , .................... 

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000431 ******************* Query Search Keys...

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000432 ************************ Search Keys...

Information Adapter Indicates normal adapter operation. No action 
required.
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AELN-0000433 Event Query Execution Begins....................

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000434 Processing Action No, %1  %2

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000435 Committing the Request Document,........

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000436 Creating an External Process: [%1] ...

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000437 note exit process: [%1] not valid ...

Error Adapter Check the adapter configuration settings.

AELN-0000438 Exception in creating process:

Error Adapter Check the adapter configuration settings.

AELN-0000439 %1

Error Adapter Check the adapter configuration settings.

AELN-0000440 Replying to the sender with subject: %1 ...

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000441 Attachments to be sent via multiple messages ...

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000442 keyWord: [%1] is not a supported keyWord ...

Warning Adapter Indicates normal adapter operation. No action 
required.
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AELN-0000443 Incoming Event [%1]  %2 Not Found , using default if defined

Error Adapter Check the adapter configuration settings.

AELN-0000444 ****************************

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000445 The ordering by single key of the meta documents to be published was not 
successful. The documents are published as they are retrieved class: %1 - 
message: %2 

Error Adapter Check the adapter configuration settings.

AELN-0000446 Component : %1 Stopped Servicing

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000447 Component : %1 Paused 

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000448 Component : %1 Resumed 

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000449 Business Event Structure has not been specified correctly ...

Error Adapter Specify the Business Event Structure correctly.

AELN-0000450 Business Event Structure has not been specified correctly.

Error Adapter Specify the Business Event Structure correctly.

AELN-0000451 Exception in initialize() of Lotus Event Manager.

Error Adapter Check the adapter configuration settings.

AELN-0000452 Event received but not instance of MDataEvent ...

Warning Adapter Check the adapter configuration settings.
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AELN-0000453 Exception in onEvent() of the Lotus Event Manager as a result of processEvent().

Error Adapter Check the adapter configuration settings.

AELN-0000454 Error Code: %1

Error Adapter Check the adapter configuration settings.

AELN-0000455 Severity: %1

Error Adapter Check the adapter configuration settings.

AELN-0000456 ShortText: %1

Information Adapter Check the adapter configuration settings.

AELN-0000457 originalError: %1

Error Adapter Check the adapter configuration settings.

AELN-0000458 Creating Business Document ...

Information Adapter Check the adapter configuration settings.

AELN-0000459 %1. 

Error Adapter Check the adapter configuration settings.

AELN-0000460 The event manager was unable to read the incoming message.

Error Adapter This could be related to the fact that the 
subscriber instance has not been configured 
correctly in the EventRegistry to receive the 
incoming message or that the incoming 
message is faulty.

AELN-0000461 BUS_EVT::: Writing Business Event: [%1]

Information Adapter Check the adapter configuration settings.

AELN-0000462 Writing to queue: [%1]

Debug Adapter Check the adapter configuration settings.

AELN-0000463 Initializing the Exception Manager ...

Information Adapter Check the adapter configuration settings.
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AELN-0000464 Event: [%1] does not exist in Publish Routing Table ...

Error Adapter Check the adapter configuration settings.

AELN-0000465 Publisher: [%1] specified in routing table does not exist ...

Error Adapter Check the adapter configuration settings.

AELN-0000466 Note Transaction: Unable to delete the Lotus Notes Document,%1 

Error Adapter Check the adapter configuration settings.

AELN-0000467 NoteTransaction: Unable to execute the lotus formula: %1, %2 

Error Adapter Check the lotus formula.

AELN-0000468 NoteTransaction: Unable to create a Lotus Notes Instance Document,%1 

Error Adapter Check the adapter and Lotus Notes 
configuration settings.

AELN-0000469 NoteTransaction: Unable to retrieve a Lotus Document By Id: %1, %2 

Error Adapter Check the adapter and Lotus Notes 
configuration settings.

AELN-0000470 NoteTransaction: Unable to retrieve the First Lotus Document in view: %1,%2 

Error Adapter Check the adapter and Lotus Notes 
configuration settings.

AELN-0000471 NoteTransaction: Unable to retrieve the Lotus Documents in view: %1,%2 

Error Adapter Check the adapter and Lotus Notes 
configuration settings.

AELN-0000472 NoteTransaction: Unable to refresh the database file,%1 

Error Adapter Check the adapter and Lotus Notes 
configuration settings.

AELN-0000473 NoteTransaction: Unable to retrieve the Lotus Documents by query with form: 
%1,%2 

Error Adapter Check the Lotus Notes query.
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AELN-0000474 NotesHandle: Failed to retrieve document by UNID: %1 in database: %2,%3 

Error Adapter Check the adapter and Lotus Notes 
configuration settings.

AELN-0000475 NoteInstance: Access by index not supported for this object

Error Adapter Check the adapter and Lotus Notes 
configuration settings.

AELN-0000476 NoteInstance: An Exception has occurred in the NoteInstance field replication 
...,Class:%1

Error Adapter Check the adapter configuration settings.

AELN-0000477 NoteInstance: Document not opened yet

Error Adapter Check the adapter and Lotus Notes 
configuration settings.

AELN-0000478 AdvisoryData : Note exit failed ...

Error Adapter Check the adapter and Lotus Notes 
configuration settings.

AELN-0000479 ErrorUserData : Note exit failed ...

Error Adapter Check the adapter and Lotus Notes 
configuration settings.

AELN-0000480 LotusBusinessAdvisory: The RvSession specified does not exist for the Business 
Advisory. Exception thrown at startUp

Error Adapter Check the adapter configuration settings.

AELN-0000481 The creation of the Business Advisory document failed. %1 

Error Adapter Check the adapter configuration settings.

AELN-0000482 LotusClientRequest: Start attempted on a client request poller thread: [%1] 
failed,

Error Adapter Check the adapter configuration settings.

AELN-0000483 LotusClientRequest :  Exception - %1

Error Adapter Check the adapter configuration settings.
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AELN-0000484 LotusClientRequest: Parameter: [%1] is not a valid parameter for operation: [%2] 
of class: [%3], Parameter: [%4] is not a valid parameter for operation: [%5] of 
class: [%6]

Error Adapter Check the adapter configuration settings.

AELN-0000485 LotusDatabasePoller: Start attempted on a thread which has already been started

Error Adapter Check the adapter configuration settings.

AELN-0000486 LotusDatabasePoller: Stop attempted on a thread which has not been started

Error Adapter Check the adapter configuration settings.

AELN-0000487 LotusDatabasePoller: Pause attempted on a thread which has not been started

Error Adapter Check the adapter configuration settings.

AELN-0000488 LotusDatabasePoller: Resume attempted on a thread which has not been started

Error Adapter Check the adapter configuration settings.

AELN-0000489 LotusEventManager: The creation of the Business Document to be published has  
failed.

Error Adapter Check the adapter configuration settings.

AELN-0000490 LotusEventManager: The repeat On analysis of the incoming event has failed

Error Adapter Check the adapter configuration settings.

AELN-0000491 LotusEventManager: The incoming Business Document has NO MInstance 
section

Error Adapter Check the adapter configuration settings.

AELN-0000492 LotusEventManager: The incoming event was identified as a business document 
but the business document could not be created from the class registry,%1

Error Adapter Check the adapter configuration settings.

AELN-000493 LotusEventManager: There is no Control Block associated with the incoming 
event

Error Adapter Check the adapter configuration settings.
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AELN-0000494 LotusEventManager: Incoming Event Message does not have an event name

Error Adapter Check the adapter configuration settings.

AELN-0000495 LotusEventManager: No Operation associated with event: [%1] trapped by event 
manager: [%2]

Error Adapter Check the adapter configuration settings.

AELN-0000496 LotusEventManager: No Data associated with event: [%1] trapped by event 
manager: [%2]

Error Adapter Check the adapter configuration settings.

AELN-0000497 LotusEventManager: The event manager was unable to read the incoming 
message.%1 

Error Adapter This could be related to the fact that the 
subscriber instance has not been configured 
correctly in the EventRegistry to receive the 
incoming message or that the incoming 
message is faulty. 

AELN-0000498 LotusEventPoller: Start attempted on a event poller thread: [%1] failed, Attempt 
to start thread which has already been started

Error Adapter Check the adapter configuration settings.

AELN-0000499 LotusEventPoller: Stop attempted on a event poller thread: [%1] failed, Attempt 
to stop thread which has not been started

Error Adapter Check the adapter configuration settings.

AELN-0000500 LotusEventPoller: Pause attempted on a event poller thread: [%1] failed,
Attempt to pause thread which has not been started

Error Adapter Check the adapter configuration settings.

AELN-0000501 LotusEventPoller: Resume attempted on a event poller thread: [%1] failed,
Attempt to resume thread which has not been stopped

Error Adapter Check the adapter configuration settings.

AELN-0000502 LotusEventPoller: Component %1 Paused

Information Adapter Check the adapter configuration settings.
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AELN-0000503 LotusEventPoller: Component %1 Resumed

Information Adapter Check the adapter configuration settings.

AELN-0000504 LotusEventPoller: Component %1 Stopped polling

Information Adapter Check the adapter configuration settings.

AELN-0000505 LotusNotesStore: The adapter engine is unable to get a connection to the 
database. The Connection is busy ...

Error Adapter Check the adapter configuration settings.

AELN-0000506 LotusNotesStore: Unable to retrieve the first Lotus Document in view: %1,%2 

Error Adapter Check the adapter configuration settings.

AELN-0000507 LotusNotesStore: This method is not supported at this point

Error Adapter Check the adapter configuration settings.

AELN-0000508 LotusNotesStore: Unable to retrieve the Lotus Documents in view: %1,

Error Adapter Check the adapter configuration settings.

AELN-0000509 LotusNotesStore: Unable to query Lotus Documents with query: %1,

Error Adapter Check the adapter configuration settings.

AELN-0000510 LotusNotesStore: Unable to retrieve the Lotus Documents by formula: %1,

Error Adapter Check the adapter configuration settings.

AELN-0000511 LotusNotesStore: Object: %1 Not Supported by this store

Error Adapter Check the adapter configuration settings.

AELN-0000512 LotusNotesStore: Unable to save the Lotus Document

Error Adapter Check the adapter configuration settings.

AELN-0000513 LotusServer: The formula has not been specified for the Server Request

Error Server Check the adapter configuration settings.

Table 26   Status Message (Cont’d)

Status Code Role Category Resolution
 TIBCO ActiveMatrix Adapter Service Engine for Lotus Notes Configuration and Deployment



182 | Appendix A  Trace Messages
AELN-0000514 LotusServer: The document associated with the document Id: %1 passed in the 
Server Request Area does not exist

Error Server Check the adapter configuration settings.

AELN-0000515 LotusServer: The agent has not been specified for the Server Request

Error Server Check the adapter configuration settings.

AELN-0000516 LotusServer: The specified agent: [%1] does not exist in the database

Error Server Check the adapter configuration settings.

AELN-0000517 LotusServer: The exit has not been specified for the Server Request

Error Server Check the adapter configuration settings.

AELN-0000518 LotusServer: Specified exit: [%1] is an INVALID Server Exit ...

Error Server Check the adapter configuration settings.

AELN-0000519 LotusServer: An Exception has occurred retrieving the static parameter: [%1] for 
the server request,

Error Server Check the adapter configuration settings.

AELN-0000520 LotusServer: Start attempted on a server thread: [%1] failed,

Error Server Check the adapter configuration settings.

AELN-0000521 LotusServer: Stop attempted on a server thread: [%1] failed,

Error Server Check the adapter configuration settings.

AELN-0000522 LotusServer: Pause attempted on a server thread: [%1] failed,

Error Server Check the adapter configuration settings.

AELN-0000523 LotusServer: Resume attempted on a server thread: [%1] failed,

Error Server Check the adapter configuration settings.

AELN-0000524 LotusServer: An Exception has occurred in the processing of a server request 

Error Server Check the adapter configuration settings.
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AELN-0000525 LotusServer: The view has not been specified for the Server Request

Error Server Check the adapter configuration settings.

AELN-0000526 LotusServer: The view: [%1] does not exist in the database

Error Server Check the adapter configuration settings.

AELN-0000527 LotusExceptionManager: Error Publisher for the Exception Event Manager

Error Adapter Check the adapter configuration settings.

AELN-0000528 LotusExceptionManager: RV Session for the Exception Event Manager

Error Adapter Check the adapter configuration settings.

AELN-0000529 LotusExceptionManager: An Exception Manager must exist for all adapter 
instances ..

Error Adapter Place this object in the configuration details.

AELN-0000530 LotusExceptionManager: An Exception Manager must have either the session 
attribute or default publisher defined ...

Error Adapter Check the adapter configuration settings.

AELN-0000531 LotusExceptionManager: Invalid RV Session specified for Exception Manager ...

Error Adapter Check the adapter configuration settings.

AELN-0000532 LotusExceptionManager: Error Publisher specified does not exist for Exception 
Manager ...

Error Adapter Check the adapter configuration settings.

AELN-0000533 LotusToXMLTranslator: Failure to create the XML Document for Event: [%1]
original Exception Class: %2 Original Exception Message: %3

Error Adapter Check the adapter configuration settings.

AELN-0000534 ServerExitTemplate: An Unknown exception has occurred in 
ServerExitTemplate ...

Error Adapter Check the adapter configuration settings.
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AELN-0000535 SplitAttachments: SplitAttachments - note exit failed...

Error Adapter Check the adapter configuration settings.

AELN-0000536 Event Not Registered: %1

Error Adapter Check the adapter configuration settings.

AELN-0000537 Note Exit for Publish Meta Object: [%1] did not create an Outgoing Lotus 
Collection

Error Adapter Check the adapter configuration settings.

AELN-0000538 Lotus formula for Meta Object: [%1] not specified in configuration

Error Adapter Check the adapter configuration settings.

AELN-0000539 The data for the class: [%1] is not an MInstance and will not be processed

Error Adapter Check the adapter configuration settings.

AELN-0000540 The incoming operation: [%1] for the class: [%2] is NOT supported

Error Adapter Check the adapter configuration settings.

AELN-0000541 The incoming operation for the class: [%1] does NOT exist

Error Adapter Check the adapter configuration settings.

AELN-0000542 Invalid Note Exit for Meta Object: %1

Error Adapter Check the adapter configuration settings.

AELN-0000543 Note Exit name for Meta Object: [%1] not specified in configuration

Error Adapter Check the adapter configuration settings.

AELN-0000544 Exception occurred in manipulation of Lotus Notes document

Error Adapter Check the adapter configuration settings.

AELN-0000545 Lotus Agent: [%1] not found in Database

Error Adapter Check the adapter configuration settings.
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AELN-0000546 Lotus Agent name for Meta Object: [%1] not specified in configuration

Error Adapter Check the adapter configuration settings.

AELN-0000547 Operation: [%1] for the meta object: [%2] is NOT supported

Error Adapter Check the adapter configuration settings.

AELN-0000548 An exception has occurred in the step execution of the meta object: %1,%2

Error Adapter Check the adapter configuration settings.

AELN-0000549 An exception has occurred in the ’checkAttributeType’ execution%1

Error Adapter Check the adapter configuration settings.

AELN-0000550 Unable to retrieve the property value: [%1] for class: [%2],%3

Error Adapter Check the adapter configuration settings.

AELN-0000551 Unable to retrieve the property value: [%1] for attribute: [%2]

Error Adapter Check the adapter configuration settings.

AELN-0000552 Unable to determine whether the class: [%1] is a multi-add class

Error Adapter Check the adapter configuration settings.

AELN-0000553 Unable to retrieve sequence class for Meta Object: [%1]

Error Adapter Check the adapter configuration settings.

AELN-0000554 Unable to create sequence class for Meta Object: [%1],%2

Error Adapter Check the adapter configuration settings.

AELN-0000555 Unable to create attachment sequence class for Meta Object: [%1] %2

Error Adapter Check the adapter configuration settings.

AELN-0000556 For attachments in field: [%1] to be published by value, a ’files’ property for the 
attribute must be defined in the configuration. This property must have its value 
set to the actual suffix for all the attachments.

Error Adapter Check the adapter configuration settings.
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AELN-0000557 Object: [%1] was not defined in the Publish Routing Table and will not be 
published

Error Adapter Check the adapter configuration settings.

AELN-0000558 Publisher: [%1] for Object: [%2] is not a valid publisher

Error Adapter Check the adapter configuration settings.

AELN-0000559 Exception in ’MetaPublish’ for the class:[%1]%2

Error Adapter Check the adapter configuration settings.

AELN-0000560 Exception in ’XMLMetaPublish’ for the class:[%1],%2

Error Adapter Check the adapter configuration settings.

AELN-0000561 The incoming record sequence in the multi-document creation scenario of class: 
[%1] was not a sequence instance

Error Adapter Check the adapter configuration settings.

AELN-0000562 Exception in multi-creation of documents for the class: [%1],%2

Error Adapter Check the adapter configuration settings.

AELN-0000563 Cannot have a class that is defined with more than ONE attribute that is a 
sequence of a user-defined class. Class: [%1]

Error Adapter Check the adapter configuration settings.

AELN-0000564 An exception has occurred in the determining if the addition of documents is 
sequenced,%1

Error Adapter Check the adapter configuration settings.

AELN-0000565 Document cannot be added since form name does not exist in class: [%1]

Error Adapter Check the adapter configuration settings.

AELN-0000566 Attribute: [%1] of class: [%2] is defined as a sequence but the incoming data 
associated with this attribute is not a sequence.

Error Adapter Check the adapter configuration settings.
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AELN-0000567 The Attribute: [%1] has been defined as an attachmentByValue attribute in the 
registry.  The incoming file suffix has not been specified

Error Adapter Check the adapter configuration settings.

AELN-0000568 Attribute: [%1] of class: [%2] is defined as an attachment sequence but the 
incoming data associated with this attribute is not a sequence.

Error Adapter Check the adapter configuration settings.

AELN-0000569 In creating a vector for the multi-value field: [%1] the entry: [%2] was of type: %3 
and is not the same as the previous data types in the vector

Error Adapter Check the adapter configuration settings.

AELN-0000570 An exception has occurred in the ’AddMetaDocumentSequence’ execution%1

Error Adapter Check the adapter configuration settings.

AELN-0000571 Document cannot be added since form name does not exist in Event Registry

Error Adapter Check the adapter configuration settings.

AELN-0000572 An exception has occurred in the ’AddMetaDocument’ execution%1

Error Adapter Check the adapter configuration settings.

AELN-0000573 An exception has occurred in the ’AddMetaDocumentSubForm’ execution%1

Error Adapter Check the adapter configuration settings.

AELN-0000574 An exception has occurred in the ’RemoveMetaDocumentSubForm’ execution%1

Error Adapter Check the adapter configuration settings.

AELN-0000575 Source Document Not found, View Name = %1 Keys = %2

Error Adapter Check the adapter configuration settings.

AELN-0000576 Source Document Not found, Formula = %1

Error Adapter Check the adapter configuration settings.

AELN-0000577 Source Document Not found, Form Name = %1 Keys = %2

Error Adapter Check the adapter configuration settings.
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AELN-0000578 Neither the view', 'formula' or 'form' was defined as a property of the class:[%1] 
to execute the Update operation

Error Adapter Check the adapter configuration settings.

AELN-0000579 An exception has occurred in the sequence publishing

Error Adapter Check the adapter configuration settings.

AELN-0000580 An exception has occurred in the publishing of sequence %1

Error Adapter Check the adapter configuration settings.

AELN-0000581 An exception has occurred in the AddDocument' execution",%1

Error Adapter Check the adapter configuration settings.

AELN-0000582 An exception has occurred in the mapping of Lotus Fields to the RV message 
nodes.  Check the Event Registry definition,%1

Error Adapter Check the adapter configuration settings.

AELN-0000583 An exception has occurred in the mapping of Lotus Fields to the MULTI RV 
message nodes.  Check the Event Registry definition,%1

Error Adapter Check the adapter configuration settings.

AELN-0000584 An exception has occurred in the execution of the lotus query: %1 Ensure the 
formula is defined correctly in the Event Registry definition

Error Adapter Check the adapter configuration settings.

AELN-0000585 An exception has occurred in the execution of the lotus formula: %1 Ensure the 
formula is defined correctly in the Event Registry definition%2

Error Adapter Check the adapter configuration settings.

AELN-0000586 An exception has occurred in the retrieval of the document by UNID: %1 Ensure 
the UNID is defined correctly in the Event Registry definition,%2

Error Adapter Check the adapter configuration settings.

AELN-0000587 An exception has occurred in the publishing of documents from the Outbox,

Error Adapter Check the adapter configuration settings.

Table 26   Status Message (Cont’d)

Status Code Role Category Resolution
TIBCO ActiveMatrix Adapter Service Engine for Lotus Notes Configuration and Deployment



Status Messages | 189
AELN-0000588 Source Documents Not found, Formula has not been specified in the Event 
Registry

Error Adapter Check the adapter configuration settings.

AELN-0000589 An exception has occurred in the UpdateDocument execution,%1

Error Adapter Check the adapter configuration settings.

AELN-0000590 An exception has occurred in the DeleteDocument'execution,%1

Error Adapter Check the adapter configuration settings.

AELN-0000591 Unknown Action Type %1 Encountered in the course of event execution

Error Adapter Check the adapter configuration settings.

AELN-0000592 An exception has occurred in the execution of the Note Action 

Error Adapter Check the adapter configuration settings.

AELN-0000593 Invalid Note Exit: %1

Error Adapter Check the adapter configuration settings.

AELN-0000594 No Lotus Collections were retrieved and hence NO Documents were processed

Error Adapter Check the adapter configuration settings.

AELN-0000595 Failure in the Confirmation of the message as a result of MExceptionEvent in 
certified message delivery. 

Error Adapter Check the adapter configuration settings.

AELN-0000596 The Keyword specified in the event registry is not a valid keyword: %1

Error Adapter Check the adapter configuration settings.

AELN-0000597 Cannot extract the nodes from the RV message for useTreeNodes

Error Adapter Check the adapter configuration settings.

AELN-0000598 Cannot extract the values from the RV message for useTreeValues

Error Adapter Check the adapter configuration settings.
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AELN-0000599 An exception has occurred in mapping the RV message node values to the Lotus 
Document fields defined in the Event Registry,%1

Error Adapter Check the adapter configuration settings.

AELN-0000600 An exception has occurred in the preparation of the lotus query

Error Adapter Check the adapter configuration settings.

AELN-0000601 Stop attempted on a thread which has not been started

Error Adapter Check the adapter configuration settings.

AELN-0000602 Start attempted on a thread which has already been started

Error Adapter Check the adapter configuration settings.

AELN-0000603 Pause attempted on a thread which has not been started

Error Adapter Check the adapter configuration settings.

AELN-0000604 Failed to adjust the environment files() in particular the attachment location

Error Adapter Check the adapter configuration settings.

AELN-0000605 An exception has occurred in the LotusAgent execution Lotus Agent Name: %1. 
Ensure that this is correct %2

Error Adapter Check the adapter configuration settings.

AELN-0000606 Found an Existing document ............, Updating the values

Information Adapter Check the adapter configuration settings.

AELN-0000607 Executing Agent: %1 

Information Adapter Check the adapter configuration settings.

AELN-0000608  ::::: Event Exit manipulating incoming data ....

Information Adapter Check the adapter configuration settings.

AELN-0000609  ::::: Event Exit manipulating outgoing data ....

Information Adapter Check the adapter configuration settings.
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AELN-0000610  ::::: Event Exit manipulating database: %1

Information Adapter Check the adapter configuration settings.

AELN-0000611  ::::: Event Exit Other Processing ....

Information Adapter Check the adapter configuration settings.

AELN-0000612  ::::: Meta Exit creating outgoing data ....

Information Adapter Check the adapter configuration settings.

AELN-0000613  ::::: Meta Exit manipulating outgoing data ....

Information Adapter Check the adapter configuration settings.

AELN-0000614  ::::: Meta Exit manipulating database: %1

Information Adapter Check the adapter configuration settings.

AELN-0000615  ::::: Meta Exit Other Processing ....

Information Adapter Check the adapter configuration settings.

AELN-0000616  ::::: Meta Exit manipulating incoming data ....

Information Adapter Check the adapter configuration settings.

AELN-0000617 %1

Information Adapter Check the adapter configuration settings.

AELN-0000618 Exception Message : %1

Error Adapter Check the adapter configuration settings.

AELN-0000619 Failed to load properties file: %1 %2

Error Adapter Check the adapter configuration settings.

AELN-0000620 Exception in Tibrv Queue dispatch : %1

Error Adapter Check the adapter configuration settings.

AELN-0000621 Fatal Error , Point of Give Up : %1

Error Adapter Check the adapter configuration settings.
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AELN-0000622 Exception Message : %1

Error Adapter Check the adapter configuration settings.

AELN-0000623 Error in LotusDate to JavaDate Conversion : %1

Error Adapter No action required. Contact Tibco support.

AELN-0000624 Error in JavaDate to LotusDate Conversion : %1

Error Adapter No action required. Contact Tibco support.

AELN-0000625 Error in lotus notes document recycling : %1 

Error Adapter Try re-starting the adapter.

AELN-0000626 Update Failed : Source Document Not found , View Name = %1 Keys = %2

Error Adapter Check if the document exists. Please check the 
adapter configuration settings.

AELN-0000627 Update Failed: Source Document Not found, Form Name = %1 Keys = %2

Error Adapter Check if the document exists. Please check the 
adapter configuration settings.

AELN-0000628 Update Failed: Source Document Not found, Formula = %1

Error Adapter Check if the document exists. Please check the 
adapter configuration settings.

AELN-0000629 Deleted Failed: Source Document Not found , View Name = %1 Keys = %2

Error Adapter Check if the document exists.

AELN-0000630 Deleted Failed: Source Document Not found, Form Name = %1 Keys = %2

Error Adapter Check if the document exists.

AELN-0000631 Deleted Failed: Source Document Not found, Formula = %1

Error Adapter Check if the document exists.

AELN-0000632 ERROR ADVISORY RECEIVED [%1]\n%2

Error Adapter Indicates normal adapter operation. No action 
required.
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AELN-0000633 INFO ADVISORY RECEIVED [%1]\n%2

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000634 WARNING ADVISORY RECEIVED [%1]\n%2

Warning Adapter Indicates normal adapter operation. No action 
required.

AELN-0000635 IP Address for the Domino Servername specified could not be resolved...

Error Adapter Check if the correct HostName/IPAddress 
has been specified.

AELN-0000636 Error in creating a Remote session on the Domino Server...

Error Adapter Check if the Domino Server is up and DIOP 
and HTTP services are enabled on the server.

AELN-0000637 Error in creating a local session on the Notes Database...

Error Adapter Check if the nsf file exists.

AELN-0000638 The release of Domino the session is running on is: [%1]

Debug Adapter Check the adapter configuration settings.

AELN-0000639 Creating HTTP Listener on port: %1

Debug Adapter Check the adapter configuration settings.

AELN-0000662 Neither the ’view’, ’formula’ or ’form’ was defined as a property of the class: 
[%1]\n to execute the Update operation.

Error Adapter Check the adapter configuration settings.

AELN-0000663 Failure in the Confirmation of the message as a result of MExceptionEvent in 
certified message delivery.

Error Adapter Check the adapter configuration settings.

AELN-940012 Request Response error. Error in incoming data for RPC service. Not able to map 
incoming data to the business object schema configured at design time.

Error Adapter Problem with schema. Check the schema for 
broken references.
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AELN-1000101 class: %1 message: %2

Warning Client Indicates normal adapter operation. No action 
required.

AELN-1000102 LotusClientRequest: %1::   [%2] Started 

Information Client Indicates normal adapter operation. No action 
required.

AELN-1000103 Exception in client request poller thread as a result of an Interruption

Warning Client Indicates normal adapter operation. No action 
required.

AELN-1000104 Exception in client request poller thread as a result of reading the database

Warning Client Indicates normal adapter operation. No action 
required.

AELN-1000105 onMsg in client request trigger: %1

Information Client Indicates normal adapter operation. No action 
required.

AELN-1000106 polling client request processing view in database for request: [%1]

Information Client Indicates normal adapter operation. No action 
required.

AELN-1000107 WARNING:: The incoming message is not of the required format and was 
ignored

Information Client Indicates normal adapter operation. No action 
required.

AELN-1000108 Processing Request Documents. The tracking ID is : %1

Information Client Indicates normal adapter operation. No action 
required.

AELN-1000109 No Request Documents Found ...................

Information Client Indicates normal adapter operation. No action 
required.
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AELN-1000110 processing Client Request Prossessing Document, the UID: %1

Debug Client Indicates normal adapter operation. No action 
required.

AELN-1000111 the related Client Request Document UID: %1

Debug Client Indicates normal adapter operation. No action 
required.

AELN-1000112 No Request Documents Found ...................

Information Client Indicates normal adapter operation. No action 
required.

AELN-1000113 The incoming RV message did not have a ClientRequest node and hence a 
request name was not identified.

Information Client Indicates normal adapter operation. No action 
required.

AELN-1000114 An Exception has occurred in request document processing errorClass:    
LotusAdapterException errorCode:     %1 errorText:     %2 OriginalError: %3 
severity:      %4

Error Client Check the adapter configuration settings.

AELN-1000115 An Exception has occurred in request document processing class:         %1 
errorText:     %2

Error Client Check the adapter configuration settings.

AELN-1000116 Initiating the %1 Request using :::::Parameters = %2 Values =     %3 

Debug Client Indicates normal adapter operation. No action 
required.

AELN-1000117 An Exception has occurred in the client request processing: exceptionName: %1 
exceptionData: %2

Error Client Check the adapter configuration settings.

AELN-1000118 Updating the related Document fields where applicable ....

Information Client Indicates normal adapter operation. No action 
required.
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AELN-1000119 Exception in updating the result field of related Document ...class: 
lotus.notes.NotesException - message: %1

Error Client Check the nsf file

AELN-1000120 Related Document has not been specified ....

Information Client Indicates normal adapter operation. No action 
required.

AELN-1000121 ------------------------------------------

Debug Client Indicates normal adapter operation. No action 
required.

AELN-1000122 Processing the reply .............

Information Client Indicates normal adapter operation. No action 
required.

AELN-1000123 Updating the related Document fields where applicable ....

Information Client Indicates normal adapter operation. No action 
required.

AELN-1000124 Exception in updating the result field of related Document ...class: 
lotus.notes.NotesException - message: %1

Error Client Check the nsf file

AELN-1000125 NO Reply associated with this request ...........

Information Client Indicates normal adapter operation. No action 
required.

AELN-1000126 onReply ................................

Information Client Indicates normal adapter operation. No action 
required.

AELN-1000127 %1 Stopped, listening to %2

Information Client Indicates normal adapter operation. No action 
required.
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AELN-1000128 Error in TrackInfo Message Creation : %1

Information Client Indicates normal adapter operation. No action 
required.

AELN-2000201 Request Server [With Reply]: %1 initiated ...

Debug Server Indicates normal adapter operation. No action 
required.

AELN-2000202 An Exception has occurred in the construction of a LotusServerWithReply object: 
[%1]...class: %2 message: %3

Error Server Check the adapter configuration settings.

AELN-2000203 An Exception has occurred in attempting to start the LotusServerWithReply 
object:  [%1]...class: %2 message: %3

Error Server Check the adapter configuration settings.

AELN-2000204 Request written to the Queue .....

Debug Server Indicates normal adapter operation. No action 
required.

AELN-2000205 Request-Response service: %1 initiated ...

Information Server Check the adapter configuration settings.

AELN-2000206 EXCEPTION :: Class: %1 Error Text: Not able to reply to the requestor Error 
Code: LotusServerWithReply_666 Original Error: %2

Error Server Check the adapter configuration settings.

AELN-2000207 Exception in thread LotusServerWithReply: %1 ....class: %2 - message: %3

Error Server Check the adapter configuration settings.

AELN-2000208 Processing the request with reply ...............

Debug Server Indicates normal adapter operation. No action 
required.

AELN-2000209 Derived Formula: %1

Debug Server Indicates normal adapter operation. No action 
required.
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AELN-2000210 Processing the formula evaluation ...........

Information Server Indicates normal adapter operation. No action 
required.

AELN-2000211 Formula evaluation against Lotus Session

Information Server Indicates normal adapter operation. No action 
required.

AELN-2000212 Result = %1 Result Class = %2

Information Server Indicates normal adapter operation. No action 
required.

AELN-2000213 Sending reply of Server Formula: [%1] .............

Information Server Indicates normal adapter operation. No action 
required.

AELN-2000214 Formula evaluation against Lotus Document: %1

Information Server Indicates normal adapter operation. No action 
required.

AELN-2000215 Processing the query using the formula ...........

Debug Server Indicates normal adapter operation. No action 
required.

AELN-2000216 Field: contains an embedded object. Publication of objects and pictures are NOT 
supported

Information Server Indicates normal adapter operation. No action 
required.

AELN-2000217 Field: contains an embedded object. Publication of objects and links are NOT 
supported

Information Server Indicates normal adapter operation. No action 
required.

AELN-2000218 [%1] Records retrieved using the Server Query: [%2] .............

Information Server Indicates normal adapter operation. No action 
required.
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AELN-2000219 NO Records retrieved using the Server Query: [%1] .............

Information Server Indicates normal adapter operation. No action 
required.

AELN-2000220 Search using view: [%1] and searchKeys: %2

Information Server Indicates normal adapter operation. No action 
required.

AELN-2000221 [%1] Records retrieved using the Server View: [%2] and search keys: %3 .............

Information Server Indicates normal adapter operation. No action 
required.

AELN-2000222 No Records retrieved using the Server View: [%1] and search keys: %2 .............

Information Server Indicates normal adapter operation. No action 
required.

AELN-2000223 Processing the Agent: [%1] .........

Information Server Indicates normal adapter operation. No action 
required.

AELN-2000224 Agent Request Parameters: %1

Information Server Indicates normal adapter operation. No action 
required.

AELN-2000225 Response Document created .........

Information Server Indicates normal adapter operation. No action 
required.

AELN-2000226 Setting the Response Document status to %1'.........'

Error Server Check the adapter configuration settings.

AELN-2000227 Agent: [%1] executed .........

Information Server Indicates normal adapter operation. No action 
required.
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AELN-2000228 Retrieving the Response Document using: %1

Information Server Indicates normal adapter operation. No action 
required.

AELN-2000229 Processing the Response Document .........

Information Server Indicates normal adapter operation. No action 
required.

AELN-2000230 Record [%1] did not process field: %2

Information Server Indicates normal adapter operation. No action 
required.

AELN-2000231 [%1] Records retrieved via the Server Agent: [%2] .........

Information Server Indicates normal adapter operation. No action 
required.

AELN-2000232 [0] Records retrieved via the Server Agent: [%1] .........

Information Server Indicates normal adapter operation. No action 
required.

AELN-2000233 Setting the Response Document status to Processed'.........'

Information Server Indicates normal adapter operation. No action 
required.

AELN-2000234 NO records retrieved via the Server Agent: [%1] .........

Information Server Indicates normal adapter operation. No action 
required.

AELN-2000235 Setting the Response Document status to ProcessedNoData'.........'

Information Server Indicates normal adapter operation. No action 
required.

AELN-2000236 Server Exit NOT found .....

Information Server Indicates normal adapter operation. No action 
required.
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AELN-2000237 Server Exit :: Creating an External Process: [%1] ...

Information Server Indicates normal adapter operation. No action 
required.

AELN-2000238 operation Type: [%1] of server: [%2] and operation: [%3] is NOT supported

Error Server Check the adapter configuration settings.

AELN-2000239 operation Type of [server: [%1] and operation: [%2]] has NOT been defined

Error Server Check the adapter configuration settings.

AELN-2000240 Creating the Error Reply ...............

Information Server Indicates normal adapter operation. No action 
required.

AELN-2000241 -----------------EXCEPTION-------------------Request : [server: [%1] and operation: 
[%2]] Error Code    : %3 Error Text    : %4 Original Error: %5

Error Server Check the adapter configuration settings.

AELN-2000242 Request: [server: [%1] and operation: [%2]]

Error Server Check the adapter configuration settings.

AELN-2000243 -----------------EXCEPTION-------------------Request : [server: [%1] and operation: 
[%2]] Error Code : LotusServerWithReply_665 Error Text : An Exception has 
occurred in the processing of a server request Original Error: class: %3 text: %4

Error Server Check the adapter configuration settings.

AELN-2000244 EXCEPTION :: Request: [server: [%1] and operation: [%2]] Error Code: 
LotusServerWithReply_665 Error Code: An Exception has occurred in the 
processing of a server request Original Error: class: %3 text: %4

Error Server Check the adapter configuration settings.

AELN-2000245 Using the Default Value of %1

Information Server Indicates normal adapter operation. No action 
required.
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AELN-2000246 Component : %1 Stopped serving

Information Server Indicates normal adapter operation. No action 
required.

AELN-2000247 Component : %1 Paused 

Information Server Indicates normal adapter operation. No action 
required.

AELN-2000248 Component : %1 Resumed 

Information Server Indicates normal adapter operation. No action 
required.

AELN-2000249 Request Server [No Reply]: %1 initiated ...

Information Server Indicates normal adapter operation. No action 
required.

AELN-2000250 An Exception has occurred in the construction of a LotusServerNoReply object: 
[%1]...

Error Server Check the adapter configuration settings.

AELN-2000251 An Exception has occurred in attempting to start the LotusServerNoReply object:  
[%1]...

Error Server Check the adapter configuration settings.

AELN-2000252 Exception in thread LotusServerWithReply: %1 ....

Error Server Check the adapter configuration settings.

AELN-2000253 Processing the request with NO reply ...............

Information Server Indicates normal adapter operation. No action 
required.

AELN-2000254 Agent Document created .........

Information Server Indicates normal adapter operation. No action 
required.

AELN-2000255 Setting the Agent Document status to %1'.........'

Error Server Check the adapter configuration settings.
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AELN-2000256 ------------------------------------------

Debug Server Indicates normal adapter operation. No action 
required.

AELN-2000257 Error in Locale specific DateFormat Conversion : %1

Error Server Contact Tibco support.

AELN-2000258 Error in LotusDate to JavaDate Conversion

Error Server Check date format.

AELN-2000259 Fatal Error , Point of GiveUp : %1

Error Server Check the adapter configuration settings.

AELN-2000260 Error in EmbeddedObjects manipulation : %1

Error Server Check schema.

AELN-2000261 Error in Attachment Processing : %1

Error Server Check schema.

AELN-2000262 Error in parsing the requested fields string : %1

Error Server Check the requested fields specified.

AELN-2000263 Received a New Request. The tracking ID is: %1

Information Server Indicates normal adapter operation. No action 
required.

AELN-2000264 Operation Type specified in the request : %1

Debug Server Indicates normal adapter operation. No action 
required.

AELN-2000265 Form Name not specified in the request

Error Server Specify the form name in the request.

AELN-2000266 Sending the error reply...

Error Server Check the adapter configuration settings.
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AELN-2000267 Data not available in the request

Error Server Specify the data in the request.

AELN-2000268 Formula / KeyField and Form Name / Form Name expected in the request

Error Server Specify Formula / KeyField and Form Name 
in the request.

AELN-2000269 Formula / FormName and Data / Data expected in the request

Error Server Specify Formula / FormName and Data / 
Data expected in the request.

AELN-2000270 Processing the request...

Debug Server Indicates normal adapter operation. No action 
required.

AELN-2000271 Creating a new document to be inserted into the database...

Debug Server Indicates normal adapter operation. No action 
required.

AELN-2000272 Parsing the incoming data...

Debug Server Indicates normal adapter operation. No action 
required.

AELN-2000273 File Name not specified in the request

Error Server Specify the file name.

AELN-2000274 Document successfully created in the database...

Information Server Indicates normal adapter operation. No action 
required.

AELN-2000275 Error in processing the request : %1

Error Server Check the adapter configuration settings.

AELN-2000276 Search criteria failed to return a document/document collection

Error Server Give correct search criteria.
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AELN-2000277 Formula evaluation failed to return a document/document collection

Error Server Give correct search criteria.

AELN-2000278 Update Operation Successful...

Information Server Indicates normal adapter operation. No action 
required.

AELN-2000300 Request processed successfully. The tracking ID is : %1

Information Adapter Indicates normal adapter operation. No action 
required.

AEADLN-890001 Reconnect attempt %1.

Information Application Indicates normal adapter operation. No action 
required.

AEADLN-890002 Reconnect succeeded on attempt %1.

Information Application Indicates normal adapter operation. No action 
required.

AEADLN-890003 The request received could not be processed due to connection errors. Error reply 
sent back.

Error Adapter Check the Lotus Domino Server connection.

AEADLN-890004 Adapter stopping due to persistent connection errors. Check the Lotus Domino 
Server and restart adapter.

Error Adapter Check the Lotus Domino Server and restart 
adapter.

AEADLN-890005 Subscription service %1 suspended due to reconnect failure.

Information Adapter Indicates normal adapter operation. No action 
required.

AEADLN-890006 Connection re-established; suspended service %1 reactivated.

Information Adapter Indicates normal adapter operation. No action 
required.

Table 26   Status Message (Cont’d)

Status Code Role Category Resolution
 TIBCO ActiveMatrix Adapter Service Engine for Lotus Notes Configuration and Deployment



206 | Appendix A  Trace Messages
AEADLN-890007 Operation did not succeed due to connection error in service %1. The operation 
will be reattempted.

Information Adapter Indicates normal adapter operation. No action 
required.

AEADLN-890008 Reconnect failed on attempt %1 - will retry in %2 ms.

Warning Adapter Indicates normal adapter operation. No action 
required.

AEADLN-890009 Connection reestablished for publisher - message may be a duplicate of a 
previously published message.

Warning Adapter Indicates normal adapter operation. No action 
required.

AEADLN-890010 An exception has occurred. Only %1 of the %2 documents have been updated.

Error Application Check the application for a valid connection.

AEADLN-890011 Processing Document %1.

Information Adapter Indicates normal adapter operation. No action 
required.

AEADLN-890012 An exception has occurred. Only %1 of the %2 documents have been deleted.

Error Application Check the application for a valid connection.

AEADLN-890013 Time taken by computeWithForm api = %1 minute(s)

Information Adapter Indicates normal adapter operation. No action 
required.

AEADLN-890014 The computewithform api has been set to off and computed fields will not be 
calculated

Warning Adapter If the computewithform api has to be set to on, 
set adln.computeWithForm to ON in the .tra 
file.

AEADLN-890015 Time taken to Complete %1 Operation for (%2) document(s) is = %3 minute(s).

Information Adapter Indicates normal adapter operation. No action 
required.
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AEADLN-890016 Time taken for Processing the (%1 th) document is = %2 minute(s).

Information Adapter Indicates normal adapter operation. No action 
required.

AEADLN-890017 An error has occurred in the Server Request Processing. %1

Error Adapter Check the application for a valid connection.

AEADLN-890018 Reconnection to server Successful

Information Server Indicates normal adapter operation. No action 
required.

AEADLN-910006 Startup Error. SDK Exception %1 occurred while creating a shutdown listener. 
The Repository URL is %2 and the Configuration URL is %3.

Error Adapter Check the adapter configuration settings.

AEADLN-910007 Startup Error. Unable to create a connection with the target application %1 using 
connection parameters [ServerName= %2, UserName= %3] and the target 
application error is %4

Error Adapter Check if correct parameters have been 
specified in the adapter configuration.

AEADLN-910010 Startup Error. Failed to load properties file containing trace messages from 
path%1 for Adapter Instance %2. Error Message %3

Error Adapter Check if the properties file exists.

AEADLN-910011 Startup Error. Port not available. Failed to Start the adapter on the port: %1. Error 
Message: %2

Error Adapter Specify a different port as the port specified is 
already in use. Change the port in nsf also 
accordingly.

AEADLN-910012 Startup Error. Negative polling interval. Failed to Start the adapter as a negative 
value (%1) has been specified for the polling interval in the .tra file.

Error Adapter Specify a non negative polling interval in the 
.tra file.

Table 26   Status Message (Cont’d)

Status Code Role Category Resolution
 TIBCO ActiveMatrix Adapter Service Engine for Lotus Notes Configuration and Deployment



208 | Appendix A  Trace Messages
AEADLN-910013 Startup Error. Negative polling batch size. Failed to Start the adapter as a 
negative value (%1) has been specified for the polling batch size in the .tra file.

Error Adapter Specify a non negative polling batch size in 
the .tra file.

AEADLN-910014 Startup Warning. Password decryption was unsuccessful.

Warning Adapter Check if the password entered is a valid one.

AEADLN-910016 Zero Polling Interval. Changing the polling interval to the default value:5000 
since zero has been specified for the polling interval in the .tra file.

Information Adapter Indicates normal adapter operation. No action 
required.

AEADLN-920001 Subscription error. Subscription service %1 listening on %2 received an 
unexpected event of type = %3. The Repository URL is %4 and the Configuration 
URL is %5.

Error Adapter Trigger the configured event.

AEADLN-920002 Subscription error. Subscription service %1 failed to deserialize the event 
received on subject %2 and SDK exception thrown is %3. The Repository URL is 
%4 and the Configuration URL is %5.

Error Adapter Problem with schema. Check the schema for 
broken references.

AEADLN-920003 Subscription error. Subscription service %1 listening on subject %2 received 
inbound event  with null data. The Repository URL is %3 and the Configuration 
URL is %4.

Error Adapter Problem with schema. Check the schema for 
broken references.

AEADLN-920004 Subscription error. Subscription service %1 listening on subject %2 could not 
deserialize the inbound event to MbusinessDocument %3.  The Repository URL 
is %4 and the Configuration URL is %5.

Error Adapter Problem with schema. Check the schema for 
broken references.
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AEADLN-920005 Subscription error. Subscription service %1 listening on subject %2,could not 
find the tracking data. The Repository URL is %3 and the Configuration URL is 
%4.

Error Adapter Check the schema.

AEADLN-920007 Subscription error. Subscription service %1 listening on subject %2 could not get 
the class description of %3. The Repository URL is %4 and the Configuration 
URL is %5.

Error Adapter Check the schema.

AEADLN-920010 Subscription error. Subscription service %1 listening on subject %2 received 
event with missing attributes in class %3. The Repository URL is %4 and the 
Configuration URL is %5.

Error Adapter Check the schema.

AEADLN-920012 Subscription error. Subscription service %1 listening on subject %2 received 
MBusinessDocument %3 with NULL value for attribute %4.

Error Adapter Check the schema.

AEADLN-920013 Subscription error. Subscription service %1 listening on subject %2 received 
MBusinessDocument %3 with invalid value %4 for attribute %5.

Error Adapter Check the schema.

AEADLN-920014 Subscription error. Subscription service %1 listening on subject %2 could not 
process the inbound event due to connection error %3 against target application 
%4 with parameters are [ServerName= %5, UserName= %6].

Error Adapter Check connection parameters.

AEADLN-920015 Subscription error. Subscription service %1 listening on subject %2 failed due to 
target application invocation error %3. Target application is %4. The target 
application specific commands and parameters are %5.

Error Adapter Check connection parameters.

AEADLN-920017 Subscription error. Subscription service could not send response %1 on reply 
subject. The Repository URL is %6 and Configuration URL is %7.

Error Adapter Check the adapter configuration settings.
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AEADLN-920019 Subscription error. Subscription service could not create reply from target 
application for publish on reply subject. The Repository URL is %1 and 
Configuration URL is %2.

Error Adapter Check the adapter configuration settings.

AEADLN-930001 Publication error. Publication service %1 publishing on subject %2 encountered 
error %3 while trying to connect to target application %4.  Connection 
parameters are [ServerName= %5, UserName= %6], the connection timeout is %7 
millisecs, and the number of retry efforts is %8. Polling timeout is %9 millisecs.

Error Adapter Check connection parameters.

AEADLN-930002 Publication error. Publication service %1 with publication subject %2 
encountered error %3 while trying to create publish event with schema %4. The 
Target application details are %5.

Error Adapter Check connection parameters.

AEADLN-930003 Publication error. Publication service %1 with publishing subject as %2 received 
event from target application %3. It failed while converting event to "Minstance" 
as it could not get the class description for %4.  Repository URL is %5 and the 
Configuration URL is %6.

Error Adapter Problem with schema. Check the schema for 
broken references.

AEADLN-930006 Publication error. Publication service %1 with publishing subject %2 received 
the event from target application %3. It failed while converting event to 
"Minstance" attribute %4 of class %5 is missing. Repository URL is %6 and the 
Configuration URL is %7.

Error Adapter Check the schema.

AEADLN-930007 Publication error. Publication service %1 with publication subject %2 received 
event from target application but could not create the business document %3. 
The target application details are [ServerName= %4, UserName= %5], the 
Repository URL is %6 and the Configuration URL is %7.

Error Adapter Problem with schema. Check the schema for 
broken references.

Table 26   Status Message (Cont’d)

Status Code Role Category Resolution
TIBCO ActiveMatrix Adapter Service Engine for Lotus Notes Configuration and Deployment



Status Messages | 211
AEADLN-930008 Publication error. Publication service %1 with publication subject %2 received 
SDK Exception %3 while converting the event received from target application 
to BusinessDocument. The exception occurred while setting the attribute %4 
with value of %5 for Business Document %6.  The target application details are 
%7, the Repository URL is %7 and Configuration URL is %8.

Error Adapter Check the schema.

AEADLN-930014 Publication error. Publication service %1 with publication subject %2 received 
error while sending event over the wire. The Error details are %3.

Error Adapter Check the adapter configuration settings.

AEADLN-940001 Request-Response error. Request-Response service %1 received unexpected null 
data in incoming request. Expects event %2. The Repository URL is %3 and the 
Configuration URL is %4.

Error Adapter Check the schema.

AEADLN-940004 Request-Response error. Request-Response service %1 failed to deserialize the 
received MServerRequest to MInstance: Received event = %2, SDK exception = 
%3. The Repository URL is %4 and the Configuration URL is %5.

Error Adapter Problem with schema. Check the schema for 
broken references.

AEADLN-940005 Request-Response error. Error in incoming data for RPC service: %1. Not able to 
map incoming data to the business object schema: %2 configured at design-time. 
Invalid data type: %3 for attribute: %4.

Error Adapter Problem with schema. Check the schema for 
broken references.

AEADLN-940006 Request-Response error. Error in incoming data for RPC service: %1. Missing 
mandatory parameter %2 for RPC input class %3.

Error Adapter Problem with schema. Check the schema for 
broken references.

AEADLN-940007 Request-Response error. Connection error in invocation of RPC service:%1.  
Connection parameters are [Server Name: %2, database name:%3, user name:%4.

Error Adapter Check the adapter configuration settings.
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AEADLN-940008 Request-Response error. Request-Response service %1 failed due to target 
application invocation error %2. Target application is %3 and inbound event is 
%4.

Error Adapter Check the adapter configuration settings.

AEADLN-940009 Request-Response error. Request-Response service %1 failed to create Reply 
Business Object Error %2.

Error Adapter Check the schema.

AEADLN-940010 Request-Response error. Request-Response service %1 received a time out error. 
Time out period in configuration file is %2.

Error Adapter Check timeout interval.

AEADLN-940011 Request-Response error. Request-Response service %1 received an error while 
sending Data. Error Message %2.

Error Adapter Check the schema.

AEADLN-950001 Request-Response Invocation error. Request-Response Invocation service %1 
received event from target application %2. It failed while converting event to 
Request, as it could not get the class description for %3.  Repository URL is %4 
and the Configuration URL is %5.

Error Adapter Problem with schema. Check the schema for 
broken references.

AEADLN-950002 Request-Response Invocation error. Request-Response Invocation service %1 
received event from target application %2. It failed while converting event to 
Request, as it could not get the Operation description %3 in the class  %4.  
Repository URL is %5 and the Configuration URL is %6.

Error Adapter Problem with schema. Check the schema for 
broken references.

AEADLN-950003 Request-Response Invocation error. Request-Response Invocation service %1 
received event from target application %2. It failed while converting event to 
Request.  Repository URL is %4 and the Configuration URL is %5.

Error Adapter Problem with schema. Check the schema for 
broken references.
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AEADLN-950004 Request-Response Invocation error. Request-Response Invocation service %1 
received event from target application %2. It failed while converting event to 
Request, as it cannot set Operation Parameter %3.  Repository URL is %4 and the 
Configuration URL is %5.

Error Adapter Problem with schema. Check the schema for 
broken references.

AEADLN-950007 Request-Response Invocation error. Request-Response Invocation service %1 
received error while sending event over the wire. The Request-Response 
Invocation endpoint details are %2.

Error Adapter Check the schema.

AEADLN-950008 Request-Response Invocation error. Request-Response Invocation service %1 
received error while requesting event over the wire. The Request-Response 
invocation endpoint details are %2.

Error Adapter Check the schema.

AEADLN-950009 Request-Response Invocation error. Request-Response Invocation service %1 
received error while requesting event over the wire. The Request-Response 
Invocation endpoint details are %2.

Error Adapter Check the schema.

AEADLN-950010 Request-Response Invocation error. Request-Response Invocation service %1 
received null reply while requesting event over the wire. The Request-Response 
Invocation endpoint details are %2.

Error Adapter Check the schema.

AEADLN-950011 Request-Response Invocation error. Request-Response Invocation service %1 
received timeout error while requesting event over the wire. The 
Request-Response Invocation endpoint details are %2.

Error Adapter Check timeout interval.

AEADLN-950012 Request-Response Invocation error. Request-Response Invocation service %1 
received error while processing reply message. The Request-Response 
Invocation endpoint details are %2.

Error Adapter Check the schema.
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AEADLN-990002 Shutdown error. SDK cleanup exception = %1.

Error Adapter Check the adapter configuration settings.

AEADLN-990003 Shutdown error. Failed to cleanup Hawk microagent.  SDK exception = %1.

Error Adapter Check the hawk configuration settings.

AEADLN-990004 Shutdown error. Failed to cleanup the threads: %1.

Error Adapter Check the adapter configuration settings.

AEADLN-990005 Shutdown error. Error in disconnecting from %1 connection parameters %2.

Error Adapter Check the adapter configuration settings.

AEADLN-910015 Initializing the .tra file...

Debug Adapter Indicates normal adapter operation. No action 
required.

AELN-2000280 Removing session corresponding to id :[%1] ...

Information Adapter Recreate the session using the Login Service, if 
needed.

AELN-2000281 Session has expired or invalid session id :[%1] ...

Error Adapter Check the sessionID to be a valid one, else 
check whether it has expired.

AELN-2000282 Exception in recycling Lotus Session. %1

Error Adapter The sessionID might be already removed by 
another operation.

AELN-2000283 An Exception has occurred in attempting to start the LotusLoginWithReply 
object:  [%1]...

Error Adapter Check the adapter configuration settings.

AELN-2000284 Login Server: %1 initiated ...

Information Adapter Indicates normal adapter operation. No action 
required.
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AELN-2000285 LoginServer: Start attempted on a server thread: [%1] failed, Attempt to start 
thread which has already been started

Error Adapter Check the settings of the Login Service.

AELN-2000286 Login Exception For User %1.

Error Adapter Check the settings of the user in the Domino 
Server.

AELN-2000287 Got session from pool for session id %1.

Debug Adapter Indicates normal adapter operation. No action 
required.

AELN-2000288 Request-Response error. Session id not found in the request

Error Adapter Enter a sessionID corresponding to the user as 
whom you would like to perform the 
operation.

AELN-2000289 An Exception has occurred in attempting to start the LotusLogoutWithReply 
object:  [%1]...

Error Adapter Check the settings of the Logout Service.

AELN-2000290 Logout Server: %1 initiated ...

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-2000291 LogoutServer: Start attempted on a server thread: [%1] failed, Attempt to start 
thread which has already been started

Error Adapter Check the settings of the Logout Service.

AELN-2000292 Logout Exception For session id %1.

Error Adapter The session might be invalid or might have 
already expired.

AELN-2000293 Number of sessions in pool : %1

Debug Adapter Indicates normal adapter operation. No action 
required.
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AELN-2000294 Received a login request....

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-2000295 Received a logout request....

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-2000296 Processing the login request...........

Debug Adapter Indicates normal adapter operation. No action 
required.

AELN-2000297 Processing the logout request...........

Debug Adapter Indicates normal adapter operation. No action 
required.

AELN-2000298 Sending session id in reply...........

Debug Adapter Indicates normal adapter operation. No action 
required.

AELN-2000299 Sending logout status in reply...........

Debug Adapter Indicates normal adapter operation. No action 
required.

AELN-0000640 An exception occurred while processing a RichText field containing Text and 
Attachments. The error message is %1.

Error Adapter Check the contents of the field.

AELN-0000641 An exception occurred while reading the value of IOR from the file. The error 
message is %1.

Error Adapter Check if the IOR file exists and its 
permissions, else its contents.

AELN-0000642 Subscription error. Session id not found in the incoming message

Error Adapter Enter a sessionID corresponding to the user as 
whom you would like to perform the 
operation.
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AELN-0000643 %1 threads created for the Request-Response Services.

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000644 An exception occurred while creating the threads for Request-Response Service. 
The error message is %1.

Error Adapter Check the settings of the Request-Response 
Service.

AELN-0000645 Array Out Of Bounds Exception occurred. The thread ID is %1.

Error Adapter Check the thread configuration for your 
Request-Response server

AELN-0000646 The Universal ID of the Document is : %1. The ThreadID is :%2

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000647 Removed the document with UniversalID %1 from the Database. The ThreadID 
is%2.'

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000648 Successfully subscribed the Event with subject: %1. The tracking ID is: %2.

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000649 An exception occurred while reading the IOR. Check the IOR file if it is 
specified by the user, else check if the server name and port are valid

Error Adapter Check the IOR file if it is specified by the user, 
else check if the server name and port are 
valid.

AELN-0000650 The UID of the Original Document is : The %1. The UID of the Publish 
Document is : The %2. The ThreadID is :%3.

Information Adapter Indicates normal adapter operation. No action 
required.
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AELN-0000652 Processing Operation No, %1 %2.

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000653 No Document Updated: Source Document Not found, View Name =%1 Keys = 
%2.

Warning Adapter Check if the document exists. Please check the 
adapter configuration settings.

AELN-0000654 No Document Updated: Source Document Not found, View Name =%1 Keys = 
%2.

Warning Adapter Check if the document exists. Please check the 
adapter configuration settings.

AELN-0000655 No Document Updated: Source Document Not found, View Name =%1 Keys = 
%2.

Warning Adapter Check if the document exists. Please check the 
adapter configuration settings.

AELN-0000656 No Document Deleted: Source Document Not found, View Name =%1 Keys = 
%2.

Warning Adapter Check if the document exists. Please check the 
adapter configuration settings.

AELN-0000657 No Document Deleted: Source Document Not found, Form Name =%1 Keys = 
%2.

Warning Adapter Check if the document exists. Please check the 
adapter configuration settings.

AELN-0000658 No Document Deleted: Source Document Not found, Form Name = %1.

Warning Adapter Check if the document exists. Please check the 
adapter configuration settings.

AELN-0000659 ERROR ADVISORY RECEIVED [%1]\n%2.

Error Adapter Indicates normal adapter operation. No action 
required.
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AELN-0000660 INFO ADVISORY RECEIVED [%1]\n%2.

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-0000661 WARNING ADVISORY RECEIVED [%1]\n%2.

Warning Adapter Indicates normal adapter operation. No action 
required.

AELN-1000129 Processing Request Documents. The tracking ID is : %1.

INFO Adapter Indicates normal adapter operation. No action 
required.

AELN-2000300 Request processed successfully. The tracking ID is : %1

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-2000301 "Key field missing, field name is : [%1]"

Warning Adapter Indicates adapter operation. No action 
required.

AELN-2000302 "Document Duplicated, formName : [%1], Key data : %2"

Warning Adapter Indicates adapter operation. No action 
required.

AELN-2000303 Performing the inserts . . . . . . . . . . . .

Information Adapter Indicates adapter operation. No action 
required.

AELN-2000304 Enable Key fields on Insert for [[%1].

Information Adapter Indicates adapter operation. No action 
required.

AELN-2000305 This processing requires searching Key fields to be specified

Warning Adapter Indicates adapter operation. No action 
required.
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AELN-2000306 [%1] Records retrieved using the Server Query (FTSearch), the parameters are: 
[%2] .............

Information Adapter Indicates adapter operation. No action 
required.

AELN-2000307 NO Records retrieved using the Server Query (FTSearch), the parameters are: 
[%1] .............

Information Adapter Indicates adapter operation. No action 
required.

AELN-2000308 Failed to query the database [%1] using Server Query (FTSearch), the parameters 
are: [%2]. Error Message: %3

Error Adapter Please check the adapter configuration 
settings.

AELN-2000309 Failed to get parameters when doing Server Query (FTSearch), the given 
parameters are: [%1]. Error Message: %2

Error Adapter Please check the adapter configuration 
settings related to FTSearch Parameters.

AELN-2000310 The FTSearch parameter is empty or not defined when doing Server Query 
(FTSearch).

Error Adapter Please check the adapter configuration 
settings related to FTSearch Parameters.

AELN-2000311 The number of FTSearch parameters is incorrect when doing Server Query 
(FTSearch).

Error Adapter Please check the adapter configuration 
settings related to FTSearch Parameters.

AELN-2000312 Invalidated FTSearch parameters when doing Server Query (FTSearch), the 
given parameters are [%1]. Error Message: %2

Error Adapter Please check the adapter configuration 
settings related to FTSearch Parameters.

AELN-2000313 FTSearch parameter 'query' is empty when doing Server Query (FTSearch).

Error Adapter Please check the adapter configuration 
settings related to FTSearch Parameters.
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AELN-2000314 <description>the number [%1] FTSearch parameter is empty when doing Server 
Query (FTSearch).

Error Adapter Please check the adapter configuration 
settings related to FTSearch Parameters.

AELN-2000315 the number [%1] FTSearch parameter should be integer when doing Server 
Query (FTSearch).

Error Adapter Please check the adapter configuration 
settings related to FTSearch Parameters.

AELN-2000316 Processing the query using the FTSearch ...........

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-2000317 Receive FTSearch parameters: %1

Debug Adapter Indicates normal adapter operation. No action 
required.

AELN-2000318 Set Update Mode to [%1] for [%2].

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-2000319 Disable key fields on Insert for [%1].

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-2000320 Publishing for Insert Operation has happenned on source document, setting 
opcode to [%1].

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-2000321 Publishing for Update Operation has happenned on source document, setting 
opcode to [%1].

Information Adapter Indicates normal adapter operation. No action 
required.
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AELN-2000322 Schema [%1] NOT supported. No Service can be found with the specified 
schema name in the coming message.

Error Adapter Please check the consistency of the schemas.

AELN-2000323 Failed to process the request. The tracking ID is : %1.

Information Adapter Indicates normal adapter operation. No action 
required.

AELN-2000324 Failed to Update the related Document fields where applicable. The error 
message is: %1

Error Adapter Please check whether the related document is 
existed.

AELN-2000325 There is type mismatch for [%1] between the data type [%2] in adapter and data 
type [%3] in Lotus.

Error Adapter Please check whether the datatype in adapter 
is consistent with that in Lotus.

AELN-2000326 FTSearch parameter 'query' has invalid symbol when doing Server Query 
(FTSearch).

Error Adapter Please check the adapter configuration 
settings related to FTSearch Parameters.

AELN-2000327 Key fields NOT Defined.

Error Adapter Please configure key fields at designer or set 
key fields (using the formKey attribute in the 
incoming message at run time).

AELN-2000328 Form [%1] NOT exists in Domino.

Warning Adapter Please check whether the form exists in 
Domino.

AELN-2000329 Field [%1] NOT exists for Form [%2] in Domino.

Debug Adapter Please check the whether the field for exists 
for the form in Domino.
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AELN-2000330 FTSearch parameter ’query’ is specified by ending with an invalid symbol with 
when doing Server Query (FTSearch).

Error Adapter Please check the adapter configuration 
settings related to FTSearch Parameters.

AELN-2000331 FTSearch parameter ’query’ is specified by ending with an invalid symbol with 
when doing Server Query (FTSearch).

Error Adapter Please check the adapter configuration 
settings related to FTSearch Parameters.

AELN-2000332 Schema NOT defined correctly for [%1].

Error Adapter Please check the adapter configuration 
settings related to FTSearch Parameters.

AELN-2000333 Received a New Request. The tracking ID is: %1.

INFO Adapter Indicates normal adapter operation. No action 
required..

AELN-500006 Message/Design-Time Test Connection is successful.

INFO Adapter

AELN-500018 Field:Max No of Retries/Palette error. The Maximum Number of Retries must be 
an integer greater than or equal to -1, and less than or equal to 65535.

Error Adapter Enter a number greater than or equal to -1 and 
less than or equal to 65535.

AELN-500041 Connection Not Established/Please verify whether the connection with the 
Database has been established.

Error Adapter Establish connection with the DataBase by 
clicking the button "Connect" in adapter 
instance Design-time Connection tab.

AELN-510041 View Not Avaialble/The View '%1' doesn't exist.

INFO Adapter
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AELN-510042 View Not Given/Palette error. Please give a valid View Name or select a View 
name using 'Fetch Schemas'".

INFO Adapter

AELN-510043 Form Not Given/Palette error. Please give a valid Form Name or select a Form 
name using 'Fetch Schemas'.

INFO Adapter

AELN-510044 Form Not Avaialble/The Form '%1' doesn't exist.

INFO Adapter

AELN-510045 Message/RPC Result Schema regenerated successfully by the form '%1'.\nPlease 
refer to the 'View Result Schema' tab for the details.

INFO Adapter

AELN-510046 Message/The Request Name '%1' of the Target doesn't equals the service name 
'%2'.\nPlease click the "Read Target" button to read the Proper Target.

INFO Adapter

AELN-510047 MValid Field Value Required/Please input a valid value for '%.

Error Adapter Define the specific field with validated value.

AELN-510001 Fatal Error/Error in creating staticmetadata classes and sequences.

Error Adapter

AELN-510048 Cannot Get Value From the Field/Cannot not get the value of '%.

Error Adapter Check the related field. Define the specific 
field with validated.

AELN-510049 Field:No Retries Before Suspend/Palette error. The Number of Publication 
Service Threads must be greater than or equal to 0, and less than or equal to 
65535.

Error Adapter Enter a number between 0 and 65535.

AELN-510050 Field: %1 /Palette error. The Input of the field must be integer greater than or 
equal to 0, and less than or equal to 65535.

Error Adapter Enter a number between 0 and 65535.
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AELN-500042 Connection Failed/Design-Time Connection Failed, Please Check the 
Connection Parameters.

Error Adapter Please check the design time connection 
parameters.

AELN-500043 Run-Time Test Connection Failed/Run-Time Test Connection Failed, Please 
Check the Connection Parameters.

Error Adapter Check the run-time connection parameters.

AELN-520020 Agents Not Defined/Agents are not defined in the Lotus Notes Database.

Warning Adapter Please define an agent in the lotusnotes 
database and try again.

AELN-510013 Message/%1.

INFO Adapter

AELN-510051 Field Empty/Field '%1' can NOT be empty.

Error Adapter Define the specific field with some value.
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Appendix B Configuring SSL for HTTP and DIIOP

This chapter provides a quick reference for how to configure SSL for HTTP and 
DIIOP on Lotus Domino applications.

Topics

• Overview, page 228

• Configuring Key and Certificate for SSL, page 229

• Enabling SSL on Lotus Domino Server, page 235

• Key Ring Files and Certificate Class File, page 236

Lotus Notes 7 is used in this book.
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Overview

To secure the connection between the adapter and the remote Lotus Domino 
Server, you can configure SSL for HTTP and DIIOP.

This section demonstrates how to configure SSL for HTTP and DIIOP on Lotus 
Domino Server. Refer to the Lotus Domino Administrator documentation for 
more information.
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Configuring Key and Certificate for SSL

To enable SSL for HTTP and DIIOP, first you need to generate a key and certificate 
for SSL.

Generating Certificate Authority Key Ring and Server Key Ring
Complete the following tasks to generate a certificate authority key ring and a 
server key ring.

Task A Create Domino Certificate Authority Database

Users who do not use a commercial CA (Certificate Authority) need to create their 
own CA in Domino.

To create a Domino CA database:

1. Start Lotus Notes.

2. From the File menu, select Database > New.

3. In the New Database window, select a server as the new application location 
and template location.

4. Enter a name for the new database in the Title field.

5. Select the Show advanced templates checkbox.

6. Select Domino Certificate Authority from the Template area. Choose the 
cca50.ntf file as the template and ensure that the Inherit future design 
changes checkbox is selected.

7. Click OK to create the database.

Task B Create a Certificate Authority Key Ring and Certificate

1. Open the Domino Certificate Authority database.

2. Click the 1. Create Certificate Authority Key Ring & Certificate option.

If the database has just been created, you may need to close it and then 
re-open it to allow some newly created views and documents to take effect.

3. Specify the Key Ring Information, Key Size, and Distinguished Name.
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Figure 40   Create Certificate Authority Key Ring

4. Click the Create Certificate Authority Key Ring button.

If the key ring has been successfully created, a window named Key ring 
created with self signed trusted root certificate pops up.

Task C Create Server Key Ring

1. From the File menu, select Database > Open.

2. In the Open Database window, change the Server field to the location of the 
server. Select the Server Certificate Admin database, its file name is 
certsrv.nsf. Click Open.

This database can be found in the Domino data directory. If you cannot find 
the database, you need to create it. Refer to the Lotus Domino Administrator 
Help for details about setting up the Server Certificate Admin application.

3. Click the 1. Create Key Ring option.

The key ring file will be created under the data subdirectory in the notes client 
installation folder.
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4. Specify the Key Ring Information, Key Size, and Distinguished Name.

Figure 41   Create Server Key Ring

5. Click the Create Key Ring button.

It is recommended that you keep the default key file name, keyfile.kyr. 
Otherwise, you must change all the key file names in the server configuration 
document in Lotus Domino Administrator.
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If the key ring has been successfully created, a window named Key Ring 
Created pops up.

Installing Certificate into Key Ring
Complete the following tasks to install certificate into the key ring.

Task A Create Certificate Request

1. In the Server Certificate Admin database, click the 2. Create Certificate 
Request option.

2. Specify the Key Ring Information and Certificate Request Information.

The key ring file is that created for the server key ring. Leave the other fields 
unchanged.

3. Click the Create Certificate Request button.

4. Input the password that you set for the server key ring file when prompted.

5. When the Certificate Request Created window pops up, copy the certificate 
request to the clipboard for later use. Do the copying according to the help 
information in the window.

Task B Submit Certificate Request

1. Access the Domino Certificate Authority database from your web browser.

For example, if the name of the database is DCA.nsf, use the following URL to 
access the database:

http://domino_server_IP_address/DCA.nsf

2. Click Request Server Certificate in the left hand panel.

3. Enter the Contact Information and paste the certificate request.

4. Click the Submit Certificate Request button.

5. Click Accept This Authority In Your Server in the left hand panel.

The key ring file will be created under the data subdirectory in the notes client 
installation folder.

Ensure that you have enabled the HTTP service for the Lotus Domino Server. 
Otherwise, you cannot access the database from the web browser.
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6. Copy the CA certificate to the clipboard for later use according to the help 
information displayed above the certificate.

Task C Install Trusted root certificate into Key Ring

1. In Lotus Notes, open the Server Certificate Admin database certsrv.nsf.

2. Click the 3. Install Trusted Root Certificate into Key Ring option.

3. Specify the Key Ring Information and Certificate Information.

a. The key ring file is that created for the server key ring.

b. Enter a value in the Certificate Label field for the certificate.

c. Select Clipboard as the Certificate Source.

d. In the Certificate from Clipboard field, paste the CA certificate that you 
have copied to the clipboard.

4. Click the Merge Trusted Root Certificate into Key Ring button.

5. Input the password that you set for the server key ring file when prompted.

6. When the Merge Trusted Root Certificate Confirmation window pops up, 
check the information, and then click OK to install the certificate.

Once the installation is finished, a window pops up to indicate that the trusted 
root certificate has been merged into your key ring.

Task D Approve the Server Certificate Request

1. In Lotus Notes, open the Domino Certificate Authority database.

2. Click Server Certificate Requests in the left hand panel.

3. Double-click the server certificate request document that is waiting for 
approval.

4. Review the certificate request.

a. Ensure that the contact information and certificate information are correct.

b. Copy the Pickup ID from the Approve section for later use.

c. Set an appropriate value in the Validity Period field. A small value will 
make your certificate expire soon while a very large value will 
compromise the security.

5. Click Approve.

6. Input the password that you set for the certificate authority key ring when 
prompted.
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7. Enter the DNS host name of your site, which should be your full computer 
name. For example, mycomputer.tibco-support.com.

Task E Pick Up Server Certificates

1. Access the Domino Certificate Authority database from your web browser.

For example, if the name of the database is DCA.nsf, use the following URL to 
access the database:

http://domino_server_IP_address/DCA.nsf

2. Click Pick Up Server Certificate in the left hand pane.

3. Input the Pickup ID which was generated when approving the server 
certificate request.

4. Click the Pick Up Signed Certificate button.

5. Copy the certificate to the clipboard for later use.

Task F Install Certificate into Key Ring

1. In Lotus Notes, open the Server Certificate Admin database certsrv.nsf.

2. Click the 4. Install Certificate Into Key Ring option.

3. Specify the Key Ring Information and Certificate Information.

a. The key ring file is that created for the server key ring.

b. Select Clipboard as the Certificate Source.

c. In the Certificate from Clipboard field, paste the server certificate that you 
have copied to the clipboard.

4. Click the Merge Certificate into Key Ring button.

5. Input the password that you set for the server key ring file when prompted.

6. When the Merge Signed Certificate Confirmation window pops up, check the 
information, and then click OK to install the certificate.
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Enabling SSL on Lotus Domino Server

After the key and certificate required by SSL are generated, you need to enable 
SSL on Lotus Domino Server.

1. Start Lotus Domino Administrator.

2. Select the Domain with the appropriate domain name.

3. In the Configuration tab, expand Server from the left hand pane, and then 
select Current Server Document.

4. Click the Ports tab, and then click the Internet Ports tab. Find the Web tab and 
DIIOP tab.

The Web tab is for HTTP configuration and the DIIOP tab is for DIIOP 
configuration. You can enable or disable SSL for HTTP and DIIOP by setting 
the SSL port status field in the corresponding tab.

In the Web tab and DIIOP tab, ensure that the fields of Name & password are 
set to Yes. Otherwise, you cannot use HTTP or DIIOP to connect to the 
Domino Server.
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Key Ring Files and Certificate Class File

Several files are generated during the configuration. Complete the tasks below 
with these files.

Task A Copy Key Ring Files to Domino

Two key ring files are generated during the configuration. By default, one file is 
named as keyfile.kyr, the other keyfile.sth.

Find the two files in the Lotus Notes data subdirectory and copy them to the 
Domino data subdirectory.

Task B Create JAR File for Certificate Class

A certificate class file is generated during the configuration. By default, it is 
named as TrustedCerts.class.

You need to create a JAR file for the certificate class file. The following steps 
demonstrate how to do it with a JAVA utility:

1. At the command prompt, go to the directory where the TrustedCerts.class 
file is located.

2. Run the following command:

jar -cvf jar_file_name.jar TrustedCerts.class

A file named jar_file_name.jar is created in the same directory.
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